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Introduction
This guide describes the features and administrative procedures that are specific to 
the Siebel eEnergy application. It should be used in combination with other books 
in the Application Administration section of the Siebel Bookshelf CD-ROM. However, 
the information in this book supersedes information about standard Siebel products 
provided in other documentation. 

This guide will be most useful to people whose title or job description matches one 
of the following:

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center. 
Duties include designing and managing Computer Telephony 
Integration (CTI), SmartScripts, and message broadcasts.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Marketing 
Administrators

Persons responsible for setting up and maintaining a marketing 
department. Duties include designing and managing campaigns, 
product marketing information, and product distribution lists.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Network 
Administrators

Persons responsible for planning, setting up, and maintaining 
networks.

Trainers Persons responsible for training end users of the Siebel eEnergy 
application.
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How This Guide Is Organized
How This Guide Is Organized
This guide begins with a few chapters containing introductory material about Siebel 
eEnergy. Every chapter after those, except for Chapter 15, “Defining an Integration 
Workflow Process,” describes a different screen and functional area of the product 
that are commonly used by customers. Chapter 15, “Defining an Integration 
Workflow Process,” describes the workflow processes contained in the sample 
database that can be imported to automate business processes.

This guide assumes that you have already installed Siebel eEnergy. If you have not, 
see the installation books on the Siebel Bookshelf.

The Siebel database server installation script creates a Siebel administrator account 
that can be used to perform the tasks described in this guide. For information about 
this process, see Siebel Server Administration Guide and the installation books on 
the Siebel Bookshelf.

CAUTION: Do not perform system administration functions on your local database. 
Doing so may have serious results, such as data conflicts or an overly large local 
database.
14 Siebel eEnergy Guide Version 7.5, Rev. B
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What’s New in This Release
This section summarizes the enhancements made to Siebel eEnergy for version 7.5. 
Some enhancements are documented in this guide, while others are documented in 
other guides. For more information on specific enhancements, see the Siebel 
Bookshelf.

Pricing Comparison 
The Price Comparison feature in Siebel eEnergy supports the energy companies 
engaged in mass-market energy services sales. Using this new feature, customer 
service representatives or prospective customers can translate a complex energy 
rates to something they can comprehend and compare: an annual bill amount. 

The Price Comparison feature includes these capabilities: 

Tier-based pricing. The Price Comparison feature works with Siebel ePricer to extend 
the pricing capabilities to allow for new structures that represent usage. Therefore, 
at the introduction of a new rate plan or tariff, the pricing manager has the 
capability to define prices for different tiers that represent the usage characteristics 
of a product. 

For example, the pricing manager of an electricity service provider can define the 
following pricing structure for a service plan: $.12/kWh for usage up to 1000 kWh, 
$.10/kWh for usage of 1001 to 2000 kWh, and $.08 for usage over 2000 kWh. 

Competitor quotes. The Price Comparison feature also provides the ability to produce 
quotes that estimate competitors’ prices. Using this information, the pricing 
calculator provides the CSR and the prospective customer with an annual bill under 
the energy service offering of the energy company, as well as an annual savings 
amount.

“Like for like” price comparison. Using the Price Comparison feature, energy 
companies can accumulate usage data and pricing comparisons. This information 
allows users to compare the existing or prospective customer’s current service with 
an equivalent product of the competition. The data also allows companies to 
determine future strategies with regard to pricing, competitors, and geography.
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Enrollment Workflow. The Price Comparison feature provides the capability to 
automatically enroll existing or prospective customers in new rate plans. This new 
workflow converts the opportunity to an active account with a rate plan selection. 
It then begins the ordering process. 

NOTE: The Price Comparison feature can also be deployed over the Web for self-
service use by a prospective or existing customer.

For more information, see Chapter 9, “Price Comparison.”

Billing Management 
The Billing module (now called Invoices) includes the following enhancements for 
7.5.

Invoice views. The new multi-level Invoice module allows users to see invoices at the 
summary or segment level, as well as at the detail level. The functionality exposes 
the information stored in third-party billing systems. Therefore, to determine which 
information to work with, the invoice views include a new filter to differentiate 
between external invoices and invoices generated in Siebel applications. 

Adjustment functionality. Users now have the ability create adjustment requests for 
invoice lines, allowing the user to identify a disputed line on the bill and create an 
adjustment request specifically for that line. It is also possible to identify and adjust 
multiple lines on one invoice with one adjustment request.

Payment functionality. Payments can now be viewed on separate screens, which 
allows the user to do queries across accounts. In addition, users can create a 
payment at the account level, allowing the users to make a payment in spite of an 
outstanding invoice, as well as against multiple invoices with one payment request. 

In addition, invoices, payments, and adjustments can now be viewed on separate 
screens, allowing the user to do queries across accounts.
16 Siebel eEnergy Guide Version 7.5, Rev. B



Introduction

What’s New in This Release
Billing Portal view. The new Billing Portal view provides a view of the customer's 
billing related data. The new Account Balances functionality retrieves data directly 
from the external billing system. From the Billing Portal, users can perform the most 
commonly executed tasks related to a customer inquiry, such as viewing an account 
balance, making a payment, or requesting an adjustment. The Billing Portal also 
contains a Refresh button for displaying the latest information available from the 
billing system after a transaction. 

SAP/ISU-CCS connectivity. Siebel eEnergy can better integrate with customer 
information systems, especially the SAP/ISU-CCS solution. Intuitive data mapping 
and documented design solutions between such areas as account management, 
order management, and premises management allow Siebel eEnergy to provide a 
completely integrated solution for processes like enrollment, billing inquiries, 
budget billing, deposit collection, and payment plans.

For more information, see Chapter 10, “Billing.”

Analytics
Siebel Analytics includes the following enhancements for 7.5.

Loyalty Management Analytics. Successful customer loyalty and retention marketing 
programs play a critical role in improving margins, profitability, and the operating 
viability of service providers. Siebel Analytics enhances the effectiveness of loyalty 
and retention programs by providing customer analysis based upon predictive 
intelligence gathered about customers using a third-party predictive modeling 
application (purchased separately from, and integrated with, Siebel applications). 
These analysis capabilities provide for the ability to proactively intervene, before 
the predicted customer behavior occurs, with targeted marketing offers or 
alternative actions.

Enhancements to Loyalty Management Analytics include additional reports for the 
Churn Propensity and Customer Lifetime Value dashboards. A new Selling 
Propensity dashboard provides predictive intelligence about upsell and cross-sell 
opportunities, and a Financial Risk dashboard provides analytics based upon an 
estimation of each customer's ability to pay financial obligations. New reports are 
also available that identify those customers who have scored the highest for each 
scoring category.
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Revenue Management and Account Management Analytics. An organization's ability to 
understand how well its products, services, and accounts perform is key to its 
success. Siebel Analytics provides a Revenue Management dashboard, and an 
Account dashboard for insight into each of these areas. Both dashboards provide a 
separate set of reports for service activation, service modification, and service 
disconnection trending analysis. While Revenue Management focuses analysis on 
products and top performing products, Account Management focuses on accounts 
and top performing accounts. Additionally, Account Management provides trending 
analysis for trouble tickets and customer satisfaction at both the account and more 
aggregated levels.

Price Type Filter. Revenue associated with products and services in the Siebel 
eEnergy product may recur over time (such as a monthly recurring charge), occur 
only once (one-time only charge), or be based upon usage (such as a per-minute 
charge). This characteristic of revenue is reflected in the product's Price Type value. 
Siebel Analytics can narrow product analysis down to only those products of a 
particular Price Type, if needed. Isolating products in this manner helps companies 
spot trends that may be related to the nature of a product's revenue stream.

For more information, see the Siebel Bookshelf.

Premises
The Premises module includes the following enhancements for 7.5:

■ The ability to create a Service Point during the ordering process

■ The ability to create and order a product from a Service Point

For more information, see Chapter 6, “Premises.”

Siebel Partner Relationship Management
With new usability enhancements, Siebel Partner Relationship Management (Siebel 
PRM) for Siebel eEnergy provides an improved ordering platform for partners and 
resellers. It includes the following enhancements for 7.5.

User-based ordering flow. For 7.5, the control of the ordering flow in PRM is based on 
user responsibilities. This allows a more streamlined order checkout for Standard 
users and a more thorough Opportunity-Quote-Order cycle for Power users. 
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Agreements. The Agreements module is now available in the Siebel PRM Partner 
Portal. This enhancement provides channel partners and resellers with the ability 
to define Service Level Agreements for their customers’ products. It also provides 
administrators with the ability to assign products to agreements.

Product finder. Users can now search for products using the enhanced Siebel PRM 
Partner Portal Search Center. This allows partners operating in retail environments 
to check for a price or product description. In addition, the integration with the 
product catalog minimizes the number of clicks to add products to the shopping cart 
and checkout.

For more information, see Siebel Order Management Guide, Siebel Order 
Management Guide Addendum for Industry Applications, and Siebel Partner 
Relationship Management Administration Guide. 
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Revision History
Siebel eEnergy Guide

Version 7.5, Rev. B

January 2003 Bookshelf

Table 1. Changes Made in Version 7.5, Rev. B

Topic Revision

“Setting Up External Organizations 
(Administrator)” on page 38

An administrator procedure has been added for 
setting up external organizations. 

“Defining an Integration Workflow 
Process” on page 219

The chapter’s introductory section has been revised 
as follows:

■ A clarification was added that workflows listed 
in the chapter may not be available in the 
sample database but may be requested.

■ A brief explanation of Universal Application 
Network (UAN) has been added. 

“Appendix” on page 251 Several sections throughout the appendix that 
pertained to the SIS OM CurrencyCode and SIS OM 
Language Code user properties have been removed. 
These user properties are no longer in the Siebel 
repository. 

“SmartScript for Price Comparison” 
on page 251

A Note is added at the end of this section clarifying 
that a script must be released when it is ready for 
production. 

Table 2. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision

“Registering a Premise Hookup 
(Administrator)” on page 91

Procedure was incomplete. Added description of 
Product field to the field table.
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Product Overview 1
Siebel eEnergy is a suite of eBusiness applications that is designed to meet the sales, 
marketing, call center, and field service requirements of regulated electric, gas, and 
water local distribution companies (LDCs) as well as unregulated energy service 
providers (ESPs). Siebel eEnergy serves residential, commercial, and industrial 
customers.

Siebel eEnergy can support large LDCs’ call center operations and integrated legacy 
customer information systems (CIS). It supports an account hierarchy and premises 
records. It also allows the tracking, sharing, and reporting of usage, billing, and 
other service details. 

Siebel eBusiness Applications are designed to work together to provide an 
integrated Customer Relationship Management (CRM) solution. Siebel eEnergy 
allows energy companies to implement Siebel modules that include sales, service, 
and marketing functionality. These modules include Siebel Sales, Siebel Service, 
Siebel Call Center, Siebel Field Service, and Siebel Configurator. 

Siebel Anywhere allows the Siebel system administrator to apply upgrades to 
Dedicated Web Clients, Mobile Web Clients, and Siebel servers.
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Key Features of Siebel eEnergy
Table 1 describes how Siebel eEnergy provides solutions for key business issues.

Table 1. Siebel eEnergy Solutions for Key Business Issues

Business Issue Siebel eEnergy Solutions

Account and Premises 
management

■ Management of accounts through multilevel account hierarchies based on 
complex account relationships

■ Independent management of service accounts and billing accounts 

■ Tracking of physical facilities and network delivery points through premise 
records

■ Tracking of meters at service points

■ Management of account and customer information through profiles

Agreement management ■ Automated production of agreements from accepted quotes

■ Coordination of pricing information

■ Assigning of standard terms, conditions, and features

■ Tracking to make sure that agreements and service entitlements are fulfilled

Audit trail ■ Creation of a history of all the changes that have been made to various 
kinds of information 

■ Records show who has accessed an item, what operation has been 
performed, when it was performed, and how the value was changed

■ Useful for maintaining security, examining the history of a particular 
record, and documenting modifications for future analysis and record-
keeping

Billing management ■ Integration with back-office billing systems

■ Query and display of billing information

■ Management of payment information, payment plans, bill adjustments, and 
bill profiles

Call center optimization ■ Single desktop to manage multiple types of customer interactions

■ Computer telephony integration (CTI) to connect callers with the most 
qualified agent

■ Integrated Web and Interactive Voice Response (IVR) self-service 
functionality 
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Credit management ■ Integration with a back-office credit system

■ Management of credit alerts

■ Notification of customers who are delinquent in payments

Customer acquisition ■ Analytical tools for segmenting prospects and developing targeted 
campaigns

■ Campaign management tools for developing and executing multichannel 
campaigns 

■ Prebuilt performance analysis tools 

■ Call scripting (providing text that uses proactive selling and retention 
techniques for employees to use when speaking with customers)

■ Territory assignment, lead scoring, and routing

Customer and partner 
applications

■ Siebel Partner Relationship Management, which allows your company to 
turn channel partners into an extended, virtual sales and service 
organization through the Internet 

■ Siebel eService, which allows your customers to create and track their own 
trouble tickets and service requests, and to search for answers to frequently 
asked questions (FAQs), through the Internet

■ Siebel eSales, which allows your customers to use the Internet to browse 
though your company’s products and services, and to configure and 
purchase them

Customer retention ■ Customer profile that is shared throughout the enterprise

■ Profile analysis to predict customer churn

■ Generation of win-back actions

■ Sales tools that increase sales effectiveness and maximize time spent 
building relationships

■ Tools for marketing analysis, campaign development, and execution

Equipment and 
infrastructure

■ Management of physical assets available at a customer site

■ Tracking of equipment sales to accounts

■ Management of meters and assets

Table 1. Siebel eEnergy Solutions for Key Business Issues

Business Issue Siebel eEnergy Solutions
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Key Features of Siebel eEnergy
Fraud management ■ Integration with a back-office fraud management system

■ Management of fraud alerts

■ Definition of relevant thresholds for customer fraud profiles

■ Classification of customer accounts to indicate the likelihood of fraud

■ Management of customer accounts that are either late in settlement or 
delinquent

Order configuration and 
management

■ Siebel Configurator automates the generation of quotes and sales orders

■ Tracking of relationships between sales, sales orders, and work orders

■ Definition of process rules and automatic escalation of open sales orders

■ Use of product classes and attributes, and product bundles in generating 
sales orders

■ Provisioning of sales orders through work orders

Pricing management ■ A set of tools for defining pricing adjustments and the conditions under 
which they should be applied

■ An engine that evaluates condition statements and determines which 
pricing adjustments to apply

■ A testing area that allows assessment of the pricing adjustments

■ Integration with end-user interfaces such as Quotes, Orders, Siebel eSales, 
Siebel Partner Relationship Management, and Siebel eConfigurator

Siebel Marketing ■ Analysis of customer information and measurement of campaign results 
with eIntelligence

■ Creation and execution of targeted marketing campaigns

■ Internet marketing with eMarketing: Integrated email campaigns, 
customized Web offers, personalized Web pages, Internet newsletters, and 
Internet surveys

Table 1. Siebel eEnergy Solutions for Key Business Issues

Business Issue Siebel eEnergy Solutions
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Product Modules and Options
Many Siebel eBusiness Applications modules can be purchased and used with 
Siebel eEnergy. In addition, optional modules specific to Siebel eEnergy can be 
purchased to provide enhanced functionality for various business processes.

Third-party and legacy 
integration

■ Prebuilt COM and CORBA interfaces to leading Operating System Software 
(OSS) and Enterprise Resource Planning (ERP) applications

■ Integration mapping tools for cross-application process integration

■ Siebel Enterprise Integration Manager (EIM), which allows bidirectional 
data exchange and synchronization

■ Performing credit verification and address validation

■ Maintenance of billing accounts through an external billing system

Trouble ticket and service 
request management

■ Single platform for logging, assigning, managing, and resolving customers’ 
problems, including network problems or outages affecting customers

■ Online solutions search capability

■ Proactive customer notifications through email, pager, fax, and Internet

■ Automatic escalation of overdue trouble tickets and service requests

■ Integration with external outage management systems

Upselling and cross-selling ■ Scripting engine that identifies upsell and cross-sell opportunities with 
every customer contact

■ Product configuration system that prompts the salesperson to propose high-
margin services

■ Integrated asset management system that provides information about 
configuration at each service location

Usage, billing, and service 
detail

■ Access to customer usage and service information

■ Summary customer data for account analysis

Table 1. Siebel eEnergy Solutions for Key Business Issues

Business Issue Siebel eEnergy Solutions
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Business Functions of Screen Tabs in Siebel eEnergy
For information about the optional modules that can be used with Siebel eEnergy, 
contact your Siebel sales representative.

NOTE: This guide documents Siebel eEnergy with the optional modules installed. In 
addition, the Sample database includes data for optional modules. If your 
installation does not include some of these modules, your software interface will 
differ from that described in some sections of this guide.

The exact configuration of Siebel eEnergy screens and views depends on your 
company’s configuration of the application. For introductory information about 
using the Siebel eEnergy interface, see Fundamentals and Siebel Online Help.

Business Functions of Screen Tabs in Siebel eEnergy
The Siebel eEnergy interface includes procedure-specific screens. Some screens are 
used exclusively by administrators. Table 2 lists the most frequently used Siebel 
eEnergy screens and the functions of the views in those screens.

Table 2. Siebel eEnergy Screens 

Screen Functions For More Information

Accounts Create, view, and update accounts. Set up and 
maintain account hierarchies. Define and 
maintain account profile information. Query 
customer bills. Record bill payments, 
repayment plans, and adjustments. 

See Chapter 2, “Accounts”, Chapter 3, 
“Profiles”, and Chapter 10, “Billing” in 
this guide

Activities Track personal activities and view activities for 
other team members. Track the progress of 
accounts, trouble tickets, service requests, 
interactions with contacts, and opportunities. 

See Siebel Call Center User Guide

Agreements Create, generate, modify, approve, and track 
agreements. 

See Chapter 5, “Agreements and 
Entitlements,” in this guide

Assets Manage information about products sold to 
accounts. 

See Siebel Field Service Guide
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Audit Trail Creates a history of the changes that have been 
made in Siebel eEnergy.

See Applications Administration Guide

Briefings Gather and format information from a number 
of different sources, both inside and outside 
your company, including the World Wide Web. 

See Siebel eBriefings Administration 
Guide

Calendar Create and display activities (including to-do 
activities) and share calendar information with 
co-workers. 

See Fundamentals

Campaigns Manage outbound communications with 
prospects targeted for a particular marketing 
effort.

See Applications Administration Guide

Contacts Record and track business and personal 
contact information associated with an 
account, an opportunity, a trouble ticket, or 
service request. 

See Chapter 4, “Contacts,” in this 
guide

Credit 
Management

Manage and monitor customer credit issues. 
Share data with third-party credit management 
applications. 

See Chapter 13, “Credit Management,” 
in this guide

Entitlements Associate entitlements with accounts, 
contacts, and products. Determine a 
customer’s eligibility for service under its 
entitlements. 

See Chapter 5, “Agreements and 
Entitlements,” in this guide

Expense Reports Manage expense-report information for your 
own expenses, or your team’s expenses. 

See Applications Administration Guide

Forecasts Create business forecasts based on 
opportunities or products.

See Applications Administration Guide

Fraud 
Management

Manage and monitor customer fraud issues. 
Share data with third-party fraud management 
applications. 

See Chapter 14, “Fraud Management,” 
in this guide

Literature Display company- and industry-related 
literature cataloged by the Siebel 
administrator.

See Applications Administration Guide

Opportunities Manage sales opportunities for business and 
residential customers. 

See Chapter 8, “Opportunities,” in this 
guide

Table 2. Siebel eEnergy Screens 

Screen Functions For More Information
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Orders Create sales orders and track their status. 
Generate order summaries. 

See Siebel Order Management Guide 
and Siebel Order Management Guide 
Addendum for Industry Applications

Premises Create and maintain premises. Track service 
points, customer premise equipment, and 
meters associated with a premise. 

See Chapter 6, “Premises,” in this 
guide

Price 
Comparison

Creates quotes comparing in-house rate plans 
against competitors’ rates

See and in this guide

Products Display products, product lines, product 
features, and price lists. 

See Siebel Order Management Guide 
and Siebel Order Management Guide 
Addendum for Industry Applications

Quality Manage information about adverse events or 
reactions related to products.

See Applications Administration Guide

Quotes Create, view, and update quotes. Update 
opportunities and configure solutions for 
quotes. 

See Siebel Order Management Guide 
and Siebel Order Management Guide 
Addendum for Industry Applications

Service Requests Create, display, and update customer requests 
for information about or assistance with 
products or services. 

See Chapter 12, “Service Requests and 
Trouble Tickets,” in this guide

SmartScripts Define the application workflow for an 
interactive situation in a script. These 
interactive situations could include inbound 
communications (such as customer service) 
and outbound contacts (such as 
telemarketing).

See Siebel SmartScript Administration 
Guide

Solutions Search, organize, and add to a knowledge base 
of answers to service requests and trouble 
tickets. 

See Siebel Field Service Guide

Trouble Tickets Create, display, and update customer requests 
for information about or assistance with 
products or services. 

See Chapter 12, “Service Requests and 
Trouble Tickets,” in this guide

Work Orders Manage the work components associated with 
activating or turning off service for a customer. 

See Chapter 11, “Work Orders,” in this 
guide

Table 2. Siebel eEnergy Screens 

Screen Functions For More Information
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This chapter defines some basic concepts about accounts. It also provides the 
procedures for setting up account hierarchies and updating account information. 

Administrators, such as call center administrators, sales administrators, and sales 
managers, will benefit from reading this chapter. It describes how your customer 
service representatives (end users) will enter information into the accounts screens, 
which form the hub of customer information. After becoming familiar with the end-
user procedures, you can customize the software to fit your company’s needs.

Accounts Overview
An account is any external organization with which your company does business. 
It negotiates agreements, receives service and bills, and raises trouble tickets. An 
account is usually the central entity of a Siebel CRM implementation.

After adding accounts in Siebel eEnergy, end users at your company will contribute 
information for tracking customer service, processing requests, viewing 
agreements, and so on. 

Account Hierarchy
A single account per customer will probably meet your company’s needs to track 
the accounts of residential customers. However, for large commercial clients, end 
users might need to build an account hierarchy. An account hierarchy is a multilevel 
structure reflecting parent-child relationships within the organization.

Within a complex account hierarchy, an account usually represents one of these:

■ A customer, prospective customer, or household

■ An individual service or billing account

■ An aggregate account for billing or service accounts
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■ A division in an organization

■ An entire organization

Hierarchies can accommodate subsidiaries and complex organizations that have, 
for example, a world headquarters, multiple regional headquarters, and many 
branch locations, each with its own service and billing requirements. 

This multiple-level structure supports a top-down view of the customer. Separate 
child accounts can be used to designate which information pertains to one 
subsidiary or another within the organization. 

A hierarchy has these further advantages:

■ It allows you to maintain customer information, such as address and contact 
name at each point in the hierarchy.

■ It aids in specifying usage and billing roll-up relationships.

■ It allows you to create and maintain aggregation points and to support complex 
discounting methods.

To fully support mergers, demergers and corporate restructuring, Siebel eEnergy 
automatically updates the master account or parent account of an account record 
and its children when the changes are made to the account hierarchy. In particular, 
it is possible to reparent a child account if that subsidiary is sold to another holding 
company, or to reparent a whole organization if it is purchased by another entity. 
These changes take effect by changing the parent account of the account record.

Account Classes
An account class is a method for classifying an account according to its position and 
role in an account hierarchy. When setting up the hierarchy, end users define 
parent-child relationships among the accounts. Then they designate which account 
class applies to each new account, according to your customer’s requirements and 
organizational structure. 
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For example, with energy companies, it is common for the service to be delivered 
to one subsidiary while bills get sent to another subsidiary. Separate accounts 
would be created for each subsidiary, one with the account class service and the 
other with the account class billing to reflect their different functions. An account 
given the account class service generally stores service item information and allows 
end users to analyze the customer’s usage or orders. An account given the account 
class billing generally stores information for the financial transaction or invoice.

Siebel eEnergy does not restrict parent-child associations based on account class. 
Any class can be a child of any other class. For example, a customer account can be 
placed anywhere in the hierarchy, and a billing account can be the parent or the 
child of a service account. To enforce hierarchy rules based on account class, you 
need to set them up through state models. For more information about state models, 
see Siebel Business Process Designer Administration Guide.

Out of the box, Siebel eEnergy provides these five classes for accounts:

■ Customer Class. An account with this class represents the actual customer, 
person, or organization that is receiving service. A customer account includes 
basic customer information, such as the company name and headquarters 
address. It can receive both service and bills. 

■ Service Aggregator Class. An account with this class receives aggregate usage 
details for all of its subsidiary accounts. It can be anywhere in the account 
hierarchy. It allows you to generate and view multiple service accounts that 
share some specifications. 

Implementation example: A manufacturing company has several industrial 
complexes, and each complex is made up of various manufacturing plants 
receiving electric and gas services. Each plant can have the electric and gas 
services set up as separate service accounts. The corporate headquarters can set 
up a service aggregate account for each type of manufacturing plant to track 
electric and gas usage per type of manufacturing process.

■ Service Class. An account with this class receives service, but not bills. In the 
account hierarchy, it is the account level at which the physical delivery of the 
service or product occurs. It can represent a person or organization with multiple 
service addresses.
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■ Billing Aggregator Class. An account with this class receives aggregate billing 
details for all of its subsidiary accounts. It can be anywhere in the account 
hierarchy. It allows you to generate and view multiple billing accounts that have 
some of the same specifications. It can be set up to bill the customer based on 
certain requests, such as creating bills for the different services and rolling those 
separate billing statements into a billing aggregate account. It also allows you to 
create and maintain billing aggregation points and to support complex 
discounting methods. It receives and aggregates bills. 

Implementation example: A company has offices in different states, and each 
office receives services two different services: gas and electricity. Each office can 
have both services set up as separate billing accounts, and each office can be set 
up as a billing aggregate account for the services. Then the corporate 
headquarters can be set up as a billing aggregate for the three offices and a single 
payment can be made for the services.

■ Billing Class. An account with this class is used to invoice the customer for 
products and services. In the account hierarchy, it is the account level at which 
the financial transactions for the service or product occur. It shows the collection 
of all charges applied to a customer in a given time frame for which the customer 
must submit payment. 
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Siebel eEnergy displays certain information based on the account class: 

■ The Service Account and Billing Account Explorers filter on account class.

■ In the Quotes and Order Entry views, only those accounts with the appropriate 
account class will appear in the dialog box for association. 

NOTE: You can set up additional account classes or rename the default classes. 
However, when renaming, be careful to rename the explorers as well, because they 
filter accounts on class names. For instructions on modifying account classes, see 
Applications Administration Guide.

Figure 1 shows an example of an account hierarchy where parent-child 
relationships are established along service and billing account classes.

Figure 1. Example of Account Hierarchy
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Account Roles and Responsibilities
Sales administrators and sales managers usually oversee the creation and 
maintenance of accounts by their teams. All team members (end users) can create 
an account and update account information. 

Table 3 lists the roles and responsibilities related to account procedures.

Table 3. Account Roles and Responsibilities

Role Description

Administrator Sales Administrator or Sales Manager

■ Determines what information is required for an account

■ Determines what account information is visible to each member 
of the sales force

■ Reviews and analyzes account activity to measure performance 
and improve sales effectiveness

■ Reviews account hierarchies developed by the sales staff

End User Customer Service Representative

■ Performs call center activities, primarily responding to customer 
inquiries and sales order requests

■ Creates accounts for new customers, including the required key 
information for an account

■ Updates accounts for existing customers

■ Understands relationship between accounts and associated 
contacts

■ Creates account hierarchies

■ Understands account hierarchies and relationship of accounts 
within hierarchy

Sales Representative

■ Focuses on outside sales and customer relationship management

■ Creates accounts for new customers, including the required key 
information for an account

■ Updates accounts (such as creating a sales opportunity), creates 
sales orders, and tracks service requests or trouble tickets

■ Creates account hierarchies, designating parent-child 
relationships among an organization’s accounts
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Business Scenario for Accounts
This scenario shows a sequence of procedures performed by an end user. Your 
company may follow a different sequence according to its business requirements.

A customer service representative (CSR) receives a call from a prospective 
customer. The inbound call is arbitrarily routed to the CSR, since IVR (Interactive 
Voice Response) and CTI (Computer Telephony Integration) are unable to locate the 
account.

The caller explains that he is the owner and CEO of a small company that develops 
specialized software for the high-tech industry. He wants to use the CSR’s company 
as its sole provider.

The CSR first verifies that no account currently exists for the caller and then gathers 
the following information about the caller’s company: 

■ It has these three service locations: 

■ The headquarters or administrative office is located in Newcastle, England.

■ A development office is based in York.

■ A sales office is located in Birmingham.

■ All services for the Northern England offices (Newcastle and York) will be billed 
on a single invoice; however, each location will receive a statement.

■ The Birmingham site will receive its own invoice.

■ The caller wants a discount based on all the services he has at all three locations, 
and he wants to receive a statement for all services.
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Based on this conversation, the CSR creates the account hierarchy shown in 
Figure 2.

Based on this hierarchy, the CSR must set up the following to establish service for 
the caller:

■ One customer account for the entire company

■ Two billing accounts (one for Northern England and one for Birmingham)

■ Three service accounts (one for Newcastle, one for York, and one for 
Birmingham)

Figure 2. Account Hierarchy for Business Scenario
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■ One billing aggregator account for both billing accounts so that a complete 
statement can be invoiced

Next, the CSR receives a call from a customer who has noticed that some oil is 
leaking from a green box in her backyard. The CSR accesses the customer’s account 
to determine what equipment might be malfunctioning and when it was previously 
checked.

Figure 3 shows the sequence of procedures an end user might perform to manage 
accounts:

Administrator Procedure for Accounts
This section provides instructions for the following procedure: 

■ To set up external organizations on page 38

Figure 3. Example of Sequence for Accounts
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Setting Up External Organizations (Administrator)
Administrators must set up external organizations to populate the selection boxes 
that appear in external organization fields throughout your Siebel application. 

To set up external organizations

1 From the application-level menu, choose View > Site Map > 
Data Administration > Accounts/Orgs.

2 In the Accounts/Orgs list, create a new account record.

3 Clear the Account Flag check box. 

4 Complete the other fields as necessary.

The external organization appears in the selection box that is displayed when an 
end user enters an external organization field. External organization fields 
include, but are not limited to, those listed in Table 4.

End-User Procedures for Accounts
This section provides instructions for the following procedures:

■ To create an account on page 39

■ To create an account hierarchy on page 41

■ To change a parent-child relationship on page 41

■ To review the hierarchy for an account on page 42

Table 4. Examples of External Organization Fields

Screen View Field

Accounts Equipment > Other Equipment Supplier

Accounts Infrastructure Owner

Premises Infrastructure > Account Detail Owner

Work Orders More Info Provider
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■ To view the account hierarchy as an organization chart on page 42

■ To view a list of child accounts on page 42

■ To access the customer portal view on page 43

■ To access the account views on page 44

■ To view an agreement for an account on page 44

■ To view usage detail information on page 44

■ To add installed or planned equipment on page 45

■ To add energy-related infrastructure on page 46

Creating an Account
An account forms the major link for entering detailed information about customers. 
After adding accounts in Siebel eEnergy, end users can contribute information for 
tracking customer service, processing requests, viewing agreements, and so on. 

To create an account 

1 Navigate to the Accounts screen.

2 Click the More Info view tab.
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3 In the More Info form, add a record and complete the necessary fields. To access 
more fields, click the show more button in the form.

Some fields are described in the following table.

Field Comments

Account Class Distinguishes an account within an account hierarchy when 
dividing accounts into billing or service accounts. The Billing 
Account and Service Account Explorers filter on this field. Also, 
the accounts available for association in the Quotes and Entry 
views are determined by account classes.

For Account Class, select Customer if you are creating a 
residential customer account. 

For more information on account classes, see “Accounts 
Overview” on page 29.

Account Team Determines who can access information about the account.

Address Address for the account. Enter a new address or associate an 
existing one. In the dialog box for associating addresses, the 
Premise check box indicates if the address is a premise. 

Good Standing Determines if the account is blocked centrally, which excludes 
certain activities from being performed. Note that this field is 
different from account status.

Lock Assignment If you do not want Assignment Manager to run, check this field. 
If you do not select Lock Assignment, Assignment Manager can 
reassign this account to another team according to its territory. 
For example, if you want to allow a commercial account with 
three different locations to be handled by the same account 
manager, even though one or two locations fall in another 
account manager’s territory, do not select Lock Assignment.

Site Description of the location or function of the account, such as 
headquarters or corporate or San Francisco.

Synonyms Allows you to refer to accounts (and their sites) in the way that 
you prefer. For example, an account named A/B Products, Inc., 
might have the following synonyms: AB, A/B, and AB Products.

When you search for an account or enter an account in another 
part of Siebel eEnergy, you can use a synonym instead of the 
actual name.
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Creating an Account Hierarchy
Creating an account hierarchy consists of creating child accounts and associating 
them with a parent account. You must create the parent account before adding child 
accounts. For instructions about creating an account, see “To create an account” on 
page 39.

NOTE: For mergers or acquisitions, end users might need to move the entire 
hierarchy under a new account. To do so, follow the procedure described in “To 
change a parent-child relationship” on page 41. Be sure to associate the new parent 
account at the top level. The new parent ID automatically cascades to its child 
accounts, reflecting the change.

To create an account hierarchy

1 Navigate to the Accounts screen.

2 Select the account by doing one of these:

■ Perform a query in the list.

■ Make the appropriate selections from the Queries and Show drop-down lists 
to define the account record set, and then select the account in the Accounts 
list.

3 In the Accounts list, add a record for each child account and complete the 
necessary fields.

4 In the Parent field, select the parent account from the dialog box.

To change a parent-child relationship

1 Navigate to the Accounts screen.

2 Select the child account.

3 In the Parent field, select a different parent account in the dialog box.
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Reviewing an Account Hierarchy
End users can review the entire account hierarchy to check its structure. 

To review the hierarchy for an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select one of these options:

■ To review the hierarchy for billing or service accounts, select Billing Account 
Explorer or Service Account Explorer, and then expand the subfolders in the 
explorer tree.

The explorer view contains only those accounts for the designated account 
class, including corresponding aggregator accounts. 

■ To review all account hierarchies, select Account Management, and then 
expand the subfolders in the explorer tree.

The explorer view displays accounts under the subfolders Accounts (shows 
all child accounts, regardless of class), Billing Accounts, and Service 
Accounts.

To view the account hierarchy as an organization chart

1 Navigate to the Accounts screen.

2 Select the account.

3 Click the Account Hierarchy view tab.

4 Scroll down to view the organization chart showing the account hierarchy. 

To view a list of child accounts

1 Navigate to the Accounts screen.

2 Select the account.

3 Click the Account Hierarchy view tab.

4 Scroll down and select Account Org Hierarchy from the lower Show drop-down 
list. 

A list of child accounts appears. 
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Accessing or Updating Account Information
Siebel eEnergy allows end users to access the same account information through 
different views. Specific views allow end users to find the information most relevant 
to them, according to the procedure they need to perform at that moment.

Most views allow end users to record interactions with a customer and to update 
the customer’s information, depending on the system setup and the end user’s 
access rights. 

From all views, end users can access information on billing, service, quotes, 
agreements, contacts, and so on. 

The end-user views are:

■ Customer portal view (call center agent). While talking to the customer, call center 
agents generally need an overview of a customer’s account. The customer portal 
view allows them to access the most commonly needed information in a 
compact presentation.

■ Account views (sales representative). Sales representatives access the same 
account information as call center agents, but they might do it through the 
Account views. Each view displays a specific piece of account information. For 
example, while preparing a report, a sales representative might want to review 
the usage details or order history for an account. The sales representative does 
not need the account overview information available in the customer portal 
because she is normally not talking to the customer on the telephone while 
reviewing information for her report. 

To access the customer portal view

1 Navigate to the Accounts screen.

2 Select the account.

3 In the Accounts list, click the hyperlink in the Name field.

The Customer Portal view appears with several lists and forms summarizing the 
account information.
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To access the account views

1 Navigate to the Accounts screen.

2 Select the account.

3 Click a view tab to access specific information for that account.

To view an agreement for an account

1 Navigate to the Accounts screen.

2 Select the account.

3 From the Show drop-down list, select Agreement Accounts Explorer.

4 In the explorer tree, expand the folder for the account.

Subfolders appear for the selected account’s agreements. 

5 Expand the folders and select the specific agreement or subagreement to view.

Monitoring Infrastructure, Equipment, and Usage 
End users can record and monitor the infrastructure, equipment, and usage 
information for service customers.

NOTE: End users can either view the usage detail information or add energy-related 
infrastructure information through the Premises screen as well.

To view usage detail information

1 Navigate to the Accounts screen.

2 Select the account.

3 Click the Usage Detail view tab.

A list of services appears with usage history beneath it. The history displays 
period-by-period or monthly usage information about the account and service 
you selected.
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4 In the Usage Detail list, select the service.

5 In the Usage History list, from the drop-down list, select the type of usage 
information you want to view.

All options except Usage History and Usage Information display the information 
in charts.

To add installed or planned equipment

1 Navigate to the Accounts screen.

2 Select the account.

3 Click the Equipment view tab.
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4 In the Equipment or Other Equipment list, add a record and complete the 
necessary fields.

Use the Equipment list to record and view items supplied by your company and 
the Other Equipment list to record and view items supplied by other companies, 
including competitors and alliance partners.

You can also use these lists to record information about the equipment your 
customers own or plan to acquire. For instance, if your company offers 
discounted rates on electricity to customers who install all-electric kitchen 
appliances, you might want to record information about the appliances currently 
installed in a large apartment building, or the future appliance needs of a 
developer who is building several new homes. 

If you create separate service accounts for customers with multiple locations, 
you can associate installed and planned equipment for a location with its 
corresponding service account. If you use a single account to represent a 
customer with multiple locations, you should associate the installed and 
planned equipment for each of the customers’ various locations with the one 
account for that customer.

Some fields in the lists are described in the following table.

To add energy-related infrastructure

1 Navigate to the Accounts screen.

2 Select the account.

3 Click the Infrastructure view tab.

Field Comments

Install Date Date on which the equipment was installed, or the date on which 
the customer plans to purchase the equipment.

Product Choices change dynamically depending on the type of equipment 
you select. Most of the other fields are populated automatically 
with data about the product you select. 

Type Links equipment to type of service available for that equipment.
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4 In the list, add a record and complete the necessary fields.

Use this list to record information or attributes for the energy-related 
infrastructure at the sites to which you provide services. Typical infrastructure 
information might include meter type, transformer size, voltage, phase, 
capacitors, and gas supply pressure. This may be especially important at large 
industrial or commercial sites such as factories, warehouses, and office 
buildings. 

If you use multiple service accounts to represent a customer with multiple 
locations, you can associate infrastructure items at each location with its 
corresponding service account. If you use a single account to represent a 
customer with multiple locations, you should associate the infrastructure items 
at all the customer’s locations with the one account for that customer.

Some fields in the list are described in the following table.

Additional End-User Procedures Related to Accounts
For descriptions of other procedures related to accounts, see Siebel Bookshelf.

Service Item Additions to a Service or Billing Account
A service item is an instance of a service that your company provides to a particular 
person. End users add services through the ordering module, and the steps involved 
depend on your company’s setup. For instructions, see Siebel Order Management 
Guide Addendum for Industry Applications.

Field Comments

Attribute An attribute of the infrastructure item, such as Substation or Transformer. 
Values change dynamically with your selection in the Service Type field.

Owner Owner of the infrastructure item.

Value Specific information about the data in the Attribute field.
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This chapter explains some basic concepts regarding profiles and provides step-by-
step instructions for creating them. It also describes the interrelationship among 
profiles, business functions, and back-office systems.

Administrators, such as call center administrators, sales administrators, and sales 
managers, will benefit from reading this chapter. It shows where customer service 
representatives (end users) will enter information for these profiles and which 
information might be critical for smooth integration with back-office systems. 

After becoming familiar with the end-user procedures, you can customize the 
software to fit your company’s needs.
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A profile stores information required to perform a business function. For example, 
a billing profile contains the information needed to invoice the customer for 
products and services.

Profile Types
Table 5 describes the account profiles available within Siebel eEnergy.

Table 5. Account Profiles

Profile Comments

Address Profile and 
MSAG Profile

Allows for validation of an address against a master street 
address guide (MSAG) data source or other external database. 
You can also use the MSAG Profile as an example for creating 
other profiles relevant to your company.

Billing Profile Captures the bill run characteristics needed to invoice the 
customer for products and services. It is generally associated 
with a billing account. An account has one billing profile that 
can be used in multiple billing systems to produce a bill for the 
account.

Customer Profile Contains information about an account when the customer is 
an organization rather than a residential account. Much of the 
profile information can be added automatically if your 
company imports this data into Siebel eEnergy from its billing 
software or customer information system. 

Energy Exemption Profile Provides information about the special status of a customer, 
such as if the customer has life support, is a senior citizen, or 
has a credit problem.

Energy Statement Profile Records billing statement preferences, including number of 
copies, media, contact requesting the statement, as well as 
energy supplier and aggregator information.

Financial Profile Contains information used to perform a credit check on the 
customer. 

Fraud Profile Contains information about the fraud status of an account. It 
allows end users to set fraud thresholds that, when exceeded, 
trigger a fraud alert. 
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NOTE: The order management module no longer uses the Service Profile view. If you 
used the Service Profile view in the 6.x or earlier versions of Siebel eEnergy, you 
want to use the new MSAG Profile view instead.

Profile Roles and Responsibilities
Table 6 lists the employees who generally perform the procedures related to profiles. 

Loyalty Profile Contains information needed to predict customer churn, 
estimate debt risk, and identify upsell and cross-sell 
opportunities. When integrated with a third-party predictive 
modeling package, it displays scores generated by that 
software.

Site Profile Contains detailed information about an account’s location.

Table 6. End-User Roles and Responsibilities

Position Description

Customer Service 
Representative

■ Focuses on call center activities, primarily responding to customer 
inquiries and sales order requests

■ Understands account hierarchies, including the required key 
information for a profile

■ Creates profiles for new customers, modifies and adds profiles for 
existing customers

Sales 
Representative

■ Focuses on outside sales and customer relationship management

■ Understands account hierarchies, including the required 
information for profiles

■ Creates profiles for new customers, modifies and adds profiles for 
existing customers

Table 5. Account Profiles

Profile Comments
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Business Scenario for Profiles
This scenario shows a sequence of procedures performed by a customer service 
representative (end user). Your company may follow a different sequence according 
to its business requirements. 

This scenario continues the “Business Scenario for Accounts” on page 35. For a new 
customer, the customer service representative (CSR) has already created an account 
hierarchy, added a contact for the account, and entered an address for the account. 

Now, for each service account in the hierarchy, the CSR wants to validate its address 
against the MSAG (master street address guide) database or a similar external 
database. 

After submitting each new address for validation, the CSR chooses the correct 
match from the list the database sends back. She checks to see that the validated 
field has been automatically updated to indicate the procedure was completed. 

Next the CSR creates unique profiles associated with individual accounts. Each 
profile stores information necessary to perform a business function.

Starting with the top-level parent account, the CSR creates a financial profile and a 
statement profile:

■ The CSR creates a financial profile for the top-level parent account because the 
customer’s company will have financial responsibility for all its accounts. The 
financial profile includes all necessary information to perform a credit check on 
the company. 

■ The CSR also creates a statement profile for the top-level account because the 
customer wants to receive a statement at the corporate level that summarizes all 
charges for products and services. 

The statement profile contains information, such as the address, number of 
copies of the statement required, statement media type, frequency of statement, 
contact person, and so on. Each statement profile is given a unique identifier 
within the CSR’s company’s billing system. All the profile information is 
required by the billing system so that the statement can be processed. 
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The CSR then moves on to the billing subaccounts in the hierarchy and creates 
separate billing profiles for those subaccounts. Each billing profile stores 
information, such as the mailing address, contact, billing frequency, and debit or 
credit card data for that account.

She then creates statement profiles for several subaccounts so that those offices can 
receive informational statements for the amount of service used.

Next she creates an exemptions profile wherever subsidy and tax exemption 
information applies. For example, a charitable organization will have a tax 
exemption status. Exemption profiles can be created for any level of the account 
hierarchy and are usually part of the initial account setup. They contain information 
that can also be passed to the billing system. 

Then she creates a site profile for each service account, which specifies how many 
floors the site has, where equipment is located within the site, and so on. 
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Figure 4 shows the accounts and profiles needed for the customer’s account 
hierarchy discussed in the business scenario. 

NOTE: Siebel eEnergy does not restrict how end users build hierarchies. If you want 
to enforce certain rules, you must set the rules up within Siebel eBusiness 
Applications. This diagram shows one recommended use of profiles for specific 
account classes.

Figure 4. Business Scenario for Account Hierarchy and Profiles
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Figure 5 summarizes the interrelationship among accounts, profiles, and back-
office systems. 

NOTE: For simple residential customer accounts (those not separated into billing and 
service accounts), all profiles are directly associated with the customer account and 
not with subaccounts as shown in Figure 5.

Figure 5. Interrelationships Among Accounts, Profiles, and Back-Office Systems
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End-User Procedures for Profiles
This section provides instructions for the following procedures:

■ To create or update a profile on page 56

■ To add payment method information to a billing profile on page 57

■ To run a credit check on page 61

■ To validate an address on page 63

■ To revalidate an address on page 64

Creating and Updating a Profile
At each level in the account hierarchy, end users can create one or more account 
profiles. However, administrators need to make sure the application supports the 
specific type of profiles they want end users to maintain. For example, if the billing 
application does not support exemption plans, there is no need to have an 
exemption profile. 

NOTE: This section pertains to all profiles except Address (MSAG) Profiles. For 
instructions on working with MSAG profiles, see “Creating and Updating an Address 
Profile” on page 63.

To create or update a profile

1 Navigate to the Accounts screen.

2 Select the account by doing one of these:

■ Perform a query in the list.

■ Make the appropriate selections from the Queries and Show drop-down lists 
to define the account record set, and then select the account in the Accounts 
list.

3 Click the Profiles view tab. 
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4 From the Show drop-down list, select a profile type. 

5 In the forms or lists that appear for that specific profile, update the information 
according to the step-by-step instructions found in the next sections. 

The following sections describe the various profiles you can create using this 
procedure and the unique fields required for each.

About Billing Profiles
End users create a billing profile to invoice the customer for products and services. 
A billing profile contains such information as billing frequency, payment type, bill 
media, bill type, and the customer’s email address for sending a bill electronically. 
This information can be submitted to a back-office system, which may be the 
master repository for this information. 

A billing profile is generally associated with a billing account and may represent the 
legally binding agreement between the customer and the service provider. It reflects 
information from an external billing system.

Some fields in the Billing Profile form are described in Table 7. 

To add payment method information to a billing profile

■ Depending on the payment method, add further information or update existing 
information:

Table 7. Billing Profile Fields

Field Comments

Budget Billing Indicates if you require budget billing collection.

Email Bill To Email address to which the customer bill can be sent electronically.

External Billing 
Account #

Populated when Siebel eEnergy executes a preconfigured call to the 
back-office system, requesting an account number. The account 
number generated by the billing system serves as the billing 
system’s primary reference for the life of the account.

Payment Method Payment method selection determines additional fields to update.
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■ For Automatic Debit, Check, or Monthly Statement, enter information in the 
Automatic Debit form.

■ For Credit, enter information in the Credit Card Payment form.

Some fields are described in the following table.

About Customer Profiles
End users create a customer profile for accounts when the customer is an 
organization rather than a residential account. Much of the profile information can 
be added automatically if your company imports this data into Siebel eEnergy from 
its billing software or customer information system. 

The customer profile allows end users to capture relevant customer information, 
such as financial and sales information about the customer, and to record 
information about the customer’s partners and competitors.

About Energy Exemption Profiles
End users create an energy exemption profile to store information about the special 
status of a customer, such as if the customer has life support, is a senior citizen, or 
has a credit problem.

Field Comments

Category Card category of the payment card, such as Debit, 
Procurement, or Credit card.

Block Indicates if a card is blocked. This is determined when 
you run the credit card through a check using an 
external system.

Block Reason Reason that a payment card is blocked. This block only 
applies to one particular payment card. If the client has 
several payment cards, another card can still be used.
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Some fields in the Energy Exemption Profiles form are described in Table 8.

About Energy Statement Profiles
End users create a statement profile to record billing statement preferences, 
including the number of copies, the media, and the contact requesting the 
statement, as well as the energy supplier and the aggregator information.

End users can create multiple statement profiles for an account if the billing system 
supports this. 

Some fields in the Statement Profile are described in Table 9.

Table 8. Energy Exemption Profile Fields

Section Field Comments

LIFELINE Effective Date Date when Lifeline assistance becomes effective.

Eligible Customer’s eligibility for Lifeline assistance.

Received Date Date when Lifeline documentation was received.

Renewal Date Date when Lifeline renewal is required.

TAX EXEMPTION Identification numbers to show eligibility for a 
Federal, State, County, or City exemption. Tax 
Exemption number stores the number of the 
certificate that is issued for temporary exemption 
from tax.

SPECIAL CUSTOMER Shows which categories apply to this customer.

Table 9. Energy Statement Profile Fields

Field Comments

Aggregator Organization that collects statements for several accounts.

Media Media on which the statement is to be transmitted.

Vendor Organization that prints or distributes bills. 
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About Financial Profiles
End users create a financial profile to perform a credit check on the customer. To 
verify a customer’s credit, Siebel eEnergy submits a request to a back-office system 
or credit bureau. The back-office system or credit bureau sends back a response that 
includes a credit score that determines if the customer is authorized by internal 
credit policy to subscribe to services. These back-office systems perform credit 
checks for incorporated businesses or individuals.

Some fields in the Financial Profiles form are described in Table 10. However, 
different fields may appear according to the Account Type you selected (for 
example, Residential as the Account Type). 

Table 10. Financial Profile Fields

Section Field Comments

PROFILE Contact Last Name 
and First Name

Contact for the account. This field is 
automatically populated with the name of 
the contact specified in the Primary Contact 
field.

Corporate Number This may be a business number as provided 
by a state, county, or city government.

Legal Entity Legal name of the company or corporation.

Tax Profile Code Displays the code from standard tax 
categories that classify companies according 
to their tax aspects. This information is 
stored in an external billing or credit/tax 
system. 

BANK Customer’s bank information for the credit 
check.

CREDIT RATING Last Update Date the last credit check was performed. 

Rating Credit rating of the customer.

Source Group that did the most recent credit rating.

Update By The user ID of the person who last 
requested a credit check.
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To run a credit check

1 Set up the financial profile (see “To create or update a profile” on page 56 and 
“About Financial Profiles” on page 60 for instructions).

2 In the Financial Profile form, click Credit Check. 

This sends the financial profile information to an external system, which reports 
a credit rating. The credit rating typically is produced by a credit bureau and 
indicates the customer’s ability to pay. It helps companies to assess their risk 
before agreeing to credit terms with a potential customer.

NOTE: Credit check data for an incorporated business or an individual consists of 
business name, billing address, corporate ID, and tax ID. For an unincorporated 
business, credit check data includes name, social security number, and driver’s 
license.

About Fraud Profiles
A fraud profile contains information about the fraud status of a customer account. 
End users can set up thresholds that, when exceeded, trigger the creation of a fraud 
alert.

Some fields in the Fraud Profiles form are described in Table 11.

Table 11. Fraud Profile Fields

Field Comments

Credit Threshold Amount of credit the account is allowed.

Daily Threshold Threshold limit of the calls the customer can make.

Domestic Threshold Threshold limit for domestic calls the customer can make.

International Threshold Threshold limit for international calls the customer can 
make.

Max Duration of Calls Maximum time that is allowed for a call.
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About Loyalty Profiles
The Loyalty Profile view contains scores generated by a back-office predictive 
modeling application. It helps predict customer churn, estimate debt risk, and 
identify upsell and cross-sell opportunities. 

About Site Profiles
A site profile contains detailed information about an account’s location. Some fields 
in the Site Profiles form are described in Table 12. To access all fields, click the show 
more button in the form.

Max Number of Calls Maximum number of calls that can be made in a given 
period.

Max Value of Calls Cost of the calls, in the appropriate currency.

Overflow Value Select the overflow allowed for the threshold limits in the 
Calculator. Expressed as a percentage. 

Sensitive Number Threshold Threshold limit for calls to sensitive numbers that the 
customer can make. Sensitive numbers may include high-
priced calls such as those to 900 numbers.

Table 11. Fraud Profile Fields

Field Comments

Table 12. Site Profile Fields

Field Comments

Cogeneration Indicates that the site has the ability to generate its own energy but 
can also purchase electricity from an energy provider.

Open Market Indicates if the site is either in an unregulated energy market or in 
a regulated one.
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Creating and Updating an Address Profile
End users can enter addresses without tight restrictions on formatting. However, 
when provisioning services, tighter formatting restrictions may be required by a 
back-office system. 

To guarantee proper formatting, the address needs to be validated against a back-
office data source. In Siebel eBusiness Applications, Address Profiles allow multiple 
formats of one address to be stored. The MSAG (master street address guide) format 
is available with the shipped product, but other formats can be added using Siebel 
Tools. When setting up additional formats, use the MSAG Profile as an example.

Obtaining the proper address format is important in performing several key 
business processes:

■ Validating service addresses or mailing addresses against an external standard 
to guarantee a unique location for finding facilities, activating services, or 
mailing materials through the Postal Service. 

■ Determining the existing services and service provider at the address. 

Each address profile format requires an external data source for validation. Your 
company can either own the data outright or subscribe to a service that provides 
the data. 

After validating an address, end users might need to change some address fields. To 
edit those fields, end users must revalidate the address, as described in this section.

To validate an address

1 Navigate to the Accounts screen.

Servicing Company Energy service company or local distribution company that provides 
the energy service.

Supply 
Characteristics

Specifies if the site is inside or outside your company’s standard 
service territory.

Table 12. Site Profile Fields

Field Comments
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Creating and Updating an Address Profile
2 Select the account.

3 Click the Address Profile view tab. 

The Address list appears with the MSAG Profile form beneath it. The Address list 
shows all the addresses associated with the account.

4 In the Address list, select the address you want to validate. 

5 Scroll down to the MSAG Profile form, add a record, and complete the necessary 
information.

6 If the Validated field indicates “N,” open the Validated dialog box. 

If the address validation is integrated with an external data source, opening the 
Validated dialog box begins a search for possible addresses.

NOTE: This behavior differs from the default behavior of the shipped product, 
which supports manual address validation. In the manual state, you can select 
the “Y” option, at which point the MSAG Profile is marked as validated. 

7 In the dialog box containing addresses, select the address that matches the 
customer’s address.

NOTE: In the dialog box, you can also perform a query and enter criteria to 
narrow the search for addresses.

8 In the MSAG Profile form, make sure the Validated field indicates “Y.” 

After the address has been validated, the MSAG profile becomes read-only with 
the exception of the Access Instruction and Descriptive Location fields. To 
update the profile, the user must revalidate the address.

To revalidate an address

■ Follow the procedure for validating an address (“To validate an address” on 
page 63), but click the ReValidate button after Step 4 on page 64 before 
continuing with the procedure.
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A contact is someone about whom you or your company needs to keep business or 
personal information. Siebel eEnergy helps you manage contacts and associate 
contact data with accounts, opportunities, trouble tickets, or service requests.

Customer service representatives and field service representatives are examples of 
end users who might use contact management functions.

End users can use Siebel eEnergy to:

■ Record and track business and personal contact information

■ Create and track a list of activities for a contact

■ View a contact profile

■ View information about trouble tickets and service requests that are associated 
with a contact

This chapter discusses these procedures and provides instructions for performing 
them.

Business Scenario for Contacts
This scenario shows a sequence of procedures performed by a call center manager 
(administrator) and call center agent (end user). Your company may follow a 
different sequence according to its business requirements.
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Business Scenario for Contacts
A call center agent receives a call from a customer with a service problem. The 
agent verifies that the caller is already registered as a contact by using a query on 
the contact’s name. The agent adds information to the customer’s contact profile 
and provides the needed service by creating a trouble ticket without leaving the 
Contacts screen. The agent then logs the activity. During the call, the customer 
states an interest in purchasing a particular product, so the agent associates an 
opportunity with the contact. After the call, the agent sends a follow-up email to 
the customer to verify that the action was taken.

Figure 6 shows the sequence of procedures that an end user might follow to manage 
contacts.

Figure 6. Example of Sequence for Contact Management
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End-User Procedures for Contacts
End-User Procedures for Contacts
This section provides instructions for the following procedures:

■ To add a contact

■ To add information to a contact profile on page 68

■ To add an activity to a contact on page 68

■ To associate a contact with a trouble ticket on page 69

Adding a Contact
End users need to add contacts and verify that particular contacts are established 
customers. Their company may choose to use passwords for an additional level of 
verification.

End users can view all contact records that they create. If an end user adds a contact 
to an account or opportunity and that account or opportunity has an associated 
sales team, members of the sales team can also view the contact. In a contact 
record, a sales team is also known as a contact access list.

To add a contact

1 Navigate to the Contacts screen.

2 Click the More Info view tab.

3 In the More Info form, add a record and complete the necessary fields.

4 In the Account field, select one or more accounts in the dialog box. 

If there is more than one account associated with this contact, designate one as 
the primary account by selecting the Primary field for that account.

For more information about adding contacts, see Siebel Call Center User Guide.
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Modifying a Contact Profile
Modifying a Contact Profile
End users can modify a contact profile. Contact profiles are distinct from account 
profiles.

To add information to a contact profile

1 Navigate to the Contacts screen.

2 Select the contact by doing one of these:

■ Perform a query in the list.

■ Make the appropriate selections from the Queries and Show drop-down lists 
to define the account record set, and then select the contact in the Contacts 
list.

3 Click the Profile view tab.

4 In the Profile form, complete the necessary fields.

Creating a Contact-Related Activity 
End users can add, modify, or delete activities for a contact.

To add an activity to a contact

1 Navigate to the Contacts screen.

2 Select the contact.

3 Click the Activities view tab.

4 In the Activities list, add a record and complete the necessary fields.

Associating a Contact with a Trouble Ticket
End users can associate a contact with a trouble ticket. A similar method can be 
used to associate a contact with a service request.
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Additional Procedures Related to Contact Management
For more information about Trouble Tickets, see Chapter 12, “Service Requests and 
Trouble Tickets.”

To associate a contact with a trouble ticket

1 Navigate to the Contacts screen.

2 Select the contact.

3 Click the Trouble Tickets view tab.

4 In the Trouble Tickets list, add a record and complete the necessary fields.

NOTE: If the trouble ticket status is set to Closed, some fields cannot be modified. 
To modify these fields, drill down on the Ticket Id hyperlink, and in the Trouble 
Ticket Detail form, change the status to Open or Pending. 

Additional Procedures Related to Contact Management
For descriptions of other procedures related to contact management, see Siebel 
Bookshelf.

Contacts and Opportunities
End users can use Siebel eEnergy to associate an opportunity with a contact. For 
more information, see Siebel Sales User Guide.

Contact Correspondence
End users can use Siebel eEnergy to send email to a contact. If an email application 
and Siebel Office are installed, the message content can be automatically generated. 
For more information, see Siebel Sales User Guide.
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Agreements and Entitlements 5
Agreements and entitlements may be used by customer service representatives, 
field service representatives, service managers, account managers, support renewal 
agents, and contract administrators. Agreement and entitlement data is stored in 
agreement and entitlement records that must be created, associated with other 
records, revised, examined, and printed.

For further procedures and information related to agreements and entitlements, see 
Siebel Call Center User Guide and Siebel Field Service Guide.

Agreements and Entitlements Overview
This section defines agreements and entitlements and discusses the relationship 
between them.

Agreements Defined
An agreement is a legally binding document that defines the obligations to offer, 
provide, or produce specific products or services over a set period of time for a 
specific amount of money. A sale may require an agreement to detail and document 
the sale transaction. 

An agreement typically includes detailed descriptions of pricing, terms, limitations, 
coverage, conditions, legal rights, processes, and guidelines. Agreements are often 
revised to reflect changes in the company, a company’s product lines, or in the 
market.

Siebel eEnergy can manage complex commercial agreements as well as simple 
residential agreements. Complex agreement can have multiple levels, each with 
different terms, conditions, and discounts. 

An agreement must be associated with one contact or at least one account. 
However, agreements may be associated with multiple accounts.
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Agreements and Entitlements Overview
Entitlements Defined
An entitlement defines the level of support to which a customer is entitled. 
Examples of entitlements include response time metrics and service level metrics. 
A metric is a type of provision (for example, response time) combined with a value 
for that provision (for example, 2 hours).

Entitlements are associated with customers through their service-level agreements 
(see “Types of Agreements” on page 72).

Agreement and Entitlement Relationships
The relationship between agreements and entitlements is as follows:

■ An agreement can have one or more entitlements.

■ An entitlement can have one or more metrics, accounts, contacts, or products.

■ The accounts and contacts associated with agreements may be different from the 
accounts and contacts associated with an entitlement.

An agreement that is associated with an entitlement can specify that all contacts or 
products should receive support under the entitlement. This provides blanket 
contact service agreements and blanket product service agreements.

Types of Agreements
Many different types of agreements can be created in Siebel eEnergy, including 
contracts, sales agreements, service agreements, service level agreements, master 
service agreements, work orders, profiles, letters of understanding, letters of intent, 
nondisclosure agreements, subcontractor work orders, price protections, and 
support renewals. Some types of agreements are defined below:

■ A contract is an agreement that typically covers an ongoing relationship between 
a vendor and a customer. A contract states what a vendor is contractually bound 
to provide to a customer and what a customer is contractually bound to 
purchase from a vendor. This type of agreement is legally binding and may 
specify such things as products, services, discounts, terms, and entitlements. 

■ A sales agreement is an agreement that is typically related to a specific sale. This 
type of agreement specifies such things as base price, discounts, special rates, 
rentals or leasing, and financing. 
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Agreements and Entitlements Overview
■ A service agreement is a type of agreement that defines a service relationship. It 
spells out a customer’s rights to receive service, including the price, service 
level, support requirements, maintenance, and warranty. Service agreements 
have specific components that include:

■ Service Calendars. Specify the days and hours during which service will be 
provided (for example, Monday to Friday and 9 to 5).

■ Quotas. Specify the amounts of service the customer can receive (for 
example, number of phone calls allowed, number of on-site visits allowed, 
and so forth).

■ Entitlements. Specify the accounts, contacts, and products that are covered, 
as well as the metrics being used.

■ A service level agreement (also referred to as an SLA or a service support level) is 
a type of service agreement that defines a customer’s entitlements and assets. A 
service level is a quantitative measurement that is usually expressed as a 
percentage. As examples, a service level may be the percentage of parts received 
on time out of those requested, the percentage of asset uptime, or the percentage 
of problems fixed within a required time frame. A service level agreement can 
also be part of a larger service agreement.

Master Agreements and Subagreements
Small and uncomplicated transactions may only need a standard boilerplate 
agreement. Larger transactions may need a customized collection of boilerplate 
agreement sections. Sales involving multiple products and staggered delivery 
schedules may need agreements with customized content within the customized 
collection of agreement sections.

End users can create parent-child relationships among agreements. If, for example, 
a large commercial account requires a master agreement and one or more 
subagreements, end users can designate the main agreement as a master agreement 
and then generate its associated subagreements. These agreements are linked to one 
another as parent and child agreements. 
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Business Scenarios for Agreements and Entitlements
Data from which to build agreements comes from the agreement library in Siebel 
eEnergy. An agreement library is a data repository developed by your company’s 
sales and legal organizations. It includes information such as recommended and 
required text for agreement sections, answers to agreement questions, sample cover 
letters, and sample executive summaries.

Business Scenarios for Agreements and Entitlements
Agreements for commercial customers and residential customers may be managed 
differently. To reflect this, this section presents two different business scenarios.

Business Scenario for a Commercial Customer
This scenario shows a sequence of procedures performed by an account manager 
(end user). Your company may follow a different sequence according to its business 
needs.

An account manager has been working with a commercial customer for the past 
two months on an opportunity to supply commercial electric service to the 
customer’s office. Account information for the customer is already present in Siebel 
eEnergy. Over the past two months, the account manager has created and 
maintained the opportunity, quotes, and proposals in Siebel eEnergy. 

After reviewing several proposals and discussing different offerings and services, 
the company’s owner has accepted the account manager’s most recent proposal and 
has requested a service agreement for the current quote. 

First, the account manager creates an agreement record with basic information such 
as account name, effective date, and a general description of products and services 
to be covered. He next selects the appropriate terms to add to the agreement and 
specifies contacts for this agreement. Next, he creates an order. When the order is 
created, Siebel eEnergy associates the new service with the agreement. 
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Business Scenarios for Agreements and Entitlements
The account manager then uses Siebel eEnergy to generate a physical service 
agreement. Using a predefined agreement template that the account manager 
selects, Siebel eEnergy automatically assembles sections from the agreement library 
and adds the information the account manager entered for the agreement record 
and its associated terms and contacts. Siebel eEnergy then places the text in a 
Microsoft Word document. If necessary, the account manager can manually edit the 
Word document to personalize it for the customer. 

Finally, the account manager prints the finished service agreement for the owner’s 
approval and signature.

Figure 7 shows the sequence of procedures that might be used to manage 
commercial agreements.

Figure 7. Example of Sequence for Agreements (Commercial)
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Business Scenario for a Residential Customer
This scenario shows a sequence of procedures performed by a customer service 
representative (end user) at a local office. Your company may follow a different 
sequence according to its business needs.

A residential customer with an existing service agreement decides to sign up for 
your company's air conditioning maintenance program. She visits her local office 
to complete this transaction. The agent looks up her service agreement on the local 
office system, which is connected to Siebel eEnergy at company headquarters. 

The agent then creates the order in Siebel eEnergy. When the order is created, Siebel 
eEnergy associates the new maintenance service with the customer's agreement. 
When the order is complete, Siebel eEnergy automatically updates the agreement 
with the new service. Finally, Siebel eEnergy issues requests to the appropriate 
back-office applications to provision the customer's air conditioning maintenance 
service.

Figure 8 shows the sequence of procedures that might be used to manage residential 
agreements.

Figure 8. Example of Sequence for Agreements (Residential)
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Administrator Procedures for Agreements and Entitlements
Administrator Procedures for Agreements and 
Entitlements

This section provides instructions for the following procedures:

■ To set up a template for the Auto Document feature on page 77

■ To verify the template appears as an agreement template on page 78

Setting Up Templates for the Auto Document Feature 
(Administrator)

Administrators must set up agreement templates for the Auto Document feature to 
work properly. 

To set up a template for the Auto Document feature

1 From the application-level menu, choose View > Site Map > Document 
Administration > Proposal Field Mapping.

2 In the Business Objects list, add a record for the mapping information.

3 In the Business Object field, select Service Agreement.

4 Complete the necessary fields, and click Save.

5 From the Show drop-down list, select Proposal Templates.

6 In the Templates list, add a record and complete the necessary fields:

a In the Mapping Name field, select the name you just created.

b In the Default field, select the check box if you want to make this template 
the default one.

NOTE: You must designate one agreement template as the default for the Auto 
Document feature to work.

c In the Category field, select Agreement.
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End-User Procedures for Agreements and Entitlements
d In the Template File Name, select the template file to use.

To verify the template appears as an agreement template

1 Navigate to the Agreements screen.

2 Click the Documents view tab.

3 In the Documents list, add a record.

4 In the Template drop-down list, verify that the template appears as an option.

End-User Procedures for Agreements and Entitlements
This section provides instructions for the following procedures:

■ To add an agreement on page 78

■ To add terms to an agreement and generate a total on page 80

■ To create and print an agreement document on page 80

■ To associate an agreement with an order on page 82

■ To associate an agreement with a service item on page 82

■ To revise an agreement on page 83

■ To examine agreement details in the Explorer on page 84

Adding an Agreement
End users can add an agreement record to the Siebel eEnergy database.

To add an agreement

1 Navigate to the Agreements screen.

2 Click the More Info view tab.
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Adding an Agreement
3 In the More Info form, add a record and complete the necessary fields. To access 
more fields, click the show more button in the form.

Some fields are described in the following table.

Field Comments

Account Name of the account that the agreement covers.

If multiple accounts are associated with this agreement, the 
primary account is visible in the form.

Agreement # Agreement number. Automatically generated, unique ID, which 
cannot be changed or updated.

Approver A member of the agreement team who is authorized to approve 
the agreement.

Effective The date on which the agreement becomes effective. This field is 
for information only.

End The date the agreement expires.

Name User-assigned name for the agreement.

Parent Agreement If the current agreement is a subagreement or child agreement, 
this field identifies the master or parent agreement.

PO# Purchase order number.

Revision Revision number of the agreement. 

The value is set to 1 when the agreement is created and is 
incremented whenever the agreement is revised.

Service Indicates that this is a service agreement.

Start The date on which agreement functionality begins.

Team People working on the agreement.

Valid Indicates that the agreement is valid.

This field is checked when entitlements are considered and when 
preventive maintenance actions are initiated.

Vendor Name of vendor who originally sold the agreement.
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Adding Terms to an Agreement and Generating a Total
Agreement terms include information such as payment method, shipping charges, 
and credit card number. Agreement totals summarize the charges relating to the 
service for which the agreement is created.

To add terms to an agreement and generate a total

1 Navigate to the Agreements screen.

2 From the Show drop-down list, select All Agreements.

3 In the Agreements list, select an agreement. 

4 Click the Terms & Totals view tab.

5 In the Terms & Totals form, complete the necessary fields.

The agreement totals are calculated automatically and displayed in the Totals 
form. The Products field and Services field amounts equal the Total Extended 
Price for Products and the Total Extended Price for Services, respectively. The 
Total field displays the total price for the shipment.

Creating and Printing an Agreement Document
End users can prepare and print an agreement for use as a contract document.

To create and print an agreement document

1 Navigate to the Agreements screen.

2 From the Show drop-down list, select All Agreements.

3 In the Agreements list, select an agreement.

4 Click the Documents view tab.
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5 In the Documents list, click Auto Document.

Some fields are automatically populated.

NOTE: If you receive an error message about a template, check the template 
setup. For instructions, see “Setting Up Templates for the Auto Document 
Feature (Administrator)” on page 77. 

6 If necessary, complete or modify the fields.

Some fields are described in the following table.

7 In the Documents list, click Generate Draft.

Siebel eEnergy assembles the standard agreement sections into a Microsoft Word 
file according to the template you selected, and inserts specific information from 
the current agreement record. A Microsoft Word application window appears 
with the draft agreement displayed.

8 Edit and print the Word document, as necessary.

9 Save the Word document.

The document is automatically associated with the agreement record.

Associating an Agreement with an Order
End users can associate agreements with orders. 

Field Comments

Draft Name Filename for the generated agreement.

Name Name of the agreement document record.

Template Template on which to base the agreement.
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Associating an Agreement with a Service Item
To associate an agreement with an order

1 Navigate to the Orders screen.

2 Click the More Info view tab.

3 In the More Info form, add a record and complete the necessary fields. To access 
more fields, click the show more button in the form.

4 In the Agreement Name field, select an agreement in the dialog box, and click 
Submit.

Associating an Agreement with a Service Item
End users can associate agreements with service items. This allows companies to 
track detailed agreements at the item level of a product bundle.

To associate an agreement with a service item

1 Navigate to the Quotes screen.

2 In the Quotes list, select an existing quote or add a record.

3 Drill down on the Name hyperlink.

4 In the Quote form, complete the necessary fields.

5 In the Line Items list, add a record and complete the necessary fields for the 
service to be ordered.

6 In the Product field, select a product.

NOTE: The dialog box contains only those products with the “Track as Asset” field 
selected in the Product Administration screen, More Info view.

7 Scroll down and click the Line Item Detail subview tab.

8 In the Line Item Detail form, select an agreement in the Agreement Name field.

9 In the Line Items list, click the Orders view tab.

10 Click the Sales Order or Service Order button.
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11 Complete the necessary fields in the order.

12 Drill down on the Order # hyperlink.

13 Verify that the line items from the quote appear.

14 In the Price List field, select a price list.

15 Submit the order to change the status to Open.

Revising an Agreement
End users create a revision to an agreement to add a new clause or term, or to 
update information that already exists in the agreement. End users might do this, 
for example, when a customer orders a new service that is not covered by the 
existing agreement, or when their company modifies its discount rates.

When end users revise an agreement, Siebel eEnergy preserves a record of each 
earlier version of that agreement. Consequently, revision records allow you to track 
the history of any agreement. The original agreement is saved as revision 1. When 
an agreement is revised:

■ The respective revision number is increased by one.

■ The agreement name in the Name field is changed to name (.x) where x is the 
revision number.

To revise an agreement

1 Navigate to the Agreements screen.

2 In the Agreements list, select an agreement.

3 In the More Info form, click Revise.

Viewing Agreement Details in the Explorer
End users can use the hierarchical format of the Agreement explorer to view 
agreements and examine associated information.
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Viewing Agreement Details in the Explorer
To examine agreement details in the Explorer

1 Navigate to the Agreements screen.

2 From the Show drop-down list, select Explorer.

A data document appears for each of the parent-level agreements your company 
has with its customers.

3 Expand the folder for the data document.

Subfolders appear for the selected agreement’s associated agreements, 
entitlements, activities, notes, and products and services. 

4 Expand the subfolder.

The individual records appear as a series of data documents below the subfolder 
and as rows in the list. 

5 Select a record.

The details of the record appear highlighted in the list. 
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The premises functionality of Siebel eEnergy is used by administrators, such as 
distribution network planners, field service engineers, field service operations 
managers, and managers of customer service representatives. It is also used by end 
users, such as customer service representatives.

This chapter explains the concept of a premise and describes procedures you can 
use to manage the creation and maintenance of premise records. It also describes 
typical procedures that end users might use when working with premise records.

A premise is an address that identifies a physical location, such as a building, 
apartment, land parcel, and so on, to which energy services can be delivered. In 
Siebel eEnergy, a premise acts as a grouping of service points.

A premise record stores the address of a building, apartment, or land parcel to 
which your company offers energy services. Siebel eEnergy also stores nonservice 
addresses that are associated with particular customers, such as billing addresses 
outside the company’s service territory. Nonservice account addresses have a 
variety of uses, but premise records are specifically used to track addresses at which 
a company might offer services. Premise records are never deleted from the system 
and can therefore be used to track asset and service usage even if the premise 
becomes unoccupied.

Premise records also track service points and meters. A service point is an asset that 
is installed at a particular service location and represents a network delivery point, 
such as a gas pipe. 

A meter is a serialized item of customer premise equipment, such as a gas, electric, 
and water meter, that measures service usage. More than one meter can feed into a 
single service point, and service usage is accumulated and billed at the service point 
level.
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Business Scenario for Premises
Several procedures in this chapter involve an association between a record, such as 
a service point record, and a meter. It is assumed for this chapter that product and 
asset records for meters have already been entered into Siebel eEnergy. For more 
information about setting up a product, see Product Administration Guide.

For more information about setting up an asset, see Siebel Field Service Guide.

Premise and meter information can be imported into Siebel eEnergy either 
periodically in batches, using Siebel Enterprise Integration Manager, or through 
real-time integration with a third-party application. Premise information can also be 
entered manually.

Every instance of a service delivered to a particular premise needs a unique 
identifier, called a service item identifier. Services provided through a physical 
network connection (for example, a gas pipe) use the Service Point as the service 
item identifier. For companies that prefer not to differentiate between service points 
and meters (companies that use only the meter entity), the Service Point acts as the 
meter ID.

Business Scenario for Premises
This scenario shows a sequence of procedures performed by a distribution network 
planner, field service engineer, field service operations manager, and customer 
service representative (end user). Your company may follow a different sequence 
according to its business requirements.

A new commercial facility is under construction, and the distribution company has 
developed plans to connect the facility to the network. Before the facility is actually 
connected, the distribution network planner creates a premise record for it in Siebel 
eEnergy and attaches two electronic files to the premise record. One file is the 
blueprint for the connection, and the other is a technical specification document.

A week later, field service engineers complete the connection of the new facility to 
the network and install a meter base (service point). The field service operations 
manager then enters network hookup information into Siebel eEnergy. To track this 
information, the manager first creates a service point record for the installed meter 
base and associates it with the premise. 
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Business Scenario for Premises
Because the city must inspect all newly installed meter bases, the field service 
operations manager adds a record for that activity and associates it with the 
premise. After the inspection is completed, a field service technician installs the 
meter.

A record for the meter, which is a serialized product whose Type is defined as 
“Meter,” was previously entered into Siebel eEnergy. The field service operations 
manager next enters additional information about the meter by associating a note 
with the premise record. In addition, the manager associates an electronic file, 
which contains the hookup wiring schematic, with the premise. 

A few weeks later, the occupant of the new facility moves in and calls to report that 
the meter is not working properly. The CSR who answers the call reviews 
information about the meter in Siebel eEnergy, including the date it was installed, 
its current status, and the date when it was last tested. He sees that the meter was 
only recently installed and has never been tested, and he records the problem by 
creating a service request.

In response to the creation of a service request, a field service engineer is dispatched 
to the facility and replaces the meter. In Siebel eEnergy, he records the date on 
which the old meter was removed and creates a record for the new meter that he 
installs. The new record includes the address of the premise and the service point 
with which the meter is associated.
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Business Scenario for Premises
Figure 9 shows the sequence of procedures that might be used to set up a 
commercial premise.

Figure 9. Example of Sequence for Initial Setup of a Commercial Premise
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Administrator Procedures for Premises
Figure 10 shows the sequence of procedures that might be used to maintain a 
commercial premise.

Administrator Procedures for Premises
This section provides instructions for the following procedures:

■ To add a premise before the customer account exists on page 90

■ To add a premise when the customer account already exists on page 91

■ To add a service point and associate it with a premise on page 91

■ To associate a meter with a service point on page 93

■ To record the date that a meter was removed on page 93

Figure 10. Example of Task Sequence for Maintenance of a Commercial Premise
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Setting Up Premise Records (Administrator)
Only administrators can set up premise records. End users can view premise 
information, view information associated with premises, and associate other 
records with premises.

About Adding a Premise Record
There are two ways to add a premise record. The method you use depends on if an 
account for the customer who will occupy the premise has already been 
established.

You can add a premise record before the customer who will occupy a premise is 
known. In this case, there is no existing customer account with which to associate 
the premise. When a customer moves into the premise and requests service, the 
association is made automatically when the premise is added to the account 
addresses. 

If an account for the customer who will occupy a new premise has already been 
established, a new address will be added to the account addresses. Once the address 
is validated as a premise, the address is flagged as a premise by an administrator.

Creating a Premise
Use one of the following procedures to create a premise.

To add a premise before the customer account exists

1 From the application-level menu, choose View > Site Map > Data 
Administration > Premises.

The All Premises list appears with the More Info form beneath it.

2 In the form, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Bill Group ID of the billing system batch or group to which the premise belongs.

Buildings Total number of buildings at the premise. 
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Registering a Premise Hookup (Administrator)
To add a premise when the customer account already exists

1 From the application-level menu, choose View > Site Map > Data 
Administration > Addresses.

The Addresses list appears with the Address form beneath it.

2 In the Addresses list, select an Address.

3 In the Address form, check the Premise field.

4 From the Show drop-down list, select Premises.

The All Premises list appears with the More Info form beneath it.

5 In the list, select the new premise and complete the necessary fields in the form.

For a description of some fields, see the table in “To add a premise before the 
customer account exists” on page 90.

Registering a Premise Hookup (Administrator)
Premises can be associated with one or more service points. If your application is 
configured to allow you to manage meters separately from service points, you can 
associate a meter with a premise through a service point. Otherwise, you can only 
associate a meter point (the meter) with a premise. 

To add a service point and associate it with a premise

1 From the application-level menu, choose View > Site Map > Data 
Administration > Premises.

2 In the All Premises list, select a premise.

Floors Total number of floors at the premise. 

Read Route Name of the meter reading route to which the premise belongs. 

Read Sequence Number that identifies the sequence in which the meters at the 
premise are read. 

Field Comments
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Registering a Premise Hookup (Administrator)
3 Click the Service Points view tab.

4 In the Service Points list, add a record.

The Service Points dialog box appears with a list of service points that are not 
associated with any premises. 

5 In the dialog box, select an existing service point or click New to create a new 
service point.

6 In the Service Points list, complete the necessary fields.

Some fields are described in the following table.

Field Comments

Location Description of the location of the service point.

Product Associate a product with this service point. Only products in 
which the value in the product’s Type field is Service Point and 
Service Type is not null are available for selection.

Removal Date Date on which the service point is removed from the premise.
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Replacing a Meter for Maintenance (Administrator)
To associate a meter with a service point

1 From the application-level menu, choose View > Site Map > Data 
Administration > Premises.

2 Click the Meter Location view tab.

3 In the Meter Location list, add a record and complete the necessary fields.

Some fields are described in the following table.

Replacing a Meter for Maintenance (Administrator)
A malfunctioning meter can be removed from service and replaced with one that 
works correctly. The original meter can then be repaired and installed at another 
location.

When a meter is removed or installed, the field service administrator must update 
Siebel eEnergy so the locations of meters owned by the company can be tracked.

To record the date that a meter was removed

1 From the application-level menu, choose View > Site Map > Data 
Administration > Premises.

2 Click the Meter Location view tab.

3 In the Meter Location list, select a location.

4 In the End Date field, enter the date that the meter was removed.

Field Comments

Meter Id Identifier generated automatically when a meter record is created 
in Siebel eEnergy.

Start Date Date the meter is associated with the service point.
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End-User Procedures for Premises
This section provides instructions for the following procedures:

■ “To associate an activity with a premise” on page 94

■ To look up a premise on page 95

■ To view service point and meter information for a premise on page 95

■ To view usage history for a service point on page 96

■ To view a service request associated with a premise on page 96

■ To add a service request for a premise on page 97

■ To add infrastructure information to a premise on page 98

■ To view asset information for a meter on page 99

Associating an Activity with a Premise
End users can create an activity and associate it with a premise to:

■ Remind themselves of procedures related to a premise that they must perform.

■ Communicate procedures related to a premise that other members of the 
organization must perform.

To associate an activity with a premise

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.

3 Click the Activities view tab.

4 In the Activities list, add a record and complete the necessary fields.
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Verifying the Premise
Verifying the Premise
End users can verify the premise that a caller is referring to by looking up the 
premise record.

To look up a premise

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.

For a description of some fields, see the table in “To add a premise before the 
customer account exists” on page 90.

Viewing Service Point and Meter Information
End users can view service point and meter information for the premise.

To view service point and meter information for a premise

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.

3 Click the Service Points view tab.

4 In the Service Points list, select a service point.

Some fields are described in the following table.

5 Scroll down to the Meters list and select a meter.

Field Comments

Product Name of the product that is the service point.

Service Type Populated automatically based on selection of Product.
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Viewing Usage History
Service usage is recorded at meters and accumulated for usage history and billing 
purposes at the service point level. End users can view usage history for a service 
point associated with a premise. This is useful for resolving billing inquiries from 
customers who have recently moved into the premise. Usage history is displayed as 
data in lists and charts. End users can view usage history through either the 
Premises screen or the Accounts screen. For instructions for viewing usage history 
through the Accounts screen, see Chapter 2, “Accounts.”

NOTE: Usage data may reside in an external data repository and be viewed in Siebel 
eEnergy if that type of integration has been set up.

To view usage history for a service point 

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.

3 Click the Service Points view tab.

4 In the Service Points list, drill down on the Service Point hyperlink.

5 In the Service Point Services list, select a record.

6 In the Usage History list, select the information you want to view from the drop-
down list.

Viewing Service Requests for a Premise
End users can view service requests associated with a premise.

To view a service request associated with a premise

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.
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Adding a Service Request for a Premise
3 Click the Service Requests view tab.

Two Service Requests lists appear. The upper list displays accounts and the 
lower list displays service requests.

4 In the upper list, select an account.

5 In the lower list, select a service request.

6 To view more detailed information about the service request, drill down on the 
SR Number field.

Adding a Service Request for a Premise
End users can add a service request by creating a new service request in the Service 
Request view of the Premises screen.

To add a service request for a premise

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.

3 Click the Service Requests view tab.

Two Service Requests lists appear. The upper list displays accounts and the 
lower list displays service requests.

4 In the upper list, select an account.

5 In the lower list, add a record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Owner Person handling the service request.

Priority Ranking to help you prioritize service requests internally. Describes the 
response your company gives to the service request. 

The Priority ranking does not have to be the same as the severity.
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Adding Infrastructure Information
End users can create a record containing infrastructure information that is 
associated with a premise through an account.

To add infrastructure information to a premise

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.

3 Click the Infrastructure view tab.

Two Infrastructure lists appear. The upper list displays accounts and the lower 
list displays infrastructure.

4 In the upper list, select an account.

5 In the lower Infrastructure list, add a record and complete the necessary fields.

Some fields are described in the following table.

Severity Severity of the service request or impact on the customer. Describes the 
seriousness of the problem.

The Severity ranking does not have to be the same as the priority.

SR Number Unique, system-generated number that identifies the service request. 

Field Comments

Field Comments

Attribute An attribute of the infrastructure item, such as Substation ID or 
Transformer Type. 

Changes dynamically according to the value selected in Service Type.

Owner Customer or account that owns the infrastructure item.

Value Information about the data in the Attribute field. For example, if the 
Attribute is Voltage at Meter, a typical Value would be 240 volts.
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Viewing Asset Information for a Meter
End users can view asset information for a meter.

To view asset information for a meter

1 Navigate to the Premises screen.

2 In the All Premises list, select a premise.

3 Click the Service Points view tab.

4 In the Service Points list, select a service point.

5 Scroll down to the Meters list, and drill down on the Meter Id hyperlink.

The Assets screen appears and displays information about the meter. Some fields 
are described in the following table.

Additional End-User Procedures Related to Premises
For descriptions of other procedures related to premises, see Siebel Bookshelf.

Caller Verification
When receiving an inbound call, end users first verify and locate the caller. For more 
information about verifying and locating a caller, see Siebel Call Center User Guide.

Field Comments

Asset # Automatically generated when a new asset is created and 
associated with a product.

Serial # User-assigned number for tracking.

Owner Owner of the meter asset.
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Additional End-User Procedures Related to Premises
Customer Accounts
When a new customer requests service from your company, end users will need to 
create an account for the customer. For more information about creating a customer 
account, see Chapter 2, “Accounts.”

Sales Orders
When a customer requests a new service, end users must create a sales order. For 
more information about creating a sales order, see Siebel Order Management Guide 
Addendum for Industry Applications.

Premises and Attachments
At any time, end users can store additional information relating to a premise in the 
database by associating an electronic file with the premise record. For directions for 
associating an attachment with a record, see Fundamentals.

Premises and Notes
At any time, end users can store additional information relating to a premise in the 
database by adding a note and associating it with the premise record. For directions 
for associating a note to a record, see Fundamentals.
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Asset records are used by customer service representatives (CSRs), field service 
representatives, service managers, account managers, support renewal agents, and 
contract administrators. The procedures described in this chapter are primarily used 
by customer service representatives. 

Asset data is stored in records that can be created, associated with other records, 
revised, examined, and printed. For more information about assets, see Siebel Field 
Service Guide.

Assets Overview
An asset is a product or product component that has been purchased by a customer 
and installed at, turned on at, or delivered to a customer site. An asset can be a 
physical product or a service product. Examples include meters, service points, and 
energy services that are active at specific customer sites. An asset is tracked at an 
asset number level. An asset has attributes, a configuration, and a location. 

Siebel eEnergy uses both the asset number and product name to track the asset. It 
is the combination of these two fields that makes an asset unique within Siebel 
applications. Therefore, the same asset number can be shared by different products. 
For example, a gas and an electric service point can have identical asset numbers 
for different products.

Asset management and tracking are important parts of help desk systems and field 
service applications. Siebel eEnergy tracks purchases, allows you to create an asset 
before purchase, and allows you to track the asset’s location. The asset 
management system records the location of serialized products and product 
components, such as meters, and tracks the movement of these assets from 
inventory locations to customers or employees.

Assets cannot be deleted, so even inactive services remain in the dialog boxes for 
selection.
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Business Scenario for Assets
End users can use these methods to create or modify assets:

■ Manually in the Assets screen. 

■ Manually in the Activity Part Tracker view, provided the product is serialized. 
This would typically be done by a field service agent. For more information, see 
Siebel Field Service Guide.

■ Automatically using the Siebel eEnergy application’s order management 
process. For more information, see Siebel Order Management Guide Addendum 
for Industry Applications.

New or modified asset records can also be automatically received from an 
integrated third-party asset management system. For more information, see Siebel 
Enterprise Integration Manager Administration Guide.

Business Scenario for Assets
This scenario is an example of a sequence performed by a customer service 
representative (end user). Your company may follow a different sequence according 
to its business requirements. 

A CSR processes an order for an energy service, which creates an asset for the root 
service and each component. The customer also orders a backup system, for which 
the CSR creates an asset. The CSR associates the backup system asset with the 
customer’s service as a related asset. 

At a later time, the customer calls to report a product failure. Noticing that the 
service has components, the CSR views their details to identify the failed 
component. 

The CSR reviews the history of services for the asset and sees nothing out of the 
ordinary. The CSR creates a service request for the problem and associates it with 
the asset component. 

A few weeks later, the customer calls again with a suggestion for improving the 
service. The CSR enters a change request and associates it with the customer’s 
asset. 
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Business Scenario for Assets
For another customer, the billing system shows an exception (usage data beyond the 
normal range). The field service representative drives out to the premise. He 
determines that the meter has malfunctioned and captures the meter reading in 
Siebel eEnergy.
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Business Scenario for Assets
Figure 11 summarizes the sequence an end user might use to manage asset 
information in Siebel eEnergy:

Figure 11. Example of Sequence for Assets
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End-User Procedures for Assets
End-User Procedures for Assets
This section provides instructions for the following procedures:

■ To create an asset on page 105

■ To associate a related asset with a primary asset on page 106

■ To view hierarchical information for an asset on page 107

■ To create a transaction for an asset on page 107

■ To view components associated with an asset on page 108

■ To add a service request associated with an asset on page 108

■ To add a change request associated with an asset on page 109

■ To view service point and service information on page 110

■ To enter meter readings on page 111

■ To view meter readings on page 111

Creating an Asset
End users can create assets and enter asset information in Siebel eEnergy, as shown 
here. 

NOTE: Assets can also be created through the order management module. For 
instructions, see Siebel Order Management Guide Addendum for Industry 
Applications.

To create an asset 

1 Navigate to the Assets screen. 

The Assets list appears with the More Info form beneath it.
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Associating Related Assets with a Primary Asset
2 In the form, add a record and complete the necessary fields. To access more 
fields, click the show more button in the form.

Some fields are described in the following table. 

Associating Related Assets with a Primary Asset
End users can associate one or more assets with another asset and designate their 
relationships, such as backup or option. An asset with which other assets are 
associated is a primary asset. 

To associate a related asset with a primary asset

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select All Assets.

3 In the Assets list, select the primary asset. 

4 Click the Relationships view tab.

5 In the Relationships list, add a record and complete the necessary fields.

Viewing Hierarchical Information for an Asset 
End users can view the hierarchical information for assets, including the 
relationships of assets and their components. 

Field Comments

Account Account associated with the asset. 

Asset # Populated with a default number generated by Siebel eEnergy. 
Accepts any string consisting of 100 or fewer characters. 

Qty Quantity of the asset.

Serial # Displays either the serial number set in the service point or the service 
ID from the order.
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Creating a Transaction for an Asset
To view hierarchical information for an asset

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select Assets Explorer.

3 In the explorer tree, select an asset. 

4 Expand the asset branch to display subsidiary records.

When you click the asset name in the explorer tree, the Assets list highlights the 
asset selected in the explorer and displays further details on the right side of the 
view. The fields are the same as those in the Assets lists in the All Assets or My 
Assets view.

Creating a Transaction for an Asset
An asset transaction captures the movement of components of an asset, such as 
installation or part replacement. End users can create transactions for an asset.

To create a transaction for an asset

1 Navigate to the Assets screen.

2 From the Show drop-down list, select All Assets.

3 In the Assets list, select the asset. 

4 Click the Transactions view tab.

5 In the Transactions list, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Asset # Number of the subasset (component) associated with the 
transaction (for example, the part installed in the main asset).

Transaction Date and time of the transaction.
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Viewing Components Associated with an Asset
End users can view components that are associated with an asset. Components or 
subassets are generally set up when the asset is created.

NOTE: Components are automatically added, as appropriate, when you add some 
transactions in the Transactions view. 

To view components associated with an asset

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select All Assets.

3 In the Assets list, select an asset. 

4 Click the Components view tab.

The Components list displays information about the components.

Adding a Service Request Associated with an Asset
End users can add service requests associated with an asset. 

To add a service request associated with an asset

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select All Assets.

3 In the Assets list, select an asset. 

4 Click the Service Requests view tab.
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Adding a Change Request Associated with an Asset
5 In the Service Requests list, add a record and complete the necessary fields.

Some fields are described in the following table. 

Adding a Change Request Associated with an Asset
End users can add change requests associated with an asset by either creating new 
change requests or associating existing change requests with an asset.

To add a change request associated with an asset

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select All Assets.

3 In the Assets list, select an asset. 

4 Click the Change Requests view tab.

5 In the Change Requests list, add a record and do one of the following:

■ Select an existing change request to associate with the asset. 

■ Add a new change request and complete the necessary fields.

Some fields are described in the following table. 

Field Comments

Last Name Name of the account contact. 

Owner Owners of the service request. You can select more than one 
owner.

SR # Unique, system-assigned number for the service request. 

Field Comments

Area General product area where the change request has occurred. 

Owner Person assigned to deal with the change request.
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Viewing Service Points and Services
End users can view the services associated with each service point and usage details 
for each service, but they cannot add a service point from this view. For instructions 
for adding a service point, see “To add a service point and associate it with a 
premise” on page 91. 

Services are associated with service points when a CSR submits a New or Modify 
order for a service. When a CSR submits a Disconnect order, the service is made 
inactive. For more information, see the chapter about the employee use of order 
management in Siebel Order Management Guide Addendum for Industry 
Applications.

To view service point and service information

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select All Assets.

3 Click the Service Point Services view tab.

4 To see various types of usage information for a service:

a In the Service Point Services list, select the service. 

b In the Usage History view, from the drop-down list, select an option.

Priority Priority assigned to fixing this problem. 

Subarea Kind of product addressed by this change request. 

Substatus Indicates if this change request has been assigned to an 
employee for resolution.

Type Type of change request. 

Field Comments
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Viewing or Entering a Meter Reading
End users can view the types of readings taken and can enter actual readings. 

NOTE: Field service agents can also enter meter readings in the Activities Readings 
view. For more information, see Siebel Field Service Guide.

To enter meter readings

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select All Assets.

3 Select a meter asset. 

4 Click the Measurements view tab.

The Measurements list appears with the Measurements form beneath it. 

5 In the form, add a record and complete the necessary fields.

To view meter readings

1 Navigate to the Assets screen. 

2 From the Show drop-down list, select All Assets.

3 Select a meter asset. 

4 Click the Readings view tab.

5 In the Readings list, select a record.

The lower Readings list displays the readings for that meter.
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Viewing or Entering a Meter Reading
112 Siebel eEnergy Guide Version 7.5, Rev. B



Opportunities 8
An opportunity is any lead that could result in a sale. Some opportunities are 
generated from campaign leads, while others are created by your company’s sales 
representatives. Through Siebel eEnergy, sales representatives can manage their 
sales opportunities for business and residential customers. Specifically, they can:

■ View a list of all opportunities in the database or only those opportunities 
specifically assigned to them

■ Create new opportunities

■ Track the status of an opportunity through the sales cycle, from creation to 
closure

■ Update information about opportunities as they move through the sales cycle

■ Generate quotes based on opportunities

■ Use opportunity profiles to record additional information and review customer 
responses to predefined questions

From the Opportunities screen, CSRs can run the Price Comparison feature. The 
Price Comparison feature generates annual costs for both in-house and competitors’ 
electric and gas services. The feature calculates savings for existing and prospective 
customers if they choose to change rate plans. For more information on this feature, 
see Chapter 9, “Price Comparison.”

Administrators involved with opportunities will benefit from reading this chapter. It 
describes how your CSRs create and update opportunities. After becoming familiar 
with the end-user procedures, you can customize the software to fit your company’s 
needs.
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Business Scenario for Opportunities
For information about hierarchical products or multiple price types with recurring 
and nonrecurring fees, see these guides:

■ Product Administration Guide

■ Pricing Administration Guide

■ Siebel Order Management Guide Addendum for Industry Applications

Business Scenario for Opportunities
This scenario shows a sequence of procedures performed by a sales representative 
(end user). Your company may follow a different sequence according to its business 
requirements.

While attending a trade show, a sales representative meets the director of a small 
company, who expresses interest in purchasing several products from the sales 
representative’s company. She asks the prospective customer to complete a form 
and assures him that she will be in contact with specific product pricing.

Back at her office, the sales representative creates a new account and enters contact 
information in Siebel eEnergy. Then she creates a new opportunity and associates 
it with this new account. 

As part of the opportunity description, she indicates the probability for the sale, 
estimates the potential revenue for the sale, and designates the stage of the sale. 

Next she associates products with the opportunity and specifies product 
information, such as the product type, quantity, and pricing. 

To evaluate some preliminary quotes for the prospective customer, she creates 
several quotes. For products containing subproducts, she selects the top-level 
product name to ensure proper revenue calculations. She also reviews setup fees 
and recurring fees for the products.

She calls the prospective customer to set up a meeting to go over her quotes. During 
that conversation, she determines that he might also be interested in another 
product that her company offers. She updates the product information and notices 
that the additional product triggered an overall discount generated by the rules 
established through Siebel eEnergy.
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Business Scenario for Opportunities
The prospective customer also mentions that his company is expanding to an 
additional location. The sales representative enters that location as a related site for 
the same opportunity.

After confirming the meeting for the next day, she hangs up and continues her 
preparations for the meeting. While doing so, it occurs to her that another customer 
might be able to take advantage of the same discount. She enters that customer 
account as a partner for the opportunity. 
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Business Scenario for Opportunities
Figure 12 summarizes the sequence an end user might use with opportunities in 
Siebel eEnergy:

Figure 12. Example of Sequence for Opportunities
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End-User Procedures for Opportunities
This section provides instructions for the following procedures:

■ To create an opportunity on page 117

■ To associate an opportunity with an account on page 118

■ To associate a product with an opportunity on page 119

■ To create a quote for an opportunity on page 119

■ To create a profile for an opportunity on page 121

■ To associate a related site with an opportunity on page 122

■ To associate a partner with an opportunity on page 122

Creating an Opportunity
An opportunity is generated in the Campaigns screen or is added manually. Every 
time end users identify an opportunity, they should create a new record.

To create an opportunity

1 Navigate to the Opportunities screen.

2 Click the More Info view tab.

3 In the More Info form, add a record and complete the necessary fields. To access 
more fields, click the show more button in the form.

Some fields are described in the following table.

Field Comments

Channel Distribution strategy this opportunity plays in your organization.

Expected Value Automatically populated when you select Probability and Revenue 
Amount fields. 
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Associating an Account with an Opportunity
End users can associate an opportunity with an account. This allows them to track 
all important information for a customer.

To associate an opportunity with an account

1 Navigate to the Opportunities screen.

2 Select the opportunity by doing one of these:

■ Perform a query in the list.

■ Filter on the fields to narrow the list of Opportunities you want to work with. 
Then make the appropriate selections from the Queries and Show drop-down 
lists to define the opportunity record set, and then select the opportunity in 
the list.

3 In the Opportunities list, in the Account field, select an account in the dialog 
box.

Associating a Product with an Opportunity
End users can associate products with an opportunity and provide customers with 
detailed information on the products that interest them. 

Primary You are assigned as primary for opportunities you create. Only 
managers can change the Primary field for a sales team member. 

Probability % Probability of completing the sale.

Revenue Expected revenue in specific currency.

Sales Team Sales team member associated with the opportunity.

Source Source of the data. Source Type field reflects the source type 
associated with this selection. 

Field Comments
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To associate a product with an opportunity

1 Navigate to the Opportunities screen.

2 Select an opportunity.

3 Click the Products view tab.

4 In the Products list, add a record and complete the necessary fields. 

5 In the Product field, select a product in the dialog box.

Creating a Quote for an Opportunity
End users can create a quote for an opportunity, view all quotes for an opportunity, 
or update an opportunity with product information taken from the Quotes view. 

For the updating opportunity feature to work, certain conditions must be met:

■ In the Product Administration view, the number of occurrences must be > 0 for 
the product.

For more information, see Product Administration Guide.

■ In the Price List list in the Quotes screen, all products end users can associate 
with the opportunity or quote must be defined as Price List line items.

■ In the Line Items view of the Quotes screen, the Extended Price of the quote line 
item must be > 0.

■ In the Quotes list in the Opportunities screen, the Price List must be selected (see 
“To associate a product with an opportunity” on page 119).

If these conditions are not met, Siebel eEnergy cannot generate revenue line items 
for the Opportunity. The revenue will not be accurate until a quote is configured 
and the opportunity is updated from it.

To create a quote for an opportunity

1 Navigate to the Opportunities screen.

2 Select an opportunity.
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3 Click the Quotes view tab.

4 In the Quotes list, click Auto Quote.

A new quote is created with default values in some fields.

5 In the Price List field, select a price list.

6 Complete the necessary fields for the new quote.

7 In the Quotes list, drill down on the Name hyperlink.

The Quote form appears with the Line Items view beneath it.

8 In the Line Items list, add a record and complete the necessary fields.

Some fields are described in the following table.

9 To modify line item details:

a Scroll down and click the Line Item Detail subview tab.

NOTE: Administrators specify much of the product information through the 
Product Administration screen. When the products are added to the quote as 
line items, default product information is populated for some line item fields.

Field Comments

Extended Price Calculated by multiplying the net price by the quantity.

MRC Subtotal Monthly recurring charge.

NRC Subtotal Nonrecurring charge.

UofM Unit of Measure depends on price type. For a one-time fee, value is 
for each unit. For recurring fees, value indicates time period, such 
as per month or per quarter.
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b To adjust a discount, edit the Disc %, Disc Amount, and Disc Price fields in 
the Line Item Detail form.

NOTE: For further information about line item details, see Siebel Order 
Management Guide Addendum for Industry Applications.

10 In the Quote form, click the Update Opportunity button.

This adds revenue line items to the opportunity for every one-time or recurring 
charge for every product.

Creating a Profile for an Opportunity
End users can launch a call script that helps them define qualifying information 
about an opportunity. The script guides them through a series of questions to 
answer. 

After answering the questions, end users can later analyze the information. For 
example, they can use charts to see which opportunities qualify as part of their 
target market or they can use queries to find opportunities that match specific 
criteria.

To create a profile for an opportunity

1 Navigate to the Opportunities screen.

2 Select an opportunity.

3 Click the Profile view tab.

4 In the Profile form, click Script to launch the wizard.

5 Answer the questions in the script.
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Associating a Related Site with an Opportunity
The Opportunity Account defines the primary account related to the opportunity. 
End users can associate accounts for satellite offices or subsidiaries to the 
opportunity. 

To associate a related site with an opportunity

1 Navigate to the Opportunities screen.

2 Select an opportunity.

3 Click the Related Sites view tab. 

4 In the Related Sites list, add a record.

5 In the Account field, select an account in the dialog box. 

Associating a Partner with an Opportunity
The Opportunity Account field defines the primary account related to the 
opportunity. When additional accounts are involved in an opportunity, end users 
add them to the opportunity as partners. 

For an account to appear in the list of partners, it must have a check mark for the 
Partner field in its account form.

To associate a partner with an opportunity

1 Navigate to the Opportunities screen.

2 Select an opportunity.

3 Click the Partners view tab. 

4 In the Partners list, add a record.

5 In the Add Partner dialog box that appears, select an account. 

The dialog box lists only accounts that have the Partner field selected in the 
Accounts screen, More Info view.
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Additional End-User Procedures Related to 
Opportunities

For descriptions of other procedures related to opportunities, see the Siebel 
Bookshelf.

Account and Contact Creation
When adding a prospective customer to the database, end users often first create an 
account and enter contact information. For more information about creating a 
customer account, see Chapter 2, “Accounts.” For more information about entering 
a contact, see Chapter 4, “Contacts.”
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This chapter describes the basic concepts behind the Price Comparison feature 
available in Siebel eEnergy. It also provides some business scenarios that illustrate 
the sequence of tasks users might perform with the new feature. In addition, the 
chapter explains procedures for setting up rate plans, generating annual costs for 
those plans, and viewing costs comparing competitors’ rates with in-house rates.

Administrators, such as pricing managers or call center administrators, will benefit 
from reading this chapter. Pricing managers will learn how to set up rate plans and 
run reports. Other administrators or managers will see how customer service 
representatives (end users) use the Price Comparison feature. After becoming 
familiar with the end-user procedures, administrators and configurators can 
customize the software to fit their company’s needs. 

For further information about setting up products, price lists, and ordering, see 
these guides:

■ Product Administration Guide

■ Pricing Administration Guide

■ Siebel Order Management Guide

■ Siebel Order Management Guide Addendum for Industry Applications

For technical information on the background logic of the price comparison 
functionality, see Appendix A.
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Price Comparison Overview
The Price Comparison feature available in Siebel eEnergy determines the annual 
cost for services, such as gas or electricity, to existing or prospective customers. It 
then compares the existing cost against the internal rates that reside in the Siebel 
database and provides comparative quotes to the customer. After reviewing the 
quotes, customers can enroll for the service your company offers.

This list provides an overview of the steps involved with the Price Comparison 
feature:

1 The Price Comparison feature is accessed in one of these methods:

■ From a Web site, a customer or prospective customer requests a list of 
comparative rates for services. The entry point is through Siebel eSales. 

■ A customer service representative (CSR) creates an opportunity in Siebel 
eEnergy and selects the Price Comparison feature.

2 A SmartScript session begins to collect customers’ answers to a series of 
questions regarding their current services and rates. 

3 At the end of the SmartScript session, the Price Comparison feature converts this 
customer-provided information into an annual cost. 

The annual cost is used to determine the customer’s usage based on the 
competitor’s rate plan information. For a more detailed explanation, see 
Appendix A. 

4 The Price Comparison feature finds in-house rate plans that match the attributes 
of the competitor’s rate plan.

5 The Price Comparison feature calculates the projected annual cost for each 
matching rate plan based on the usage from Step 3 and displays the quotes.

6 If the CSR is running the Price Comparison feature, the CSR can choose to mail, 
email or fax a copy of the displayed quotes to the prospect. 

7 The customer selects a rate plan and begins the enrollment process.
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8 The next step depends on which application was used to begin the price 
comparison process:

■ If the process began through Siebel eSales, new customers must log in and 
register. Customers who already have products in their shopping cart can add 
the rate plan to their shopping cart.

■ If the process began through Siebel eEnergy, the CSR provides the necessary 
account information for new customers. For accounts already associated 
with the opportunity, the information is automatically filled in. 

9 The typical order workflows occurs to provision the order.

The Price Comparison feature calls workflows, methods, and processes, which form 
the background logic for the feature. For detailed information on the business 
services and workflows involved, see Appendix A.

Rate Plans with Tier-Based Pricing
Rate plans in Siebel eEnergy can accommodate complex product bundles and 
pricing schemes. Administrators set up root products with the Usage products as 
subcomponents. Each product must have a Service Type field set, such as Electricity 
or Gas, in order to limit the price comparison to the correct product category.

Administrators can set up the plans to reflect variations in service, region, time of 
the day or year (for example, day, night, weekends, summer, or winter), payment 
methods, payment duration, credit risk, and so on. The administrator can extend 
this list by adding attributes to the appropriate product class.
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In this example, the rate plans assure full selection of all components. The pricing 
manager sets up electricity rate plans and gas rate plans. The different combinations 
of attributes give rise to different rates within the same rate plan. Table 13 shows 
several rate plan examples.

Table 13. Rate Plan Examples

Class Root Product Subcomponents Tier Pricing Attributes List Price

Electricity StandardWith
StandingCharge

$15 per 
month

StandardWith
StandingCharge
Usage

1-1000=$0.12 Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Threshold

$0

1-1000=$0.10
1001-2000=$0.08
>2000=$0.05

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Peak

$0

1-1000=$0.08
1001-2000=$0.05
>2000=$0.03

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Off Peak

$0

Electricity StandardWith
NoStandingCharge

$0 per 
month

StandardWith
NoStandingCharge
Usage

1-1000=$0.12 Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Threshold

$0

1-1000=$0.10
1001-2000=$0.08
>2000=$0.05

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Peak

$0

1-1000=$0.08
1001-2000=$0.05
>2000=$0.03

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Off Peak

$0
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Gas GasWith
StandingCharge

$10 per 
month

GasWithStanding
ChargeUsage

1-1000=$0.12 Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Threshold

$0

1-1000=$0.10
1001-2000=$0.08
>2000=$0.05

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Peak

$0

1-1000=$0.08
1001-2000=$0.05
>2000=$0.03

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Off Peak

$0

GasWith
NoStandingCharge

$0 per 
month

GasWith
NoStandingCharge
Usage

1-1000=$0.12 Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Threshold

$0

1-1000=$0.10
1001-2000=$0.08
>2000=$0.05

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Peak

$0

1-1000=$0.08
1001-2000=$0.05
>2000=$0.03

Region=North
MeterType=Credit
PaymentType=Automatic 
Debit
Usage Type=Off Peak

$0

DualFuelWith
StandingCharge

$0 per 
month

Table 13. Rate Plan Examples

Class Root Product Subcomponents Tier Pricing Attributes List Price
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These complex rate plans are usually maintained in external billing and pricing 
systems. They are matched up with the actual consumer usage when generating a 
utilities bill.

Business Scenarios for Price Comparison
These scenarios show sequences of procedures performed by a pricing manager 
(administrator), customer service representative (end user), and new customer 
(end user) requesting price comparisons over a Web site. Your company may follow 
different sequences according to its business requirements.

Pricing Manager Sets Up Rate Plans
Your company’s pricing manager creates a rate plan as a new customizable product 
and associates a class with it that defines its attributes. For this customizable 
product, she wants Payment Type to be the attribute of the parent rate plan so that 
the attribute will be inherited by its subcomponents. She then creates another 
product as a subcomponent to represent the different usage types and associates it 
with the same class. 

Next, the pricing manager sets up tier pricing for the class, specifying different 
tiered rates for different attribute combinations. She sets up a price list for her 
company and for each of the competitors. She adds both the root product and 
subcomponents as price list items. She associates the tier pricing with the 
subcomponents.

A month later, the pricing manager receives the latest publication of residential rates 
for a major competitor, so she updates her data with the most current information 
for each rate for that competitor.

StandardWith
StandingCharge

$15 per 
month

GasWith
StandingCharge

$10 per 
month

Table 13. Rate Plan Examples

Class Root Product Subcomponents Tier Pricing Attributes List Price
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Next, she realizes that the competitor has introduced a new rate plan into the 
market. Because her company does not have an equivalent rate, she creates a new 
rate product for the competitor’s plan and adds it to the competitor's price list. 

She can then also model the relevant pricing structure. When a customer service 
representative or a prospective customer chooses this rate, the comparison will 
report that there is no equivalent or like-for-like rate plans and return only those 
rate plans that match the attributes of the competitor's product or service. 

The next rate on her market intelligence gathering list is from a new competitor and 
therefore not in the database. She sets up a new price list for that competitor, and 
adds the existing equivalent rate products. She also notes that the rate is only 
offered within the city limits of Richardson, so she creates a rate structure for which 
the Region attribute has a value of Richardson. 

Pricing Manager Analyzes Rate Plans
The pricing manager runs a report each month to compare her company’s rates with 
other competitors in the service area. She needs to review the effectiveness of her 
company’s rate plans, the introduction of competitors’ rate plans, and the 
redesigning of new rate plans to capture the market share needed.

The pricing manager first runs a report that lists all the competitors, their rate plans, 
and the cents/kWh for peak, off-peak, and weekend rates associated with each rate 
plan. This gives her a good idea of the dynamics in the marketplace.

She next runs a report consolidating the customers' inputs, choices and decision, 
for every single time the pricing calculator was run for a given time period, 
displaying the region, service (gas, electric, or both), competitor, rate plan, savings, 
and if they switched to National Energy. This data assists her in measuring the 
effectiveness of her rate plans in customer acquisition.

Prospective Customer Compares Prices and Enrolls Over the Web
Mr. Mathis, an energy customer with service provided by a competing firm, goes to 
a Web site to follow up on a price comparison ad he saw.
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Mr. Mathis is prompted to answer a series of questions. For the first question, he 
indicates that he wants to receive both gas and electricity service from this 
company. For his electricity service provider, he selects from a drop-down list that 
is specific to his region. That action triggers another drop-down list to appear from 
which he specifies his current service tariff or rate. 

Looking at his most recent bill, Mr. Mathis enters his quarterly costs. Since he has 
chosen gas and electric, he then answers similar questions concerning his gas 
service, and then clicks Finish.

Based on the gathered information, the Price Comparison calculator generates his 
projected annual bill. For each of the company’s rate plans, he also sees the savings 
he will achieve by switching to the company. 

Mr. Mathis selects the rate plan that saves him the most money and then clicks the 
Enroll button. He is then brought to a view that has the proper orderable service 
entered as a line item. Because he is not an existing customer, Mr. Mathis is required 
to go through new user registration before he can complete the transaction online. 

Example Sequence for Price Comparison
This example sequence for price comparison is performed by administrators and 
CSRs. Your company may follow a different sequence according to its business 
requirements.

Administrator Procedures
Administrators may want to perform the procedures in the order shown here.

1 Set up rate plans (products). See “Setting Up Products for Rate Plans 
(Administrator)” on page 134.

2 Set up price lists. See “Setting Up Price Lists for Rate Plans (Administrator)” on 
page 138.

3 Set up usage profiles. See “Setting Up a Usage Profile (Administrator)” on 
page 140.

4 Match rate plans. See “Matching Competitors’ Rate Plans with In-House Rate 
Plans (Administrator)” on page 141.
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5 Run reports. See “Running Reports (Administrator)” on page 142.

End-User Procedures
End users may want to perform the procedures in the order shown here.

1 Access the Price Comparison feature. See “Accessing the Price Comparison 
Feature” on page 143.

2 Generate price comparison. See “Generating a Price Comparison” on page 144.

3 Enroll customer for service. See “Enrolling a Customer for a Service” on page 145.

Administrator Procedures for Price Comparison
This section provides instructions for the following procedures:

■ To set up classes for rate plans on page 135

■ To create root products for rate plans on page 136

■ To create usage products on page 137

■ To set up usage products on page 137

■ To set up tier-based pricing on page 138

■ To set up price lists for the rate plans on page 140

■ To set up a usage profile on page 140

■ To match competitors’ rate plans with in-house rate plans on page 141

■ To run the Price Comparison Administrative Report on page 142

■ To run the Price Comparison Administrative Report on page 142

Overview of Setting Up Rate Plans (Administrator)
To use the price comparison feature, administrators need to perform these general 
procedures:
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1 Set up products (classes, root products, usage products as subcomponents).

2 Set up price lists.

3 Set up usage profiles.

4 Match rate plans.

The next sections provide step-by-step instructions for performing those 
procedures.

For rate plan examples, see “Rate Plans with Tier-Based Pricing” on page 127.

Setting Up Products for Rate Plans (Administrator)
To set up products, administrators must first set up classes to be associated with the 
products. For rate plans, classes describe the type of service, such as Electricity or 
Standard Electric Services. 

As part of defining classes, administrators create attributes, such as Meter Type, that 
get inherited by the products associated with that class. They also define the list of 
values available to the end user for each attribute of the class.

After that, administrators create and define the root products that should belong to 
the new class. To the root product, they add subcomponents, which are the usage 
products.

For more information on class systems and products, see Product Administration 
Guide and Siebel Order Management Guide Addendum for Industry Applications.

Attributes of Class Administration
Before proceeding with the procedures in this section, read this background 
information on the attributes of class administration.

In general, there are two categories of List of Values (LOVs) in Siebel applications:

■ One type is used for setting up Dynamic Attributes, described as part of the 
procedures in this section.
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■ One type is used everywhere else in the application, including in the Price 
Comparison SmartScript.

Therefore, if you follow the procedure described in this section to set up a dynamic 
attribute in Class Administration for use in Price Comparison, you will probably 
want to do the following:

■ Associate a List of Values to each dynamic attribute

■ Make the LOVs represent the possible answers to a corresponding question 
about customer's billing details in the Price Comparison SmartScript.

Because of the different categories of LOVs in Siebel applications, you need to set 
up two different LOV types with the same set of values. The first one you set up 
here in Class Administration, while the other one you set up in the regular LOV 
administration (see Applications Administration Guide).

Out of the box, Siebel eEnergy has already set up the LOV types and values for two 
dynamic attributes: Meter Type and Payment Method. The corresponding LOV types 
used in the Price Comparison SmartScript are UT_METER_TYPE and 
PAYMENT_METHOD.

In addition, for Region and Usage Type, you do not need to set up the regular LOVs. 
This is because Region does not use LOVs (it uses a special BusComp to hold the 
possible values), and Usage Type is not exposed in the SmartScript questions at all.

To set up classes for rate plans

1 From the application-level menu, choose View > Site Map > Application 
Administration > Class Administration.

2 In the Classes list, add a record.

Typical class names are Electric Service, Gas Service, and Standard Electric 
Service.

3 Click the Dynamic Attributes view tab.

4 In the Dynamic Attributes list, add a record and do these steps:

a In the LOV Type field, click the select button.
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b In the Pick List of Values Type dialog box, select an existing type or add a 
record for a new LOV type.

c In the Dynamic Attributes list, drill down on the LOV Type hyperlink.

d In the List of Values - Type list, add a record for each value that an end user 
can select for that LOV type.

5 Repeat Step 4 for each attribute you want to include.

Typical examples include Meter Type, Payment Method, Region, and Usage Type.

NOTE: There are special considerations when setting up dynamic attributes for use 
in the Price Comparison feature. To make sure you are setting up the dynamic 
attributes correctly, see “Attributes of Class Administration” on page 134.

To create root products for rate plans

1 Navigate to the Product Administration screen.

2 Click the More Info view tab.

3 In the More Info form, select Products from the Show drop-down list.

4 In the form, add a record. To access more fields, click the show more button in 
the upper right corner of the form.

5 In the Class field, select the class you created for this service.

6 In the new record, complete the necessary fields.

Some fields are described in the following table.

 

Field Comments

Price Type Displays the price type, such as Recurring (recommended for root 
product).

Service Type Displays the service type, such as Electricity or Gas.
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To create usage products

■ You must create the usage products before you can add them as subcomponents. 
Follow the procedure, “To create root products for rate plans” on page 136, with 
these differences:

a For Price Type, select Usage.

b For UoM, select the appropriate unit of measurement, such as kWh.

To set up usage products

1 Navigate to the Product Administration screen.

2 In the Products list, select the root product.

3 Click the Customizable Product view tab.

The Product form appears with the Lock/Unlock Product list and Versions list 
beneath it.

4 In the Lock/Unlock Product list, open the menu and select Create Workspace.

5 In the Lock/Unlock Product list, select Locked Flag.

6 From the lower Show drop-down list (beneath the Product form), select Product 
Designer.

Type Displays the type of product, such as Service.

UoM Displays the unit of measurement. Per Month is the only UoM 
supported for the standing charge.

Field Comments
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7 In the Product Designer list, add a record and complete the necessary fields.

Some fields are described in the following table.

8 From the lower Show drop-down list, select Product Versions.

9 In the Lock/Unlock Product list, open the menu and select Refresh Workspace.

10 Click Release New Version.

Setting Up Price Lists for Rate Plans (Administrator)
For rate plans, administrators use attribute-based pricing and tier-based pricing to 
give each variation of the master rate plan a rate. Therefore, administrators need to 
first set up tier-based pricing and then set up price lists for the products.

To set up tier-based pricing

1 Navigate to the Pricing Administration screen.

Field Comments

Default Default number of instances of this product. Typically, this is the same as 
the maximum.

Maximum Maximum number of instances of the products that is allowed. This 
should equal the number of types of usage. For example, if rates for usage 
are split into peak, off peak, and threshold, the maximum should be set 
to 3.

Minimum Minimum number of instances of the products that is allowed.

Product Select an existing usage product.
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2 In the More Info form, add a record and complete the necessary fields.

Some fields are described in the following table. 

3 Click the Attributes view tab.

4 In the Attributes list, add a record for each attribute that you want to affect the 
price.

5 Click the Adjustment Item Generator view tab.

6 In the Adjustment Item Generator list, select the first attribute. 

7 In the Item Generator list, check all values that you want to affect the pricing.

8 Repeat Step 6 and Step 7 for all attributes.

9 Click Generate. 

10 In the Items list, select an attribute combination.

11 Click the select button in the Tier Price field, and add a record in the Tier Price 
dialog box for each tier.

NOTE: The minimum quantity of the first tier must be 1. Tiers must not overlap 
and there must be no gaps. A maximum quantity is not required for the last tier.

12 Repeat Step 10 and Step 11 for each attribute combination. 

NOTE: Repeat this procedure until you have created as many tier pricing items as 
are required.

Field Comments

Class Use a class associated with the rate plan and usage 
products. 

Type Select Multiple Attributes. 

Default Starting Adjustment Type Tier Based
Version 7.5, Rev. B Siebel eEnergy Guide 139



Price Comparison

Setting Up a Usage Profile (Administrator)
To set up price lists for the rate plans

1 Navigate to the Pricing Administration screen.

2 From the Show drop-down list, select Price List.

3 Click the More Info view tab.

4 In the More Info form, add a record for a new price list.

5 For Type, select PC INHOUSE PRICE LIST or PC COMPETITOR PRICE LIST.

6 Click the Price List Line Items tab.

7 In the Price List Items list, add a record for each product (root product and usage 
subcomponent).

8 For each subcomponent product, select the appropriate tiered pricing in the 
Attribute Pricing column.

9 In the List Price field, select the standing charge as the list price of the root 
product.

Setting Up a Usage Profile (Administrator)
Administrators must set up the usage information that the price comparison feature 
uses to determine annual costs. This information includes data about the regions 
and multipliers to take into account for seasons when converting bills into annual 
costs.

To set up a usage profile

1 From the application-level menu, select View > Site Map > Product 
Comparison > PC Usage Profile.

2 In the PC Usage Profile list, add a record for the region. 

The region should be one that you entered as a list of values for the region 
attribute of that class.
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3 Complete the necessary fields.

Matching Competitors’ Rate Plans with In-House Rate 
Plans (Administrator)

Administrators need to specify which rate plans should be compared against each 
other to produce like-for-like quotes.

To match competitors’ rate plans with in-house rate plans

1 From the application-level menu, select View > Site Map > Product 
Comparison > Relationships.

2 In the Competitor Product field, select a competitor’s rate plan.

3 In the Orderable Product field, select the in-house rate plan that is the equivalent 
of the competitor’s rate plan.

Field Comments

Peak Usage Must be decimal value less than 1 that represents the proportion 
of usage that is during peak hours for a typical customer in that 
region.

Example: 0.3

Off Peak Usage Must be decimal value less than 1 that represents the proportion 
of usage that is during off peak hours for a typical customer in 
that region.

Example: 0.7

Summer Multiplier The multiplier to be used to convert a quarterly bill amount into 
an annual amount for a typical customer in that region.

Example: 5

Winter Multiplier The multiplier to be used to convert a quarterly bill amount into 
an annual amount for a typical customer in that region.

Example: 3
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Running Reports (Administrator)
The Price Comparison feature provides two reports:

■ The Price Comparison Administrative Report

This report displays the competitor’s name; the equivalent rate plan; the pricing 
at each tier for that rate plan; the day, night and weekend pricing for that rate 
plan; the projected annual bill for that rate plan; and the difference in price 
between the in-house and the competitor's rate plan. 

When the report is run, the report returns the price comparison data matching 
the requirements set in the Price Comparison Admin Reports parameters view. 

■ The Competitive Pricing Report

This report displays the competitor's name, equivalent rate plan, projected 
annual bill and the difference in cost between the in-house and the competitor's 
rate plan.

To run the Price Comparison Administrative Report

1 From the application-level menu, choose View > Site Map > Product 
Comparison.

2 From the application-level menu, select View > Reports.

3 In the Reports dialog box, select EPC Administrative Report from the drop-down 
list. 

4 Click Run Now.

5 In the EPC Admin Parameters dialog box, set the constraints for the report, if 
necessary.

If you do not set constraints, the report includes all the data.

6 Click Finish.

The Report Viewer displays the report.
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To run the Competitive Pricing report

1 From the application-level menu, choose View > Site Map > Product 
Comparison.

2 Click the CP Report button.

This begins the SmartScript session used with the Price Comparison feature. 
However, to run the report, you do not have to supply answers for Region, 
Supplier, or Rate Plans. If these questions are not answered, the report is 
generated for all regions, suppliers and rate plans.

3 At the end of the SmartScript session, click Finish.

Siebel eEnergy generates the report data as a background task. An email 
notification is sent to the user when the report has been generated.

End-User Procedures for Price Comparison
This section provides instructions for the following procedures:

■ To generate a price comparison for a customer on page 144

■ To enroll a customer for a service on page 145

Accessing the Price Comparison Feature
The Price Comparison feature can be made available through two applications:

■ Siebel eEnergy allows end users, usually customer service representatives at a 
call center, to access the Price Comparison feature through the Opportunities 
screen. 

This section describes the procedures that the customer service representatives 
would do to run the Price Comparison feature.

■ Siebel eSales allows prospective or existing customers to access the Price 
Comparison feature over the Web. 

For more information, see Siebel eSales Administration Guide.
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Generating a Price Comparison
End users can collect billing information for an existing service, such as gas or 
electricity. Siebel eEnergy converts this data into an annual cost, which it can then 
compare against internal rates.

To generate a price comparison for a customer

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select an existing record or add a new record and 
complete the necessary fields.

For more information about creating opportunities, see Chapter 8, 
“Opportunities.”

3 Click the Price Comparison view tab.

4 In the Price Comparison list, click New.

Clicking New launches a SmartScript session with a series of questions to 
answer.

5 Click Next until you have answered all the questions, and then click Finish.

Clicking Finish takes you back to the Price Comparison view in the 
Opportunities screen.

Some fields are described in this table.

Field Comments

Annual Savings Displays the amount the customer could save by switching to your 
company’s rate plan.

Attribute Values Displays the attributes and values for the product.

Equivalent Rate Indicates if the database found a like-for-like rate plan. 

Projected Bill Displays the annual cost calculated from the data provided.
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Enrolling a Customer for a Service
End users can enroll customers in a service offered by their company.

To enroll a customer for a service

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Price Comparison view tab.

4 In the Price Comparison list, select a price comparison or generate a new price 
comparison. 

For instructions, see “To generate a price comparison for a customer” on 
page 144.

5 Click Enroll. 

For an existing customer, Siebel eEnergy creates an order. For a new customer, 
the CSR is given the option to create an account before the order is created.

For more information on the ordering process, see Siebel Order Management 
Guide Addendum for Industry Applications.
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This chapter describes the procedures for handling customer inquiries about their 
invoices, usually performed by customer service representatives (CSRs). Using 
Siebel eEnergy, CSRs can retrieve past invoices, current unbilled charges, and other 
invoice details. CSRs can also arrange payment plans, record payments against an 
outstanding balance, or request adjustments to the customer’s records in the event 
of an incorrect bill.

Administrators involved with billing will benefit from reading this chapter. It 
describes how your CSRs access billing information and update billing accounts. 
After becoming familiar with the end-user procedures, you can customize the 
software to fit your company’s needs.

Billing processes are integrated with an external billing system that Siebel eEnergy 
accesses to retrieve information, such as the customer’s last statement. That 
information is stored temporarily in Siebel database tables.

Performance of the billing screens depends on both the configuration and speed of 
retrieval from the external billing system. Configurators can set up Siebel eEnergy 
so that all messages are sent and received from the back-office application in real-
time or batch mode. The results of these messages can also be stored in Siebel 
eEnergy database tables, allowing CSRs to resolve them in real-time.

Your company is responsible for performing the integration of Siebel eEnergy with 
billing systems. For detailed information, see Overview: Siebel eBusiness Application 
Integration Volume I.

For instructions on setting up profiles that are used to run credit ratings, record 
billing preferences, or store tax exemption information, see “Profiles” on page 49.
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10Business Scenario for Billing
This scenario shows a sequence of procedures performed by a CSR (end user). Your 
company may follow a different sequence according to its business requirements.

A CSR at an energy provider receives a call from a business customer. The customer 
has just received his company’s December invoice for electric service and believes 
that his company was overcharged for monthly usage.

The CSR verifies the caller's identity and then accesses the customer's billing 
information, primarily maintained in an external billing system. With the Siebel 
front-office system, the CSR can access billing information as if it were stored 
locally.

The CSR finds the December invoice at the top of the customer’s invoice list. She 
brings up an image of the invoice and notices that the customer has been charged 
$300 for off-peak demand. 

The CSR wants to review the electric usage and demand history to confirm the 
company used this much power. She first retrieves the customer's usage 
information for the December billing period. She then analyzes the usage and 
informs the customer that a demand spike occurred on December 20. She also 
checks to see the other invoices for previous months to determine if this demand 
spike is consistent. It is not. The customer realizes that December 20 was the day 
of his company's holiday party and this was the cause of the excess usage. 

The customer asks to check his usage for the current month to make sure there will 
not be unexpected surprises in the next month's invoice. The CSR reviews the 
unbilled charges and reports that there is no unusual usage.

While looking at the invoice details, however, she notices that the customer is being 
charged a city tax, from which his company should be exempt. The customer has 
been paying this amount for the last few months. To reimburse him for the error, 
she can enter an adjustment request against either the entire invoice or specifically 
against a line item in that invoice. She decides to associate the request with the 
invoice line item in this case.

She enters the amount of the tax and explains the reason for the request. She then 
submits the adjustment for processing by the external billing system. If it is 
accepted, this adjustment amount will be credited immediately to the balance of the 
account of the customer and will be printed on the customer’s next invoice. 
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Before she forgets, she accesses the customer's exemption profile and makes a note 
that he should be exempt from city tax, so that he will not be incorrectly charged 
in the future.

The customer would also like to pay his outstanding balance. The CSR finds the 
most recent invoice, which is for the month of January. She creates a payment 
against the invoice, enters the customer's credit card information, and submits the 
payment for processing by the external billing system. 

Before hanging up, the customer has one last request. He would like to start 
receiving invoices by email. The CSR goes to his billing profile, selects the 
appropriate Bill Media, and enters his email address. The customer thanks him for 
his time and hangs up.

After lunch, the CSR receives a phone call from another customer, who needs to 
arrange a payment plan. His recent invoice was considerably higher than normal, 
so he wants to spread out the payment over the next three months. After the CSR 
verifies that his credit is still good, she enters the payment arrangement request and 
notes the special circumstances. The external billing system processes the request 
and approves it in a few moments. The CSR informs the customer that his request 
has been accepted and that he should look for that additional amount in the next 
three invoices.
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Figure 13 summarizes the sequence of procedures an end user might use to update 
billing information in Siebel eEnergy:

Figure 13. Example of Sequence for Billing
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End-User Procedures for Billing
This section provides instructions for the following procedures:

■ To access the Billing Portal view on page 155

■ To access the Invoice views on page 155

■ To view invoice line items on page 155

■ To view the image of an invoice on page 156

■ To view the invoice history on page 156

■ To record a payment at the account level on page 157

■ To record a payment against one invoice on page 158

■ To record a payment against multiple invoices on page 159

■ To view the payment history on page 159

■ To view usage details on page 159

■ To view unbilled charges on page 160

■ To request an adjustment to an entire invoice on page 162

■ To request an adjustment to a line item in an invoice on page 162

■ To view the outcome of an adjustment request on page 163

■ To view the history of adjustment requests on page 164

■ To record the customer’s decision about the adjustment outcome terms on 
page 164

■ To request a payment arrangement on page 165

■ To view the outcome of a payment arrangement request on page 166

■ To view the history of payment arrangements on page 166

■ To record the customer’s decision about the payment outcome terms on 
page 167
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■ To request a duplicate invoice on page 168

■ To update a billing profile on page 168

Accessing or Updating Billing Information
Siebel eEnergy allows end users to access the same invoice information through 
different views. By selecting one view or another, end users can find the information 
most relevant to them, according to the procedure they need to perform at that 
moment.

Most views allow end users to record interactions with a customer and to update 
the customer’s information, depending on the system setup and the end user’s 
access rights. 

From these views, end users can access information on billing, such as the account 
balance, invoice history, payment history, and adjustment history. 

NOTE: The procedures described in this chapter contain the most frequently used 
method for performing each task, including which view to access, although other 
methods may exist.

End-User Views
The end-user views are:

■ Billing Portal view (call center agent). The Billing Portal view summarizes the 
billing information that a call center agent would most likely need to review 
while talking to a customer. It also makes it easy for call center agents to handle 
the most common transactions associated with invoices. 

The Billing Portal view serves as a starting point for most customer inquiries. 
Among other tasks, the Billing Portal views allow call center agents to:

■ Review the account status, such as the balance, delinquency information, 
and pending financial transactions (credit and debit) that have not yet been 
applied to the balance.
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■ View the most recent invoices of a customer and drill down to access detailed 
information about an invoice.

■ View the history of payments and adjustments.

This is useful if customers claim that they have already made a payment and 
that the balance is not correct.

■ Access the usage history of different services that the customer has so that 
unexpected hikes can be explained to the customer.

■ Begin transactions, such as recording payments or adjusting balances.

Table 14 describes the information available in the Billing Portal view.

Table 14. Billing Portal View

Views Description

Account Displays account information that corresponds to the Accounts 
screen, More Info view. End users can edit this information.

Account Balance Displays balance information for the account. Retrieves this 
information from an external billing system. Information is read-
only.

Pay button. Takes end users to the Invoices screen, Payments 
view, where a payment has been created to settle the entire 
account balance.

Refresh button. Updates the information with the most current 
data.

Invoice History Displays information from the Invoices screen. Information is 
read-only.

Invoice # hyperlink. Takes end users to the Invoices screen, Line 
Items view.

Payment History Displays the payment history for the account. Information is 
read-only.

Payment # hyperlink. Takes end users to the Invoices screen, 
Payments More Info view, Invoices subview, where they record 
payments. 
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■ Invoices views (call center agent). The Invoices views allow call center agents to 
view all bill details. These views are generally accessed to reply to customer 
complaints regarding a specific charge on the bill. The Invoices views also allow 
call center agents to start transactions, such as adjusting an invoice, recording a 
payment against the invoice, requesting a bill duplicate.

Sequence for Accessing Billing Information
To resolve customer inquiries, end users first locate the billing account, where they 
generally record payments. For most other transactions, end users record 
information at the invoice level. 

End users can access the most recent invoice or retrieve past invoices. They can 
view invoice details, such as line items, after selecting the invoice. In addition, they 
can view the image of an already-sent invoice bill in HTML format.

NOTE: Some customers have a consolidated billing account for a number of service 
items. Siebel eEnergy allows end users to view charges associated with a billing 
account, service account, or parent account. For more information about accounts 
and subaccounts, see Chapter 2, “Accounts.”

Adjustment History Displays a subset of the information from the Invoices screen, 
Adjustment Requests view. Information is read-only.

Request # hyperlink. Takes end users to the Adjustment 
Requests view, Line Items subview. 

Additional Info Billing Profile hyperlink. Takes end users to the Accounts screen, 
Profiles view, Billing Profile form.

Usage Detail hyperlink. Takes end users to the Accounts More 
Info form, Usage Detail view.

Unbilled Charges hyperlink. Takes end users to the Account 
More Info form, Unbilled Charges view.

Table 14. Billing Portal View

Views Description
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To access the Billing Portal view

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account.

3 Click the Billing Portal view tab.

The Billing Portal view appears with several lists and forms summarizing the 
billing information for that account.

To access the Invoice views

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

When you select All External Invoices, the Invoices list displays the bills that 
have been generated by an external system. The information found in the 
Invoices list (header information) is generally stored in the Siebel database. 
However, due to the large volume of data, it is not recommended that your 
company store the Invoice Line Item information in the Siebel database, but 
instead access that data in real time through integration.

NOTE: When you select All Invoices from the Show drop-down list, the Invoices 
list displays all invoices, including external invoices.

3 In the Invoices list, perform a query in the Bill To Account field for the account 
name.

The Invoices list displays all invoices for that account, sorted by invoice number. 

4 In the Invoices list, select the invoice you want to view.

5 Click a view tab to access specific information for that account.

To view invoice line items

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.
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3 In the Invoices list, drill down on the Invoice # hyperlink.

The Invoices form appears with the Line Items list beneath it. From the Invoices 
form, end users can also click the Pay, Adjust, or Usage Detail buttons to 
continue with a transaction.

4 If the service item does not appear in the list, perform a query.

For example, enter the service ID in the Service field.

To view the image of an invoice

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 Click the Invoice Image view tab.

The invoice appears as a graphic at the URL that the administrator set up. For 
instructions on setting up this feature, see “Setting Up the Invoice Image Feature 
(Administrator)” on page 170.

To view the invoice history

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Billing Portal view tab.

The Invoice History list displays the most current records for the invoice. 

4 If the information does not appear in the Invoice History, perform a query to 
access the correct records.

5 Drill down on the Invoice # hyperlink.

6 In the Line Items list, click the view tab for the information you want to view.
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Entering Payment Against an Outstanding Balance
End users can enter a payment for a customer at either the account level or the 
invoice level, according to the accounting system used at their company:

■ Account-Level Payments. Associate the payment against the account when the 
company’s accounting method applies the payment against the account balance 
(Balance Forward).

■ Invoice-Level Payments. Associate the payment against one or more invoices 
when the company’s accounting method applies the payment against the bill 
balance (Open Item). 

To record a payment at the account level

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Billing Portal view tab.

4 In the Account Balance form, click Pay.

The Payments list appears with the account information already filled in for the 
new record.

5 In the field, select a method for payment.

6 In the Payments list, complete the necessary fields.

Some fields are described in the following table.

Field Comments

Payment # System-generated number.

Payment Date Automatically populated.

Payment Amount Automatically populated based on the account and account 
balance. Status must be set to Open to enter the amount. 
Otherwise, it is read-only.

Status Set automatically to Open. End users can edit this record as long 
as the Status is not Submitted.
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7 In the More Info form, complete additional fields, if necessary. The fields 
displayed depend on the Payment Method selection you made.

■ EFT. Deducts payment from the customer’s bank account.

■ Credit Card. Charges payment to the customer’s credit card.

■ Reference. Captures payment details that were made at a third-party location, 
such as post offices or banks.

8 Click Submit.

To record a payment against one invoice 

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, click Pay.

A new record is created with the payment number, amount, date, and status 
already populated. 

4 Continue with Step 5 of “To record a payment at the account level” on page 157, 
and perform the remaining steps in the procedure.

Field Comments

Bank Account # Customer’s bank account number. 

Account Holder Name Name under which the customer’s bank account is 
registered. 

Bank Branch Reference number of the specific branch of the 
customer’s bank.

Field Comments

Location Location where the payment was made. 

Reference # Reference number of the payment. 
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To record a payment against multiple invoices

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account.

NOTE: End users can also begin this procedure from the Billing Portal view. For 
information, see Table 14 on page 153.

3 Click the Payments view tab.

4 In the Payments list, add a payment.

5 Drill down on the Payments # hyperlink.

The Payment Detail form appears with view tabs beneath it.

6 Click the Invoices view tab.

7 In the Invoices list, enter the amount that you want to apply to each invoice in 
the Payment Amount field.

8 In the Payment Detail form, enter the total amount.

To view the payment history

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Billing Portal view tab.

The Payment History list displays the most current records for the account. 

Viewing Usage Details
End users can view usage details for an invoice.

To view usage details

1 Navigate to the Accounts screen.
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2 In the Accounts list, select an account.

3 Click the Billing Portal view tab.

4 Scroll down to the Additional Info list.

5 Drill down on the Usage Detail hyperlink.

The Usage Detail list appears with the Usage History list beneath it.

6 In the Usage History list, select the data you want to view from the drop-down 
list.

Viewing Unbilled Charges
End users can view unbilled charges for an account. The total of all unbilled charges 
appears in the Billing Portal view, but for a breakdown of the charges, end users can 
follow this procedure.

NOTE: End users can also begin this procedure from the Billing Portal view. For 
information, see Table 14 on page 153.

To view unbilled charges

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Unbilled Charges view tab.

The Unbilled Charges view displays the charges incurred since the last invoice. 

Some fields are described in the following table.

Field Comments

Next Invoice Date Date the next statement will be generated.

NonRecurrng Charge Current period’s nonrecurring charges.
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Overview of Adjustment Requests
End users must sometimes adjust customer bills for various reasons, such as to 
apply credit to compensate for an overcharge. The adjustment process consists of 
these procedures:

1 Request an adjustment for an invoice or invoice line item. 

2 View the request outcome.

3 Record the customer’s decision to accept or reject the outcome to the request.

The next sections describe these three procedures for adjusting an invoice.

For more information about integrating the billing component with an external 
billing system, see Chapter 15, “Defining an Integration Workflow Process.”

Requesting an Adjustment
End users can associate the adjustment request with the entire invoice or with a 
specific line item in the invoice. Because the billing component is integrated with 
an external billing system, an adjustment request is sent to the external billing 
system, which processes the request. 

NOTE: End users can also begin this procedure from the Billing Portal view. For 
information, see Table 14 on page 153.

Recurring Charges Current period’s recurring charges.

Surcharges Current period’s taxes and surcharges.

Total Charges Displays the total unbilled charges for the current period. 
Recurring charges+Nonrecurring Charges+Taxes and 
Surcharges=Total Charges.

Field Comments
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To request an adjustment to an entire invoice

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 Click the More Info view tab.

5 In the More Info form, click Adjust.

The Adjustment Requests form appears with some information populated. 

6 Verify the fields and complete any necessary fields.

To request an adjustment to a line item in an invoice

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 Click the Line Items view tab.

The Adjustment Requests form appears with the Line Items list beneath it. In the 
Adjustment Requests form, the Status defaults to Open and the Type defaults to 
Credit. The list displays a history of adjustment requests.
162 Siebel eEnergy Guide Version 7.5, Rev. B



Billing

Viewing an Adjustment Request Outcome
5 Select the line item you want to adjust, and click Adjust.

A new record is created with some information already populated.

6 Complete any necessary information, such as the reason for the Adjustment, and 
click Submit.

Siebel eEnergy processes the request and populates the fields with the results.

Viewing an Adjustment Request Outcome
Typically, the account adjustments and payment arrangement plans are determined 
in the back office, either manually or through a system. The back-office system then 
sends the outcome of the request to Siebel eEnergy.

End users can view the request outcome as well as view the history of adjustment 
requests.

To view the outcome of an adjustment request

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 In the Invoices list, drill down on the Invoice # hyperlink.

The Invoices form appears with the view tabs beneath it.

5 Click the Adjustment Requests view tab.

6 In the Adjustment Request list, review the Amount Approved field.

These fields show the external billing system’s response to the bill repayment 
plan request. The Status field is updated automatically.
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To view the history of adjustment requests

1 Navigate to the Accounts screen.

2 Select an account.

3 Click the Adjustment Requests view tab.

The Adjustment Requests list displays all adjustment requests that exist for the 
account.

Recording a Customer’s Decision About Adjustment 
Outcome Terms

After consulting with the customer, end users can record the customer’s decision to 
accept or reject the outcome terms.

To record the customer’s decision about the adjustment outcome terms

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, drill down on the Invoice # hyperlink.

The Invoices form appears with the view tabs beneath it.

4 Click the Adjustment Request view tab.

5 In the Adjustment Requests list, select the request record.

6 In the Customer Decision field, select information to indicate the customer’s 
decision to accept or reject the outcome terms.

NOTE: If your company’s policy does not require a customer decision regarding a 
bill adjustment outcome, the customer decision fields may not be available.
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Overview of Payment Arrangement
End users can request a special arrangement if a customer is unable to pay for 
services when a bill payment is due. The customer may request a payment plan or 
a deferral of payment. In response, your company can approve the request, reject 
the request, or propose its own terms. The response may depend on factors such as 
corporate policy, customer credit history or credit worthiness, and longevity of the 
customer’s association with your company.

The arrangement process consists of these procedures:

1 Request a payment arrangement for the customer.

2 View the request outcome.

3 Record the customer’s decision about the outcome.

The next sections describe these three procedures for arranging a payment plan.

For more information about integrating the billing component with an external 
billing system, see Chapter 15, “Defining an Integration Workflow Process.”

Requesting a Payment Arrangement
Because the billing component is integrated with an external billing system, a 
payment arrangement request is sent to the external billing system, which processes 
the request and generates a response.

To request a payment arrangement

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 Click the Payment Arrangements view tab.
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5 In the Payment Arrangements list, add a record and enter information for the 
request. 

Some fields are described in the following table.

The external billing system processes the request and populates the Payment 
Arrangements Outcome view at the bottom of the screen. 

Viewing the Outcome of a Payment Arrangement Request 
Siebel eEnergy receives the outcome of the request, which is generated by the 
external billing system. 

To view the outcome of a payment arrangement request

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, drill down on the Invoice # hyperlink.

The Invoices form appears with the view tabs beneath it.

4 Click the Payment Arrangements view tab.

5 Scroll down to the Payment Arrangements Outcome form to review the external 
billing system’s response to the bill repayment plan request. 

To view the history of payment arrangements

1 Navigate to the Invoices screen.

Field Comments

Number of Installments For a single-payment deferral plan, this is 1. When you click 
on the Installment Amount field, the amount is 
automatically generated.

Installment Amount When you click on this field, the amount is generated 
according to the Original Amount Due and Number of 
Installment data.
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2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 Click the Payment Arrangements view tab.

5 In the Payment Arrangements list, select Payment Arrangements or Payment 
Arrangements Details from the drop-down list.

6 If the information does not appear in the Payment Arrangements list, perform a 
query to access the correct records.

Recording a Customer’s Decision About Payment 
Arrangement Terms

After consulting with the customer, end users can record the customer’s decision to 
accept or reject the payment plan that their company is offering.

To record the customer’s decision about the payment outcome terms

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 Click the Payment Arrangements view tab.

5 Scroll down to the Payment Arrangements Outcome form and select information 
in the Customer Decision field to indicate the customer’s decision to accept or 
reject the terms. 

NOTE: If your company’s policy does not require a customer decision regarding a 
bill repayment plan outcome, the customer decision fields may not be available.

Requesting a Duplicate Invoice
Occasionally, a customer might request a copy of an invoice.
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To request a duplicate invoice

1 Navigate to the Invoices screen.

2 From the Show drop-down list, select All External Invoices.

3 In the Invoices list, select an invoice.

4 Click the Duplicate Request view tab.

5 In the Duplicate Request list, add a record and complete the necessary fields. 

Some fields are described in the following table. 

6 To send the invoice to a different mailing address:

a In the Duplicate Request list, select Duplicate Bill Request Details from the 
Show drop-down list.

b In the Address field, associate another address.

Updating a Billing Profile
When billing a customer, Siebel eEnergy integrates information, such as exemption 
information or discounts, that is stored in profiles. 

To update a billing profile

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Billing Portal view tab.

4 Scroll down to the Additional Info form.

Field Comments

Address Address to send the duplicate bill. The City, State, Zip, and Country fields 
are automatically populated when you select the address.

Comments Specific directions or descriptions about the duplication process.
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5 Drill down on the Billing Profile hyperlink.

6 In the Billing Profile form, update the information.

For further information about profiles, see Chapter 3, “Profiles.”

Additional End-User Procedures Related to Billing
For descriptions of other procedures related to billing, see the Siebel Bookshelf.

Caller Verification
When receiving an inbound call, end users first verify and locate the caller. For more 
information about this process, see Siebel Call Center User Guide.

Administrator Procedures for Billing
This section provides instructions for the following procedures:

■ To generate credit, fraud, and usage information on page 170

■ To set up the invoice image feature on page 170

Generating Credit, Fraud, and Usage Information 
(Administrator)

Siebel eEnergy contains a view for administrators that simulates an external billing 
system. From that view, you can create credit, fraud, and usage details for a billing 
account. End users do not have access to the view.

CAUTION: Siebel eEnergy billing administration views are part of the Billing 
Management option. Exclusively for testing purposes, these views are used to 
simulate an external billing system and therefore should not be used in a production 
environment. For this reason, they are not part of release documentation.
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To generate credit, fraud, and usage information

1 From the application-level menu, select View > Site Map > Billing Data 
Administration > Billing Data Administration. 

2 In the Billing Accounts list, select the account. 

3 Click the Credit, Fraud, or Usage view tabs.

4 In the appropriate list, add a record and complete the necessary fields.

NOTE: For Load Factor in the Usage view, you must enter the value as a 
percentage and not as a decimal value (multiply the value for used or available 
kWh by 100%). For example, if you would normally enter .50 as a load factor, 
enter 50. This will make sure that the data displays properly throughout Siebel 
eEnergy.

Setting Up the Invoice Image Feature (Administrator)
End users can request the image of a customer’s bill from the external billing 
system, if that feature has been set up by the administrator. The image is returned 
in HTML format and is not stored within the Siebel application. 

To set up the invoice image feature

1 From the application-level menu, choose View > Site Map > Integration 
Administration Screen > Host Administration.

2 In the HTTP Host list, add a record and complete this information:

3 From the application-level menu, choose View > Site Map > Integration 
Administration Screen > Symbolic URL Administration.

Field Comments

Name Name of your invoice host. This is an identifier and should match the 
Virtual Name.

Virtual Name Name of your invoice host. 
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4 In the Symbolic URL list, select the BillStatement record.

NOTE: In the Name field, run a query for BillStatement. BillStatement is the name 
of the control defined in Siebel Tools Reference.

5 In the Bill Statement record, complete this information:

6 Restart the application.

The image now points to the specified URL.

Field Comments

Fixup Name InsideApplet will display the image within the current applet. 
OutsideApplication will display the image in a new popup window.

Host Name Name of your invoice host. Select the name entered in Step 2.

URL URL for the bill image to appear. 
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The Work Orders module in Siebel eEnergy helps service providers to manage the 
components needed to activate a service for a customer. A work order is an action 
item that must be completed to implement an order. When an order is submitted, 
the back-office order processing system divides it into one or more work orders, 
based upon criteria, such as service provider or due dates. A work order has most 
of the components found in a standard order, but it deals specifically with those 
items that are required for the provisioning process.

By creating and tracking work orders separately, you can access the status of a sales 
order. This is important because work orders are executed by back-office systems. 
Tracking the status of an order gives you up-to-date access to the information 
related to the order and can therefore convey it to a customer at any time, either 
through inbound contact or through outbound workflow-initiated activities.

The Energy Work Orders module works in conjunction with the Energy Order 
Processing module. It uses much of the work conducted during the order process 
and provides screens that allow you to manage work orders.

Business Scenario for Work Orders
This scenario shows a sequence of procedures performed by a customer service 
representative (end user). Your company may follow a different sequence according 
to its business requirements.

A customer service representative (CSR) for an energy service provider takes an 
order for a new small commercial customer, requiring electric service, gas service, 
and a facility submetering service. The order created by the CSR includes three line 
items, one for each service. The CSR provides a quote to the customer, who accepts 
it and asks that the order be placed.
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In the Order Summary view, the CSR submits the order to the back-office systems. 
The energy service provider must notify the distribution companies for electric and 
gas services, so submitting the order creates work orders for these services. In this 
case, the order is separated into three separate work orders, which are then 
submitted to the various providers for activation:

■ Electric service—provided by the electric distribution company

■ Gas service—provided by the gas distribution company

■ Submetering service—provided by an outsource partner

The customer calls back a week later to see if her account has been switched over. 
A different CSR takes the call and is able to search the account to find any open 
orders. When the CSR finds the appropriate order, he drills into the hyperlink to find 
the work orders associated with the order. Although the electric and gas services 
have been switched, he sees that the submetering work order is still open due to a 
backlog in the appropriate meters. From the associated notes and activities, he is 
able to tell the customer that the new submetering service should be installed 
within the next three days. 

Figure 14 shows the sequence of procedures that an end user might follow to 
manage work orders.

Figure 14. Example of Sequence for Work Orders
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End-User Procedures for Work Orders
This section provides instructions for the following procedures:

■ To create a work order on page 175

■ To associate an activity plan with a work order on page 176

■ To create an activity for a work order on page 176

■ To create line items to be allocated for the order on page 177

■ To add a line item action on page 177

■ To add a work order term on page 178

Creating a Work Order
End users can create work orders.

To create a work order

1 Navigate to the Work Orders screen.

2 Click the More Info view tab.

3 In the More Info form, add a record and complete the necessary fields. To access 
more fields, click the show more button in the upper right corner of the form.

Some fields are described in the following table.

Field Comments

Account Master account for this order. Account # is automatically filled 
when a value is entered in this field.

Address Address of the account.

Last Name Contact for the order.
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Adding an Activity to a Work Order
End users can create an activity and associate it with a premise to:

■ Remind themselves of procedures related to a premise that they must perform.

■ Communicate procedures related to a work order that other members of the 
organization must perform.

Activity plans consist of a list of activities to be completed to resolve a problem. If 
an appropriate activity template exists, end users can select the template to 
populate their activities list with a defined set of activities. Then end users can 
customize the list, if necessary. 

To associate an activity plan with a work order

1 Navigate to the Work Orders screen.

2 In the Work Orders list, select a work order.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, add a record.

5 In the Template field, select an Activity Template.

To create an activity for a work order

1 Navigate to the Work Orders screen.

2 In the Work Orders list, select a work order.

3 Click the Activities view tab.

4 In the Activities list, add a record and complete the necessary fields.

Order The sales order associated with the work order.

Provider Vendor for the work order. Clicking the select button in this field 
launches a Pick Vendor dialog box.

Field Comments
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End users can create line items and line item actions to be allocated for a work 
order.

To create line items to be allocated for the order

1 Navigate to the Work Orders screen.

2 In the Work Orders list, select a work order.

3 Click the Line Items view tab.

4 Scroll down and click the Line Detail subview tab.

5 In the Line Detail form, add a record and complete the necessary fields. To 
access more fields, click the show more button in the upper right corner of the 
form.

Some fields are described in the following table.

To add a line item action

1 Navigate to the Work Orders screen.

2 In the Work Orders list, select a work order.

Field Comments

Product When you select a product, you are selecting a line item from the 
associated Service Order. The Action, Due Date, UoM, Price and 
Status fields are automatically populated with the information 
from the Order Line Item view.

Ship to Last Name An existing contact can be selected in the Ship to Contacts dialog 
box, or a new contact can be added. The Ship to First Name field 
is automatically populated when you enter a value in this field. 
When you complete this field, the City, State, ZIP Code, and 
Country fields are automatically populated.

Address An existing address can be selected in the Ship to Addresses 
dialog box, or a new address can be added. When you complete 
this field, the City, State, ZIP Code, and Country fields are 
automatically populated.
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3 Click the Line Item Actions view tab.

4 In the Line Item Actions list, add a record and complete the necessary fields.

Adding Work Order Terms
End users can add a work order term.

To add a work order term

1 Navigate to the Work Orders screen.

2 In the Work Orders list, select a work order.

3 Click the Terms view tab.

4 Scroll down to the second Terms form, and complete the necessary fields.

Some fields are described in the following table.

Additional End-User Procedures Related to Work Orders
For descriptions of other procedures related to work orders, see the Siebel Bookshelf.

Work Orders and Attachments
At any time, end users can store additional information relating to a work order in 
the database by associating an electronic file with the work order record. For 
directions for associating an attachment with a record, see Fundamentals.

Field Comments

Freight Terms Terms describing how to ship the order.

Payment Terms Terms describing how the customer will pay.

Return To Return address for order items.

Status Status of the order.
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Siebel eEnergy service requests and trouble tickets are primarily used by customer 
service representatives (CSRs) and their managers, as well as network operations 
center (NOC) agents.

Service requests and trouble tickets are database records that are used to manage 
problems with equipment or general requests for service. This chapter is mostly 
about trouble tickets, but it also explains the differences between trouble tickets and 
service requests and tells you where you can find more information about service 
requests. This chapter:

■ Guides you in setting up features that help to automate trouble ticket 
management

■ Describes procedures typically used by end users to create, monitor, and close 
trouble tickets

■ Describes procedures that you can use for overall management of trouble tickets

Service Requests and Trouble Tickets Overview
Service requests and trouble tickets are managed through the Service Requests and 
Trouble Tickets screens.

Service requests and trouble tickets perform similar functions. The main differences 
are:

■ Trouble tickets functionality supports parent-child relationships

■ Trouble tickets are typically used to record and track problems with the 
functioning of services and networks, whereas service requests are typically 
used to record and track general customer problems and requests. Examples of 
general problems and requests are billing problems, requests for new 
equipment, and requests for billing statements.
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Initiation of Service Requests and Trouble Tickets
Service requests and trouble tickets may be initiated in several ways:

■ A customer calls the call center to report a problem with the phone line.

■ A network outage management system that is integrated with Siebel eEnergy 
automatically creates a trouble ticket record in the Siebel eEnergy database.

■ Agents can reassign service requests and trouble tickets to other groups or 
individuals for resolution. Alternatively, agents can break a service request or 
trouble ticket down into different activities, which can be assigned to different 
owners. In this case, the agent can monitor progress towards completion of the 
activities and close the service request or trouble ticket.

Creation of Service Requests and Trouble Tickets
Service requests and trouble tickets can be created within Siebel eEnergy or moved 
into Siebel eEnergy by:

■ Customers using Siebel eService

■ Customers and partners using an Automated Call Distributor (ACD)

■ Call center agents responding to phone calls or email from customers

■ NOC agents responding to network problems

■ Automated network outage management systems that are integrated with Siebel 
eEnergy

Trouble Ticket Referral
Trouble tickets can be referred from Siebel eEnergy to trading partner software 
through integration with an electronic bonding gateway, using Siebel eBusiness 
Application Integration (eAI).

Additional Information on Service Requests
The remainder of this chapter describes trouble ticket management. For more 
information about service requests, see Siebel Field Service Guide and Siebel Call 
Center User Guide.
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Business Scenario for Service Requests and Trouble 
Tickets

This scenario shows a sequence of procedures performed by a customer service 
representative (end user) and a workflow manager (administrator). Your company 
may follow a different sequence according to its business requirements.

During a typical day in a customer service organization, a group of Customer 
Service Representatives (CSRs) respond to customer phone calls and assign thirty 
trouble tickets. Twenty of the trouble tickets are solved using existing solutions, 
which the CSRs associate with the trouble tickets. Ten of the trouble tickets require 
new solutions, which the CSRs create after performing the necessary research. 
Between them, the CSRs make two mistakes when they click the wrong part of the 
user interface during an operation. They note their mistakes in email messages to 
the manager and ask the manager to correct them. 

At the end of the day, the manager performs routine administrative work on the 
solutions that were created during the day, starting with correcting the two errors. 
In one error, a CSR accidently associated a solution with the wrong product defect; 
the manager corrects this by dissociating them. A different CSR incorrectly 
associated a solution with a resolution document; the manager resolves the problem 
by dissociating them.

Next, the manager reviews each of the new solutions in turn. She performs a query 
for the solutions that were created during the day and examines the first record. She 
checks that it is associated with a trouble ticket and then reads the solution. Being 
familiar with this type of problem, the manager recalls a similar solution that may 
be useful for a CSR to know about. She locates the similar solution and associates 
the two records.

The manager also recalls a technical document on the company’s network that 
might help to explain the problem. She locates the document, creates a new 
resolution document record, attaches the document to the record, and associates 
the record with the solution. She is now satisfied with the solution, so she changes 
its status to Final and makes sure that it is only visible internally.
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The manager reviews the second solution and checks that it is associated with a 
trouble ticket. This solution is incomplete so the manager leaves the status as Draft. 
She informs the CSR who created the solution that this problem is related to, and 
should be associated with, a known product defect, and asks the CSR to research it 
more thoroughly.

The manager checks that the third solution is associated with a trouble ticket and 
reads the resolution documents associated with it. One of the resolution documents 
is an internal technical document that was recently revised and should be replaced. 
The manager dissociates the solution from the document, locates the revised 
version on the network, adds it to the database, and associates it with the solution. 
She then changes the status of the solution to Final.

The manager reviews each of the remaining newly created solutions in a similar 
manner.
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Figure 15 shows the sequence of procedures that end users might follow to manage 
trouble tickets.

Figure 15. Example of Sequence for Trouble Tickets
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Administrator Setup for Service Requests and Trouble 
Tickets

You can create scripts and automate the assignment of trouble tickets, thereby 
making the CSRs’ job easier.

■ You can use Siebel SmartScript to provide scripts that guide CSRs as they collect 
information about trouble tickets. For more information about creating scripts, 
see Siebel SmartScript Administration Guide.

■ CSRs or other qualified personnel can manually assign ownership of a trouble 
ticket to themselves, to another employee, or to a group. With the appropriate 
setup, Siebel Assignment Manager can be used to give the CSR the option of 
automating the assignment.

For more information about setting up Siebel Assignment Manager (including rules, 
criteria, workload, employees, positions, and territories), see Siebel Assignment 
Manager Administration Guide.

End-User Procedures for Service Requests and Trouble 
Tickets

This section provides instructions for the following procedures:

■ To create a trouble ticket on page 185

■ To assign a trouble ticket manually to a person or group on page 186

■ To associate a child trouble ticket with existing parent trouble tickets on 
page 187

■ To verify the entitlement associated with the trouble ticket on page 188

■ To associate an activity plan with a trouble ticket on page 189

■ To add an activity to a trouble ticket on page 190

■ To close a trouble ticket on page 190

■ To conduct a customer survey on page 191
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■ To send out a customer satisfaction survey on page 191

■ To analyze trouble tickets data using charts on page 192

Overview of Trouble Ticket Creation
To create a trouble ticket, end users must follow this sequence:

1 Create a new trouble ticket record.

2 Assign the trouble ticket to a qualified CSR, if necessary.

3 Verify the customer’s entitlements.

4 Enter the service details of the trouble ticket. 

5 Set up the trouble ticket as a child trouble ticket, if necessary.

The next sections describe each procedure.

Creating a Trouble Ticket Record
End users can create a trouble ticket record.

To create a trouble ticket

1 Navigate to the Trouble Tickets screen.

2 Click the More Info view tab.
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3 In the More Info form, add a record and complete the necessary fields. To access 
more fields, click the show more button in the upper right corner of the form. 

Some fields are described in the following table.

Assigning a Trouble Ticket to a Person or Group
If end users are unable to resolve trouble tickets themselves, they may need to 
assign them to another qualified CSR or to a group. 

In general, trouble tickets can be assigned in these ways:

■ Batch assignment. Siebel Assignment Manager can assign many trouble tickets at 
a scheduled time. For more information, see Siebel Assignment Manager 
Administration Guide.

■ Dynamic assignment. Siebel Assignment Manager can automatically assign 
trouble tickets at preset intervals. For more information, see Siebel Assignment 
Manager Administration Guide.

■ Interactive assignment. Siebel Assignment Manager is invoked manually from the 
menu button in the More Info view, as described in the next procedure.

■ Manual assignment. Users select the owner in the Trouble Tickets screen, as 
described in the next procedure.

To assign a trouble ticket manually to a person or group

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket by doing one of these:

Field Comments

Last Name The last name of the person reporting the problem.

Owner Person responsible for resolving the trouble ticket (may be the end user, 
another service representative, or a service group).

Ref # A number used by an external system (if any) to identify the trouble 
ticket.
186 Siebel eEnergy Guide Version 7.5, Rev. B



Service Requests and Trouble Tickets

Associating Parent and Child Trouble Tickets
■ Perform a query in the list.

■ Make the appropriate selections from the Queries and Show drop-down lists 
to define the trouble ticket record set, and then select the trouble ticket in the 
Trouble Tickets list.

3 In the More Info form, click the show more button and then do one of the 
following:

■ To assign a trouble ticket using Siebel Assignment Manager, click the menu 
button, select Assign, and then select a person.

■ To manually assign a trouble ticket to a person, select a person in the Owner 
field. 

■ To manually assign a trouble ticket to a group, select a group in the Group 
field.

Associating Parent and Child Trouble Tickets
The general procedure for setting up a parent-child relationship is to create the child 
trouble ticket and then associate it with an existing trouble ticket that will be the 
parent.

End users can group many child trouble tickets under one parent trouble ticket. 
Grouping several trouble tickets under one parent can be useful for managing a 
single network problem that results in calls from many customers. 

To associate a child trouble ticket with existing parent trouble tickets

1 Navigate to the Trouble Tickets screen.

2 In the Trouble Tickets list, select one or more child trouble tickets.

3 Click the Parent Trouble Tickets view tab.

The Trouble Ticket Details form appears with the Parent Trouble Tickets list 
beneath it.

4 In the Parent Trouble Tickets list, click New.
Version 7.5, Rev. B Siebel eEnergy Guide 187



Service Requests and Trouble Tickets

Trouble Ticket Solutions
5 In the Add Trouble Tickets dialog box, select one or more parent trouble tickets.

NOTE: A list of children of a selected trouble ticket appears in the Related Trouble 
Tickets view.

To verify the entitlement associated with the trouble ticket 

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket.

3 Click the More Info view tab.

4 In the More Info form, click the show more button to access more fields.

5 In the Entitlement Name field, select an entitlement.

NOTE: For information on determining how this dialog box is populated, see 
Siebel Field Service Guide.

6 In the More Info form, click Verify.

The Due Date field is automatically populated with the appropriate time period. 
For instance, if the customer is entitled to have a problem fixed within two 
hours, the Due Date field will reflect this.

Trouble Ticket Solutions
Customer service organizations estimate that approximately 85 percent of assigned 
trouble tickets are related to problems that have been previously encountered. 
Siebel eEnergy provides easy access to descriptions of how previous trouble tickets 
were resolved. When there is no existing solution to a trouble ticket, a member of 
the organization can research the problem and create a new description in the form 
of a solution record.
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Solutions Defined
In Siebel eEnergy, the term solution specifically means a record in the Siebel 
eEnergy database that includes a description of how a previous trouble ticket was 
resolved or how an anticipated future trouble ticket could be resolved. The word 
solution is also used in general terms to mean an answer to a problem.

Further Information
End users can review and create solutions for trouble tickets using the same 
methods used to review and create solutions for service requests. For more 
information about working with solutions, see Siebel Field Service Guide.

Resolving Trouble Tickets
This section describes various ways of resolving trouble tickets.

Adding an Activity to a Trouble Ticket
Resolving a trouble ticket may require several procedures, performed by more than 
one person or group. End users can create an activity for each step and assign the 
activity to themselves, another qualified person, or a group.

Activity plans consist of a list of activities to be completed to resolve a problem. If 
an appropriate activity template exists, end users can select the template to 
populate their activities list with a defined set of activities. Then end users can 
customize the list, if necessary. 

For more information about working with activities and activity plans, see 
Applications Administration Guide.

To associate an activity plan with a trouble ticket

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, add a record.

5 In the Template field, select an Activity Template.
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To add an activity to a trouble ticket

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket.

3 Click the Activities view tab.

4 In the Activities list, add a record and complete the necessary fields.

Closing a Trouble Ticket
When a trouble ticket is resolved, end users can change its status to Closed in any 
Trouble Ticket list or form. Changes cannot be made to trouble tickets that are 
closed. To continue working on a closed trouble ticket, first change its status to 
Open or Pending.

To close a trouble ticket

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket.

3 Click the More Info view tab.

4 In the More Info form, from the Status drop-down list, select Closed.

NOTE: When you save or click outside the record, the Sub-Status field changes to 
Resolved and the Date Closed field reflects the current time and date.

Using the Customer Satisfaction Survey
Customer satisfaction surveys allow end users to conduct a survey with the person 
who initiated a trouble ticket. If they have Chart Works Server (a third-party 
application) installed, a chart displays a measurement of the customer’s satisfaction 
as they record the customer’s responses. On a subsequent occasion, they can 
conduct another survey without overwriting existing survey records.
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Using the Customer Satisfaction Survey
As part of closing a trouble ticket, end users can conduct a customer survey in 
person, or they can use the Correspondence screen to send a letter and survey to 
the originator of a trouble ticket. When they mail a survey, an activity is 
automatically generated for the mailing.

To conduct a customer survey

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket.

3 Click the Customer Satisfaction Survey view tab.

4 Scroll down to the Survey Details form, and add a record.

5 Ask each of the questions on the Survey form and record the customer’s answer 
for each field.

To send out a customer satisfaction survey

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket.

3 From the application-level menu, select File > New > Correspondence.

4 In the Correspondence list, add a record.

5 In the Template field, select the appropriate customer satisfaction survey 
template.

6 Complete the remaining necessary fields in the Correspondence form.

Some fields are described in the following table.

7 To add another recipient, add a record in the Recipients list.

8 To include an enclosure:

Field Comments

Label Template A template for the mailing labels.

Fulfillment Center The department or company that will handle mailing the survey.
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Analyzing Trouble Tickets Data
a In the Enclosures list, add a record.

b In the Add Literature dialog box, select a record and click Add.

9 In the Correspondence list, click Submit to send the survey.

Analyzing Trouble Tickets Data
You can use charts to perform various types of analyses on your group’s trouble 
tickets.

To analyze trouble tickets data using charts

1 Navigate to the Trouble Tickets screen.

2 Select the trouble ticket.

3 Click the Charts view tab.

4 In the Charts view, from the Show drop-down list, select a chart.

5 In the By drop-down lists, select appropriate chart settings.

Additional End-User Procedures Related to Trouble 
Tickets

For descriptions of other procedures related to trouble tickets, see the Siebel 
Bookshelf.

Customer Verification
When a customer telephones a call or service center, end users must verify if the 
person is an existing or new customer. To verify a customer, end users navigate to 
the Accounts or Contacts screen and perform a query on a form of information 
about the customer, such as last name, Social Security number, and so on. If the 
customer exists in the system, end users can review which requests have already 
been entered for this customer. If the customer does not already exist in the system, 
end users can add the customer. For more information about accounts and contacts, 
see Chapter 2, “Accounts,” and Chapter 4, “Contacts.”
192 Siebel eEnergy Guide Version 7.5, Rev. B



Service Requests and Trouble Tickets

Additional End-User Procedures Related to Trouble Tickets
Entitlement Verification
When creating a trouble ticket, verify the type of service agreement and 
entitlements connected with it. For more information about service agreements and 
entitlements see Chapter 5, “Agreements and Entitlements.”

Communication with Field Service Agents
End users may need to contact a field service agent. Siebel eEnergy allows you to 
send messages about trouble tickets in several ways, including sending a text 
message to a pager. For more information, see Siebel Communications Server 
Administration Guide.

Trouble Tickets and Attachments
At any time, end users can store additional information relating to a trouble ticket 
in the database by associating an electronic file with the trouble ticket record. For 
directions for associating an attachment with a record, see Fundamentals.
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Additional End-User Procedures Related to Trouble Tickets
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Credit management functionality frequently resides in third-party back-office credit 
systems. Siebel eBusiness Application Integration (eAI), which is part of Siebel 
eEnergy, provides you with the ability to integrate with these systems and to use 
their information and functionality. 

If customers are late in paying their bills or have not paid their bills in full, their 
accounts are flagged by the third-party credit system. The rules for detecting late 
payment or nonpayment are defined in the credit system. Siebel eEnergy can 
interpret late payment or nonpayment messages that the credit system generates. 

As a basis for credit management, Siebel eEnergy provides information in the form 
of credit alerts. A credit alert is a Siebel eEnergy credit record that can be generated 
by messages from a back-office credit management system when a customer 
breaches a credit threshold. It can also be generated manually by a customer 
request or by the initiative of a customer service representative (CSR). Credit alerts 
can be resolved through a variety of means, such as customer payment of the 
outstanding amount, adjustments to a customer account to correct an erroneous 
billing, and an agreement with a customer for a payment arrangement plan.

Credit Management Functions
Siebel eEnergy Credit Management provides the following capabilities:

■ Credit Alerts. Generates credit alerts when external credit management systems 
send information about changes in the credit situation of a customer. Provides 
the ability to send updated credit alert information back to the external credit 
management systems. 

■ Activities. Generates activities associated with a credit alert. Also allows you to 
add activities based on a credit alert. 
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Business Scenario for Credit Management
■ Payments. Allows you to send customer payments to the credit management 
system in response to a credit alert. 

■ Account Adjustments. Allows you to send requests to the credit management 
system for adjustments to a customer account when a credit alert is in error. 
Displays the credit management system’s responses to these requests. 

■ Payment Arrangements. Allows you to send requests to the credit management 
system for payment arrangement plans in response to a credit alert. Displays the 
credit management system’s responses to these requests. 

■ Attachments. Allows you to attach external documents to a credit alert. 

In addition, Siebel eEnergy provides the following credit management requirements 
in other modules:

■ Credit Rating. Displays the customer’s credit rating details, including credit score, 
source, and date. For more information, see “About Financial Profiles” on 
page 60.

■ Billing Information. Displays customer billing information you may need to 
resolve a credit alert. 

CSRs use Credit Management functionality to manage and monitor customer credit 
issues. They are responsible for reviewing with the customer all account 
information and credit issues, as well as answering billing inquiries, suggesting 
payment arrangement plans, and making account adjustments. 

Customer service supervisors use Credit Management functionality to determine if 
a CSR is allowed to request credit adjustments on a customer’s account, set up 
payment arrangement plans, and maintain billing profiles. 

Business Scenario for Credit Management
This scenario shows a sequence of procedures performed by a customer service 
representative (end user). Your company may follow a different sequence according 
to its business requirements.
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Business Scenario for Credit Management
A CSR is responsible for handling credit queries for all of your small and medium-
sized customers. A business customer has a contract for electrical services for its 
offices. The owner usually pays the bill on time. However, the latest bill for electrical 
services is overdue by 18 days. 

This nonpayment is automatically detected by the company’s accounts receivable 
system and is forwarded to the credit management system, which then forwards a 
nonpayment message to Siebel eEnergy. The message causes Siebel eEnergy to 
create a credit alert. 

Siebel eEnergy then generates an activity to contact the owner and sets the account 
status appropriately. The credit alert appears in the customer service supervisor's 
queue by default, and the supervisor assigns the credit alert to the CSR. 

The CSR examines the credit alert and reviews the billing information needed to 
handle any customer questions. She also checks for all credit alerts raised against 
the customer’s account in the last 12 months to see if there is a history of 
delinquency. This turns out to be the first credit alert against the customer’s 
account. The CSR then checks the customer's credit rating, which is acceptable.

The CSR looks up contact information for the customer in Siebel eEnergy and 
telephones the owner, who is listed as the primary contact for the customer 
account. The owner apologizes for the delay in payment of the bill and explains that 
the company has experienced a temporary cash flow problem. The owner asks what 
options are available. The CSR informs the owner that he can either delay the 
payment of the bill or request a payment arrangement plan. The owner asks to 
repay the outstanding bill in three installments. 

The CSR enters the required information into Siebel eEnergy, sets the credit alert’s 
Status to Pending, and records the details of the conversation in the Comments 
field.

Siebel eEnergy transmits this information to the credit management system. The 
credit management system processes the request overnight and responds with an 
update to the credit alert. The next day, the CSR checks for all open and pending 
credit alerts assigned to them. The CSR notices that the customer’s payment 
arrangement request has been approved. 
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Business Scenario for Credit Management
The CSR contacts the owner and informs him of the outcome. The CSR then writes 
a letter confirming the details of the payment arrangement plan, and attaches the 
letter to the credit alert. Then the CSR updates the Action Type of the credit alert to 
Payment Arrangement Agreed.
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Business Scenario for Credit Management
Figure 16 shows the sequence a CSR might use to process a customer credit alert.

Figure 16. Example of Sequence for Credit Management
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End-User Procedures for Credit Management
End-User Procedures for Credit Management
This section provides instructions for the following procedures:

■ To create an internal credit alert on page 201

■ To add an activity to a credit alert on page 202

■ To create a payment record on page 203

■ To submit a request for an account adjustment on page 205

■ To submit a request for a payment arrangement plan on page 205

■ To view a history of payment arrangements on page 206

■ To view an account adjustment outcome on page 207

■ To view a payment arrangement plan outcome on page 207

■ To record the customer’s decision about an account adjustment outcome on 
page 208

■ To record the customer’s decision about a payment arrangement outcome on 
page 209

■ To close a credit alert on page 209

Reviewing and Adding a Credit Alert
The All Credit Alerts view displays all credit alerts in the system. The My Credit 
Alerts view displays only the credit alerts that are assigned specifically to an end 
user. These views are identical except for the ownership. The policies for 
assignment of credit alerts are determined by their company.

End users can use the All Credit Alerts view or the My Credit Alerts view to see 
external credit alerts, which originate from your company’s external credit 
management system. They can limit the list by selecting a predefined query. Siebel 
eEnergy includes the queries All, Closed, Open and Unassigned Alerts. 
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Reviewing and Adding a Credit Alert
End users can also use these views to create internal credit alerts for preemptive 
measures; these alerts can record situations such as the likelihood of a delayed 
customer payment. If they have permission to do so, end users can create a credit 
alert and a corresponding payment arrangement plan record. 

On being contacted by a service provider regarding a credit problem, a customer 
may want you to query the billing account. The customer may, for example, believe 
that he has been incorrectly billed. End users may, therefore, need to refer to the 
customer billing data to deal with the customer contact. For more information, see 
Chapter 10, “Billing.” 

To create an internal credit alert

1 Navigate to the Credit Management screen.

2 In the Credit Alerts form, add a record and complete the necessary fields. To 
access more fields, click the show more button in the upper right corner of the 
form.

Some fields are described in the following table.

Field Comments

Account Account name associated with the credit alert.

Account # Account number associated with the credit alert. 

Action Type Type of action to be performed in relation to a credit alert. The 
Action Type may generate or require one or more activities. 

Agreement Agreement associated with the credit alert.

Alert # Unique identifier for the credit alert, which may or may not be 
generated within Siebel eEnergy. Automatically populated when a 
new record is added. 

Amount Owed Amount owed by the customer.

Created On Date and time stamp showing when the credit alert was generated 
within Siebel eEnergy.

Invoice # Invoice number associated with the credit alert.

Owner Person to whom the credit alert is assigned.
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Adding an Activity to a Credit Alert
Adding an Activity to a Credit Alert
End users can associate activities with a credit alert. The Credit Alert Activities view 
displays all activities associated with a selected credit alert. 

To add an activity to a credit alert

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert record.

3 Click the Activities view tab.

4 In the Activities list, add a record and complete the necessary fields.

Communication with the Customer
Contact the customer to discuss the reason for the credit alert and the available 
payment options. Determine if it is necessary to adjust the customer’s account, or 
help the customer to decide whether they would like to send payment immediately 
or request a payment arrangement plan.

Priority Priority of the action to be taken in response to the credit alert.

Source Indicates if the alert was generated externally by a credit 
management system or internally by a CSR. Automatically 
populated.

Status Status of the credit alert.

Field Comments
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Entering Payment Information
The Payment Information view allows end users to submit a record of payment 
received from a customer in response to a credit alert. One possible resolution for a 
credit alert involves the customer’s immediate payment of the amount outstanding. 
End users can enter multiple instances of payment information for a single credit 
alert. 

The Credit Alert Detail form displays a selected credit alert. The Payment 
Information form changes dynamically depending on the payment method end 
users select in the Method field.

To create a payment record

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert record.

3 Click the Payments view tab.

4 Scroll down to the Payment Detail form and add a record.

5 In the Payment Method field, select the type of payment method used by the 
customer to make a payment.

When you select a payment method from the Method drop-down list, additional 
fields appear in the form. 

6 Complete the necessary fields.

Some fields are described in the following table.

Field Comments

Card # (Credit Card only) The number on the front of the credit card.

Reference Location 
(Reference only)

The name of the third-party business (for example, 
bank or post office name).

Reference # (Reference Only) The purchase order or receipt number.
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Overview of Requests for Account Adjustments or Payment Plans
For more information about entering payment information, see “Entering Payment 
Against an Outstanding Balance” on page 157.

Overview of Requests for Account Adjustments or 
Payment Plans

A customer may have been incorrectly billed for a service and therefore may not 
have made a payment. In that case, end users need to make an adjustment to the 
customer’s billing account. Typically, they associate an account adjustment with a 
credit alert because it may solve a customer credit issue. The actual account 
adjustment is made in a third-party billing or accounts receivable system. However, 
Siebel eEnergy provides the ability to request an adjustment and to receive 
information about the outcome. 

Another customer might be facing financial difficulties and is unable to meet his 
obligations to pay for services. Such a customer might request a payment 
arrangement plan with installments or a deferral of payment. In response, your 
company can approve the request, reject the request, or propose its own terms. The 
response may depend on factors such as corporate policy, customer credit history 
or credit-worthiness, and length of the customer’s association with your company. 
A payment arrangement plan is associated with a credit alert because it may resolve 
a customer credit issue.

The customer request is sent to the back-office credit management system for 
approval. The customer request can be approved in full, rejected entirely, or 
modified with new terms. The credit management system then sends the outcome 
back to Siebel eEnergy.

NOTE: You can request either an installment plan or a payment deferral. For a 
deferral request, specify one installment to be paid at a future date. 

Account adjustments and payment plans consist of these procedures:

1 Submit the request for an adjustment or a payment plan.

2 View the request outcome.

3 Record the customer’s decision about the outcome.
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Submitting a Request
The next sections describe these three procedures.

Submitting a Request
End users first submit a request for an account adjustment or a payment plan.

To submit a request for an account adjustment

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert. 

3 Click the Account Adjustments view tab.

The Account Adjustments list displays the history of adjustment requests.

4 In the Account Adjustments list, add a record and complete the necessary fields.

Some fields are described in the following table.

NOTE: It is possible to submit multiple account adjustment requests for a single 
account. However, this situation is not typical.

To submit a request for a payment arrangement plan 

1 Navigate to the Credit Management screen.

Field Comments

Amount Amount of the adjustment. Set by default to amount owed on the credit 
alert. 

 Date Date the request for adjustment is made. Set by default to current date and 
time.

Reason Reason the adjustment request is being made.

Status Status of the request. Set by default to Open.

Type Type of adjustment request.
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2 In the Credit Alerts list, select a credit alert. 

3 Click the Payment Arrangements view tab.

4 In the Payment Arrangements form, select Payment Arrangement Details from 
the Show drop-down list.

5 In the Payment Arrangement Details form, add a record and complete the 
necessary fields.

Some fields are described in the following table.

6 Click the back button until you return to the credit alert list.

7 From the Action Type drop-down list, select Payment Arrangement Requested.

To view a history of payment arrangements

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert. 

Field Comments

Installment Amount This field is automatically populated when you enter the 
number of installments. The installment amount equals the 
original amount due divided by the number of installments. 

Number of Installments Number of installments for payment arrangement. For a 
single-payment deferral plan, this number is 1.

Original Amount Due Total amount due. 

Original Due Date Original due date for payment.

Plan End Date Payment Arrangement plan end date. 

For a single-payment deferral plan, use the same date for 
both Start Date and End Date.

Plan Start Date Payment Arrangement plan start date.

Plan Type Type of payment arrangement plan.

Status Status of the request. From the drop-down list, select 
Pending.
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Viewing a Request Outcome
3 Click the Payment Arrangements view tab.

4 In the Payment Arrangements form, select Payment Arrangement from the Show 
drop-down list.

Viewing a Request Outcome
Typically, the account adjustments and payment arrangement plans are agreed 
upon in the back office, either manually or through a system. The back-office 
system then sends the outcome of the customer request to Siebel eEnergy.

To view an account adjustment outcome

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert. 

3 Click the Account Adjustments view tab. 

4 In the Account Adjustments list, review the credit management system’s 
response to the adjustment request, specifically the Status, Amount Approved, 
and Approval Description fields.

NOTE: Each adjustment request is accompanied by a single adjustment outcome.

To view a payment arrangement plan outcome 

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert. 

3 Click the Payment Arrangements view tab. 
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4 Scroll down to the Payment Arrangements Outcome form to view the credit 
management system’s response to the adjustment request. 

Some of the fields are described in the following table.

Recording the Customer’s Decision About the Outcome
End users can record the customer’s decision about the outcome.

To record the customer’s decision about an account adjustment outcome

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert. 

3 Click the Account Adjustments view tab. 

4 In the Account Adjustments list, enter information in the Customer Decision and 
Customer Decision Date fields.

NOTE: If your company’s policy does not require a customer decision regarding 
an account adjustment outcome, the customer decision fields may not appear in 
Siebel eEnergy.

Field Comments

Installment Amount Payment amount per installment. This can be either a single 
payment or multiple installments.

Interest Charge Interest owed on the payment arrangement plan. This is 
calculated by the back-office system.

Number of Installments Number of installments. This can be either a single payment 
or multiple installments.

Plan Type Type of payment arrangement plan.

Status Outcome of the payment arrangement plan request.

Total Amount Due Total owed for bill and accrued interest.
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5 If the customer rejects the outcome, discuss the options again and submit 
another request.

To record the customer’s decision about a payment arrangement outcome

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert. 

3 Click the Payment Arrangements view tab. 

4 Scroll down to the Payment Arrangements Outcome form and enter information 
in the Customer Decision and Customer Decision Date fields.

NOTE: If your company’s policy does not require a customer decision regarding 
an account adjustment outcome, the customer decision fields may not appear in 
Siebel eEnergy.

5 If the customer rejects the outcome, discuss the options again and submit 
another request.

Closing a Credit Alert
After an outcome has been received and accepted (if necessary), close the credit 
alert.

To close a credit alert

1 Navigate to the Credit Management screen.

2 In the Credit Alerts list, select a credit alert. 

3 In the Action Type field, select Payment Arrangement Agreed.

4 In the Status field, select Closed.
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Additional End-User Procedures Related to Credit 
Management

For descriptions of other, more general procedures related to credit management, 
see Siebel Field Service Guide, Applications Administration Guide, Siebel Sales User 
Guide, and Siebel Call Center User Guide.

Financial Information Checks
Look at customer financial information, including bills and credit rating data, that 
may be useful in resolving credit alerts. For information about checking customer 
financial information, see “About Financial Profiles” on page 60.
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Fraud occurs when someone uses a service to defraud a consumer, business, or 
service provider by obtaining free services or services that the individual concerned 
is not entitled to. Some of the more common methods and indicators of fraud 
include:

■ Illegal tapping of utility service points

■ Bills returned in the mail with a claim that the customer is not at that address

Fraud can be identified in various ways. For example, a consumer may identify 
fraud on a bill, noting charges for services that were not requested or used. 
Alternatively, a service provider may identify irregular usage patterns that may 
indicate fraud.

Traditionally, companies have used legacy fraud management systems to identify 
and manage fraud.

Fraud Management Overview
The fraud management process involves fraud alerts, warnings that a fraud may 
have been committed, which are generated by the fraud management system from 
an analysis of usage details. 

A fraud alert can also be generated by a breach of a fraud threshold. A fraud 
threshold is a value which, when exceeded, produces a fraud alert. 

The back-office system issues a fraud alert by placing the customer on a fraud list, 
a list of customer accounts that are suspected of or confirmed for fraud. The back-
office system may generate multiple lists, classified by categories in descending 
order of the likelihood of fraud.
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Business Scenario for Fraud Management
A back-office fraud management system usually has a front-office component, 
which is used to manage customer interactions related to fraud. Siebel eEnergy 
functions as the front-office application for managing fraud. Your company’s back-
office fraud management systems send fraud lists to Siebel eEnergy for follow-up. 
Customer service representatives (CSRs) go through the lists and contact the 
customers to check if they used the services that are the cause of the fraud alerts.

Fraud alerts indicate what type of fraud may have occurred. For example, Exceeds 
Threshold is a fraud alert type that indicates that a predefined limit has been 
exceeded. 

To help you resolve cases of suspected or obvious fraud, Siebel eEnergy allows you 
to view fraud lists, fraud alerts, fraud-related background information about 
accounts, and the history of fraud-related activities for an account.

Business Scenario for Fraud Management
This scenario shows a sequence of procedures performed by a customer service 
representative (end user). Your company may follow a different sequence according 
to its business requirements.

A CSR is responsible for handling fraud issues for your residential customers. A 
customer has a contract for residential electric and gas services.

Your fraud management system finds that the meter readings at the customer’s 
location show typical gas usage but no electricity usage. Such a pattern may mean 
a problem with the electric meter, a theft of energy, or a gas leak in an unoccupied 
residence. The fraud management system generates a fraud alert for the customer's 
account, with the fraud level set to Suspected, fraud type set to Theft, and fraud 
event set to No Electric Usage. The fraud message is forwarded to Siebel eEnergy. 
Through integration with the third-party system, the fraud data is sent to the CSR’s 
Siebel application, and the account is flagged as fraudulent. The Siebel application 
creates a fraud alert and fraud alert details and updates the customer account with 
the fraud level.
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Business Scenario for Fraud Management
Siebel eEnergy has been configured to generate an activity to contact the customer. 
The fraud alert appears in the customer service supervisor's queue by default, and 
the supervisor assigns the fraud alert to the CSR, who examines the fraud alert. The 
CSR also checks for any other fraud alerts raised against the account in the last 12 
months to see if it has a history of fraud. This turns out to be the first fraud alert 
against the account.

The CSR looks up contact information for the customer's account in Siebel eEnergy 
and telephones the customer, intending to ask if the premises are occupied. The 
person who answers the phone is hesitant and claims that the premises are 
“infrequently” occupied. The CSR suspects that this is a case of electricity theft. The 
CSR updates the fraud alert's status and attaches appropriate comments.

Siebel eEnergy transmits this information to the fraud management system. The 
CSR's fraud management department then starts its formal investigation and 
dispatches a field service agent to the premise location.
Version 7.5, Rev. B Siebel eEnergy Guide 213



Fraud Management

End-User Procedures for Fraud Management
Figure 17 shows a possible sequence for managing fraud.

End-User Procedures for Fraud Management
This section provides instructions for the following procedures:

■ “To view a fraud alert” on page 215

■ To view fraud alert details on page 215

Figure 17. Example of Sequence for Fraud Management
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Viewing Fraud Alerts and Fraud Alert Details
■ To change a fraud threshold on page 217

■ To update a fraud alert on page 217

Viewing Fraud Alerts and Fraud Alert Details
When a back-office application flags an account for fraud, Siebel eEnergy receives 
a fraud alert and fraud alert details.

In the course of investigating fraud, end users review the fraud alert to determine 
the type of fraud that may have occurred. End users then discuss the fraud alert 
details, which contain the specific data alleged to be fraudulent, with the customer.

To view a fraud alert

1 Navigate to the Fraud Management screen.

2 In the Fraud Alerts list, select a fraud alert.

Some fields in the list are described in the following table.

To view fraud alert details

1 Navigate to the Fraud Management screen.

2 In the Fraud Alerts list, select a fraud alert.

Field Comments

Alert # Unique identifier code assigned by the system to each fraud 
alert.

Fraud Event Condition that indicates suspected fraud. The value in this field 
depends on the value in the Fraud Type field.

Owner Primary person assigned to this account for fraud management 
purposes. This person is responsible for customer follow-up to 
determine if fraud has taken place.

Threshold Overflow Quantity by which the account’s threshold level was exceeded.
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Follow-Up with the Customer
3 Click the Event Details view tab.

An Account form appears with the Event Details list beneath it. The Event 
Details list displays detailed information about the selected alert. This typically 
consists of the call detail records associated with the suspected fraudulent calls.

It is possible for certain fraud alerts to have no associated fraud alert details.

Some fields in the Event Details list are described in the following table.

Follow-Up with the Customer
End users should establish contact with the customer. Your company may have a 
business rule that determines how many times end users should attempt to contact 
the customer. 

If repeated attempts to contact the customer fail, end users may need to disconnect 
the customer’s service. Your company can configure Siebel eEnergy to send a 
message to this effect to the back-office system. Workflow Manager or a VB script 
might be used for this configuration.

Field Comments

Charge Cost of or charges for the service from the Charge dialog box. 

Date/Time Date and time of the event.

Length Length of the service in seconds. 

Number Called Number dialed in a suspected fraudulent call.

Number Location Geographical location of the number dialed in a suspected 
fraudulent call.

Rate The name of the rate plan used to calculate the charge—for 
example, Peak, Off-Peak, Standard, Economy, or International.
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Changing Fraud Thresholds
Changing Fraud Thresholds
End users can change thresholds in the fraud profile, if necessary. For example, if a 
breach of a credit threshold generated the fraud alert, the customer can request a 
higher threshold. If this is granted, it may cancel the fraud alert.

To change a fraud threshold

1 Navigate to the Fraud Management screen.

2 In the Fraud Alerts list, select a fraud alert.

3 Click the Account Name hyperlink.

4 In the Fraud Account Profile form, change one or more of the fields.

For information about the fields in the Fraud Account Profile form, see 
Chapter 3, “Profiles.”

Updating the Fraud Alert
End users can indicate that some action has been taken by adding comments or by 
changing other fields in the fraud alert record, such as its status, priority, or owner.

To update a fraud alert

1 Navigate to the Fraud Management screen.

2 In the Fraud Alerts list, select a fraud alert.

3 Click the More Info view tab.

4 In the More Info form, complete the necessary fields.

Additional Procedures Related to Fraud Management
For descriptions of other procedures related to fraud management, see the Siebel 
Bookshelf.
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Disconnecting Service
End users can disconnect a customer’s service, if necessary, based on the nature of 
the alert, a discussion with the customer, failure to contact the customer, or your 
company’s policy. Depending on the severity of the alert, part or all of the 
customer’s services may already have been disconnected by the back-office system.

If your company has configured the Fraud Activities types to include Service 
Disconnect, end users can add this activity to a fraud alert. Otherwise, for 
information about disconnecting a service, see Siebel Order Management Guide 
Addendum for Industry Applications.
218 Siebel eEnergy Guide Version 7.5, Rev. B



Defining an Integration Workflow Process 15
A workflow process is a sequence of steps that automates a business function. Some 
workflow processes (also known as business processes) allow your company to 
integrate Siebel eEnergy with back-office systems, including databases. You can 
implement integration with third-party systems by using the following resources 
and techniques:

■ Prebuilt workflows. Some prebuilt workflow processes are included in the sample 
database distributed with Siebel eEnergy, along with prebuilt integration objects 
in the Siebel Tools repository. If a workflow process mentioned in this chapter is 
not in your Siebel application’s sample database, it may be available on request. 
To request a workflow process, please contact Siebel Professional Services.

■ Manual integration. Your company can automate the integration between Siebel 
eEnergy and other applications manually. To automate the integration between 
Siebel eEnergy and other applications manually, you normally use both Siebel 
Business Process Designer and Siebel eBusiness Application Integration (eAI). 

■ UAN integration. Siebel Systems’ Universal Application Network (UAN) is a 
separate product that defines a library of business processes to integrate external 
applications with Siebel applications. This library consists of business process 
flows, common objects, and transformation maps that run on third-party 
integration servers. Your company can use the design tools provided by the 
integration server vendors to model and configure the business processes, 
common objects, and transformation maps as needed. After they have been 
designed, these processes are imported into the integration server for 
deployment. For more information about UAN, or to purchase UAN, please 
contact Siebel Sales.

This chapter explains integration using prebuilt sample workflows that may be 
provided with your Siebel application or that may be available on request. This 
chapter contains the following sections:

■ Business scenarios that illustrate how sample integration workflow processes 
can be used to automate or partially automate a business process. 
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■ Descriptions of sample integration workflow processes that are available in the 
Siebel eEnergy sample database.

■ Details of two sample workflow processes to help you understand how a 
workflow process is set up. Refer to these samples when you design your own 
integration workflow processes.

This chapter does not give detailed information about Business Process 
Administration or application integration in general. For information about these 
topics, see Siebel Business Process Designer Administration Guide and the Siebel eAI 
guides, available on the Siebel Bookshelf.

NOTE: The integration workflow processes discussed in this chapter are not 
Application Services Interfaces (ASIs), although they serve a similar function. 

Terminology
This section describes some terms used in this chapter in the context of workflow 
processes.

Siebel eAI. Siebel eBusiness Application Integration is a set of tools, technologies, 
and prebuilt functional integrations that facilitate application integration. It 
supports message-based integration with external applications. Using the eAI 
module, a service provider can connect Siebel eEnergy directly to another 
application within the operational support system architecture or connect to a hub 
or queue. This process allows middleware vendors to build their own Siebel-to-
third-party connectors.

NOTE: Integration with specific back-office systems or middleware packages is 
performed by your company. Siebel eBusiness Applications offers prebuilt 
connectors to some back-office applications.

Integration Objects. Integration objects define the content of the messages that are 
initiated or received by Siebel eEnergy. They are based on business objects. The 
repository stores both integration objects and the mapping between business 
objects and integration objects.
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Business Services. Business services act upon objects to move data, convert data 
formats, and perform calculations. The Siebel eEnergy repository contains some 
business services that specifically help with integration tasks. You can also build 
your own in Siebel Tools (at design time) or in the Siebel Web client (at run time).

Workflow Processes. Workflow processes are sequences of steps that are used by 
Business Process Administration to automate a business function. Workflow 
process steps call business services that perform the procedures needed to perform 
a business process.

Business Scenarios for Defining Integration Workflow 
Processes

The following business scenarios illustrate how you can automate business 
processes using workflow processes in combination with Business Process 
Administration.

NOTE: Triggers for some business processes (for example, a button-push or workflow 
policy) are defined during implementation of the workflow process.

Responding to an External Request for Account Data
An external system requires account data from Siebel eEnergy. The external 
application calls the CUT Send Account Data workflow process using the available 
Siebel object interfaces. The CUT Send Account Data workflow process triggers the 
CUT Get Account Data subprocess. It retrieves the data from Siebel eEnergy using 
the workflow process as an API.

The workflow process used to perform this scenario is CUT Send Account Data 
along with the subprocess CUT Send Account Data.

Sending Account Data to an External System
An end user creates or modifies a customer account record in Siebel eEnergy, and 
this information is communicated to a back-office system.

The workflow process used to perform this scenario is CUT Send Account Data.
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Receiving Account Data from an External System
The customer account data has been modified in a back-office system and must be 
updated in Siebel eEnergy.

The workflow process used to perform this scenario is CUT Receive Account Data.

Responding to an External Request for Service Profile Data
An external system requires service profile data from Siebel eEnergy. The external 
application calls the CUT Send Service Profile workflow process directly, using the 
available Siebel object interfaces. The CUT Send Service Profile workflow process 
triggers the CUT Get Service Profile subprocess. It retrieves the data from Siebel 
eEnergy using the workflow process as an API.

NOTE: A service profile contains the same information found on the Installed Assets 
view of the Accounts screen.

The workflow process used to perform this scenario is CUT Send Service Profile 
Data along with the subprocess CUT Get Service Profile Data.

Synchronizing Service Profile Data with an External System
End users create or modify a service profile in Siebel eEnergy, and the profile data 
must be synchronized with one or more back-office systems.

The workflow process used to perform this scenario is CUT Send Service Profile 
Data.

Synchronizing External Service Profile Data
End users create or modify a service profile in an external application, and the 
profile data is synchronized with Siebel eEnergy.

The workflow process used to perform this scenario is CUT Receive Service Profile 
Data.
222 Siebel eEnergy Guide Version 7.5, Rev. B



Defining an Integration Workflow Process

Business Scenarios for Defining Integration Workflow Processes
Responding to an External Request for Sales Order Data
An external system requires sales order data from Siebel eEnergy. The external 
application calls the CUT Get Sales Order Data workflow process directly, using the 
available Siebel object interfaces. It retrieves the data from Siebel eEnergy directly, 
using the workflow process as an API.

The workflow process used to perform this scenario is CUT Get Sales Order Data.

Sending Sales Order Data to an External System
End users create a sales order in Siebel eEnergy, and the order data is sent to one 
or more back-office systems.

The workflow process used to perform this scenario is CUT Send Sales Order Data.

Receiving Sales Order Data from an External System
The sales order has been acted upon by one of the back-office systems and must be 
updated in Siebel eEnergy.

The workflow process used to perform this scenario is CUT Receive Sales Order 
Data.

Responding to an External Request for Work Order Data
The external system requires work order data. The external application calls the 
CUT Get Work Order Data workflow process using the available Siebel object 
interfaces. It retrieves the data from Siebel eEnergy directly, using the workflow 
process as an API.

The workflow process used to perform this scenario is CUT Get Work Order Data.

Sending Work Order Data to an External System
End users create a work order in Siebel eEnergy, and the order data is sent to one 
or more back-office systems. 

The workflow process used to perform this scenario is CUT Send Work Order Data.
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Receiving Work Order Data from an External System
The work order has been acted upon by one of the back-office systems and must be 
updated in Siebel eEnergy. 

The workflow process used to perform this scenario is CUT Receive Work Order 
Data.

Responding to an External Request for Trouble Ticket Data
The external system requires trouble ticket data. The external application calls the 
CUT Get Trouble Ticket Data workflow process using the available Siebel object 
interfaces. The external application retrieves the data from Siebel eEnergy directly, 
using the workflow process as an API.

The workflow process used to perform this scenario is CUT Get Trouble Ticket Data.

Sending Trouble Ticket Data to an External System
A trouble ticket is created by a customer through a Siebel eEnergy customer 
application or through a phone call to a CSR. After it is entered, trouble ticket data 
is sent to a back-office system using the CUT Send Trouble Ticket Data workflow 
process.

NOTE: Customers have different requirements, and only certain types of trouble 
tickets must be sent to back-office systems. Some trouble tickets can be managed 
entirely within Siebel eEnergy. The supporting integration process is designed for 
trouble tickets that are sent to the back office. During implementation of a workflow 
process, the trigger must be implemented in such a way that the workflow process 
is only invoked for trouble tickets that are sent to the back office.

The workflow process used to perform this scenario is CUT Send Trouble Ticket 
Data.
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Receiving Trouble Ticket Data from an External System
A trouble ticket is created in a back-office system. The trouble ticket record is sent 
by the back-office system to Siebel eEnergy using the CUT Receive Trouble Ticket 
workflow process, allowing call center representatives to access externally 
generated trouble tickets. Updates to trouble tickets stored in a back-office system 
can also be sent to Siebel eEnergy by this mechanism. 

The workflow process used to perform this scenario is CUT Receive Trouble Ticket 
Data.

Receiving Fraud Alert Data
A fraud alert record is created in a back-office system and sent to Siebel eEnergy 
using the CUT Receive Fraud Alert Data workflow process. Updates to fraud alert 
information stored in the back-office system are communicated to Siebel eEnergy in 
the same way, allowing CSRs to see the latest information about externally 
generated alerts.

The workflow process used to perform this scenario is CUT Receive Fraud Alert 
Data.

Receiving Credit Alert Data
A credit alert record is created in a back-office system and sent to Siebel eEnergy 
using the CUT Receive Credit Alert Data workflow process. Updates to credit alert 
information stored in the back-office system are communicated to Siebel eEnergy in 
the same way, allowing CSRs to see the latest information about externally 
generated alerts.

The workflow process used to perform this scenario is CUT Receive Credit Alert 
Data.
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Synchronizing Phone Number Data with an External System
End users create or modify a phone number in Siebel eEnergy, and the phone 
number is synchronized with one or more back-office systems using the CUT Send 
Phone Number Data workflow process.

NOTE: This process describes the exchange of phone number data. It is assumed that 
the phone number data are stored as Assets in the Siebel database. This process can 
be applied to any Asset data.

The workflow process used to perform this scenario is CUT Send Phone Number 
Data.

Synchronizing External Phone Number Data with Siebel eEnergy
End users create or modify a phone number in an external application, and the 
phone number data is synchronized with Siebel eEnergy using the CUT Receive 
Phone Number Data workflow process.

The workflow process used to perform this scenario is CUT Receive Phone Number 
Data.

NOTE: This process describes the exchange of phone number data. It is assumed that 
the phone number data are stored as Assets in the Siebel database. This process can 
be applied to any Asset data.

Responding to an External Inquiry for Phone Number Data
The external system requires phone number (asset) data. The external application 
calls the CUT Get Phone Number Data workflow process using the available Siebel 
object interfaces. The external application retrieves the data from Siebel eEnergy 
using the workflow process as an API.
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The workflow process used to perform this scenario is CUT Get Phone Number 
Data.

NOTE: This process describes the exchange of phone number data. It is assumed that 
the phone number data are stored as Assets in the Siebel database. This process can 
be applied to any Asset data.

Sample Integration Workflow Processes
This section lists the sample integration workflow processes and indicates which 
business services, integration objects, and methods are used for each step. 

NOTE: Sample workflows must be imported into your database. For instructions on 
importing these workflows, see Siebel Business Process Designer Administration 
Guide.

Some workflow process steps call other workflow processes. For example, Step 1 of 
the CUT Send Account Data workflow process calls the CUT Get Account Data 
workflow process. In this example, the CUT Get Account Data workflow process is 
a subprocess of the CUT Send Account Data workflow process (see Table 15 on 
page 228).

Some sample workflow processes communicate using the Siebel EAI MQ Series 
Transport. If your company does not use MQ Series, you can replace the appropriate 
step with one that uses either a custom transport business service, the provided 
HTTP business service, or the provided XML file business service. Business services 
are located in the Siebel Tools repository and are available for use when defining 
workflow processes.

The integration objects used in the samples are:

■ CUT Sample Account IO

■ CUT Sample Asset IO

■ CUT Sample Credit Alert IO
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■ CUT Sample Fraud Alert IO

■ CUT Sample Sales Order IO

■ CUT Sample Service Profile IO

■ CUT Sample Trouble Ticket IO

■ CUT Sample Work Order IO

NOTE: The Integration Object mentioned in this section is specified in XML. It is not 
specified as a Business Service Input Argument.

CUT Send Account Data
Table 15 shows the steps for the CUT Send Account Data workflow process.

CUT Get Account Data
Table 16 shows the steps for the CUT Get Account Data workflow subprocess.

Table 15. CUT Send Account Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Account Data Send Account Data

Subprocess Name CUT Get Account Data

Business Service EAI MQSeries Server 
Transport

Integration Object

Method Send

Table 16. CUT Get Account Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Account Data Convert to XML

Subprocess Name
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CUT Receive Account Data
Table 17 shows the steps for the CUT Receive Account Data workflow process.

CUT Send Service Profile Data
Table 18 shows the steps for the CUT Send Service Profile Data workflow process.

Business Service EAI Siebel Adapter EAI XML Converter

Integration Object CUT Sample Account IO

Method Query Integration Object Hierarchy 
to XML Document

Table 17. CUT Receive Account Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Account 
Update

Convert to Internal Update Account

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

Insert or Update

Table 18. CUT Send Service Profile Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Service Profile Data Send Service Profile Data

Subprocess Name CUT Get Service Profile 
Data

Table 16. CUT Get Account Data Workflow Process Steps

Step Element Step 1 Step 2
Version 7.5, Rev. B Siebel eEnergy Guide 229



Defining an Integration Workflow Process

Sample Integration Workflow Processes
CUT Get Service Profile Data
Table 19 shows the steps for the CUT Get Service Profile Data workflow subprocess.

CUT Receive Service Profile Data
Table 20 shows the steps for the CUT Receive Service Profile Data workflow process.

Business Service EAI MQSeries Server 
Transport

Integration Object

Method Send

Table 19. CUT Get Service Profile Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Service Profile Data Convert to XML

Subprocess Name

Business Service EAI Siebel Adapter EAI XML Converter

Integration Object CUT Sample Service Profile 
IO

Method Query Integration Object Hierarchy 
to XML Document

Table 20. CUT Receive Service Profile Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Service 
Profile Update

Convert to Internal Update Service 
Profile

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Table 18. CUT Send Service Profile Data Workflow Process Steps

Step Element Step 1 Step 2
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CUT Get Sales Order Data
Table 21 shows the steps for the CUT Get Sales Order Data workflow process.

CUT Send Sales Order Data
Table 22 shows the steps for the CUT Send Sales Order Data workflow process.

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

Insert or Update

Table 21. CUT Get Sales Order Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Sales Order Data Convert to XML

Subprocess Name

Business Service EAI Siebel Adapter EAI XML Converter

Integration Object CUT Sample Sales Order IO

Method Query Integration Object Hierarchy 
to XML Document

Table 22. CUT Send Sales Order Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Sales Order Data Send Sales Order Data

Subprocess Name CUT Get Sales Order Data

Business Service EAI MQSeries Server 
Transport

Table 20. CUT Receive Service Profile Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3
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CUT Receive Sales Order Data
Table 23 shows the steps for the CUT Receive Sales Order Data workflow process.

CUT Get Work Order Data
Table 24 shows the steps for the CUT Get Work Order Data workflow process.

Integration Object

Method Send

Table 23. CUT Receive Sales Order Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Sales Order 
Update

Convert to Internal Update Sales Order

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

Insert or Update

Table 24. CUT Get Work Order Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Work Order Data Convert to XML

Subprocess Name

Business Service EAI Siebel Adapter EAI XML Converter

Table 22. CUT Send Sales Order Data Workflow Process Steps

Step Element Step 1 Step 2
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CUT Send Work Order Data
Table 25 shows the steps for the CUT Send Work Order Data workflow process.

CUT Receive Work Order Data
Table 26 shows the steps for the CUT Receive Work Order Data workflow process.

Integration Object CUT Sample Work Order IO

Method Query Integration Object Hierarchy 
to XML Document

Table 25. CUT Send Work Order Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Work Order Data Send Work Order Data

Subprocess Name CUT Get Work Order Data

Business Service EAI MQSeries Server 
Transport

Integration Object

Method Send

Table 26. CUT Receive Work Order Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Work Order 
Update

Convert to Internal Update Work Order

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Table 24. CUT Get Work Order Data Workflow Process Steps

Step Element Step 1 Step 2
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CUT Get Trouble Ticket Data
Table 27 shows the steps for the CUT Get Trouble Ticket Data workflow process.

CUT Send Trouble Ticket Data
Table 28 shows the steps for the CUT Send Trouble Ticket Data workflow process.

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

Insert or Update

Table 27. CUT Get Trouble Ticket Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Trouble Ticket Data Convert to XML

Subprocess Name

Business Service EAI Siebel Adapter EAI XML Converter

Integration Object CUT Sample Trouble Ticket 
IO

Method Query Integration Object Hierarchy 
to XML Document

Table 28. CUT Send Trouble Ticket Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Trouble Ticket Data Send Trouble Ticket Data

Subprocess Name CUT Get Trouble Ticket 
Data

Business Service EAI MQSeries Server 
Transport

Table 26. CUT Receive Work Order Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3
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CUT Receive Trouble Ticket Data
Table 29 shows the steps for the CUT Receive Trouble Ticket Data workflow process.

CUT Receive Fraud Alert Data
Table 30 shows the steps for the CUT Receive Fraud Alert Data workflow process.

Integration Object

Method Send

Table 29. CUT Receive Trouble Ticket Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Trouble 
Ticket Update

Convert to Internal Update Trouble 
Ticket

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

Insert or Update

Table 30. CUT Receive Fraud Alert Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Fraud Alert 
Update

Convert to Internal Update Fraud Alert

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Table 28. CUT Send Trouble Ticket Data Workflow Process Steps

Step Element Step 1 Step 2
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CUT Receive Credit Alert Data
Table 31 shows the steps for the CUT Receive Credit Alert Data workflow process.

CUT Get Phone Number Data
Table 32 shows the steps for the CUT Get Phone Number Data workflow process.

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

 Insert or Update

Table 31. CUT Receive Credit Alert Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Credit Alert 
Update

Convert to Internal Update Credit Alert

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

Insert or Update

Table 32. CUT Get Phone Number Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Phone Number Data Convert to XML

Subprocess Name

Business Service EAI Siebel Adapter EAI XML Converter

Table 30. CUT Receive Fraud Alert Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3
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CUT Send Phone Number Data
Table 33 shows the steps for the CUT Send Phone Number Data workflow process.

CUT Receive Phone Number Data
Table 34 shows the steps for the CUT Receive Phone Number Data workflow 
process.

Integration Object CUT Sample Asset IO

Method Query Integration Object Hierarchy 
to XML Document

Table 33. CUT Send Phone Number Data Workflow Process Steps

Step Element Step 1 Step 2

Step Name Get Phone Number Data Send Phone Number Data

Subprocess Name CUT Get Phone Number 
Data

Business Service EAI MQSeries Server 
Transport

Integration Object

Method Send

Table 34. CUT Receive Phone Number Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3

Step Name Receive Phone 
Number Update

Convert to Internal Update Phone 
Number

Subprocess Name

Business Service EAI MQSeries Server 
Transport

EAI XML Converter EAI Siebel Adapter

Table 32. CUT Get Phone Number Data Workflow Process Steps

Step Element Step 1 Step 2
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Sample Workflow Process: CUT Send Account Data
This section examines a send-type sample workflow process to help you understand 
how the workflow process is set up. 

The CUT Send Account Data workflow process sends an XML string, created from 
an account record, to an IBM MQSeries queue.

Viewing the Sample Workflow Process
You can view any of the sample workflow processes in Siebel eEnergy.

To view the CUT Send Account Data sample workflow process

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 From the Queries drop-down list, select All Processes.

3 In the Workflow Processes list, select CUT Send Account Data.

4 Click the Process Designer view tab.

The workflow process is displayed as a flowchart.

Integration Object

Method Receive XML Document to 
Integration Object 
Hierarchy

Insert or Update

Table 34. CUT Receive Phone Number Data Workflow Process Steps

Step Element Step 1 Step 2 Step 3
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Viewing CUT Send Account Data Workflow Process Properties
Properties that apply to all steps of a workflow process are called workflow process 
properties. These properties apply to all workflow processes:

■ Error Message

■ Error Code

■ Object Id

■ Siebel Operation Object Id

The CUT Send Account Data workflow process has these additional properties:

■ Account XML. Specifies the Siebel object that has been converted to XML.

■ Input: Siebel Int Object Name. Specifies the input Integration Object used in send 
workflows.

■ Process Instance Id. Specifies the process instance and is automatically populated 
when a process is executed and persistence is enabled.

To view properties for the CUT Send Account Data workflow process

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 From the Queries drop-down list, select All Processes.

3 In the Workflow Processes list, select CUT Send Account Data.
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4 Click the Process Properties view tab.

Viewing the Workflow Process Steps
You can examine the details of any workflow process step.

To examine the details of the CUT Send Account Data workflow process steps

1 From the application-level menu, choose View > Site Map > Workflow 
Administration > Workflow Processes.

2 From the Queries drop-down list, select All Processes.

3 In the Workflow Processes list, select CUT Send Account Data.

4 Click the Process Designer view tab.

5 Double-click the step you want to view.

Information about the workflow process step appears.

Get Account Data Subprocess Step
The first step after Start is the Get Account Data subprocess. This subprocess 
contains two steps:
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■ Get Account Data

■ Convert to XML

To view the Get Account Data subprocess, follow the directions in “To examine the 
details of the CUT Send Account Data workflow process steps” on page 240 and 
double-click the Get Account Data step. The individual substeps are not detailed in 
the Sub Process form. To see them, you must view the Get Account Data workflow 
process.

Figure 18 shows the Subprocess view for the Get Account Data subprocess step of 
the CUT Send Account Data workflow process.

Figure 18. Get Account Data Subprocess Step of the CUT Send Account Data Workflow Process
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To examine the details of the CUT Get Account Data subprocess step

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 From the Queries drop-down list, select All Processes.

3 In the Workflow Processes list, select CUT Get Account Data.

4 Click the Process Designer view tab.

The workflow process is displayed as a flowchart.

5 Double-click the Get Account Data step.

Get Account Data Step
This step uses the query method of the Siebel EAI Adapter to get an instance of an 
account record from the Siebel database. The CUT Sample Account IO describes the 
structure of the Account business object and was created using the Integration 
Object Builder. The other part of the query criteria is the Object Id, which is a 
process property that contains the row ID for the account in the sample DB.

NOTE: The CUT Sample Account IO value is actually specified as a process property 
that is used as the input argument for the process step.
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Sample Workflow Process: CUT Send Account Data
Figure 19 shows the Business Service view for the Get Account Data step of the CUT 
Get Account Data workflow process.

Convert to XML Step
This step uses the Integration Object Hierarchy to XML Document method of the 
EAI XML Converter to convert the outbound Siebel Message to XML and store it in 
the Account XML output argument. 

Figure 19. Get Account Data Step of the CUT Get Account Data Workflow Process
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Sample Workflow Process: CUT Send Account Data
Figure 20 shows the Business Service view for the Convert to XML step of the CUT 
Get Account Data workflow process.

Send Step
The last step in the CUT Send Account Data workflow process before End invokes 
the EAI MQSeries Server Transport to put the XML message onto the MQSeries 
queue, called Employee. The message is represented by the Message Text argument. 

The Queue Manager Name and Physical Queue Name are defined during the 
MQSeries setup. The Account XML message is sent to the queue specified by the 
Physical Queue Name property, which is managed by the queue manager specified 
in the Queue Manager Name property.

Figure 20. Convert to XML Step of the CUT Get Account Data Workflow Process
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Sample Workflow Process: CUT Receive Account Data
Figure 21 shows the Business Service view for the Send step of the CUT Send 
Account Data workflow process.

Sample Workflow Process: CUT Receive Account Data 
This section examines a receive-type sample workflow process to help you 
understand how the workflow process is set up.

Viewing the Sample Workflow Process
You can view any of the sample workflow processes in Siebel eEnergy.

Figure 21. Send Step of the CUT Send Account Data Workflow Process
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Sample Workflow Process: CUT Receive Account Data
To view the CUT Receive Account Data sample workflow process

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 From the Queries drop-down list, select All Processes.

3 In the Workflow Processes list, select CUT Receive Account Data.

4 Click the Process Designer view tab.

The workflow process is displayed as a flowchart.

This sample workflow process, shown in Figure 22, receives an XML string from an 
IBM MQSeries queue and updates the Account instance in the Siebel database.

Defining CUT Receive Account Data Workflow Process Properties
You should set workflow process properties when you need a property to be true 
for the entire workflow. For example, as shown in the following procedure, the CUT 
Receive Account Data workflow process has five properties. The Error Message, 
Error Code, Object Id, and Siebel Operation Object Id properties are included in each 
workflow process by default. The Account XML property defines the MQSeries 
message as XML recognizable by Siebel eBusiness applications.

The CUT Receive Account Data workflow process has these additional properties:

■ Account Message. Contains the object in its Siebel eEnergy hierarchical format 
when converted. It must be in this format before it can be inserted or updated 
in Siebel eEnergy.

■ Account XML. Specifies the Siebel object that has been converted to XML.

■ Process Instance Id. Specifies the process instance and is automatically populated 
when a process is executed and persistence is enabled.

Figure 22. CUT Receive Account Data Workflow Process
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Sample Workflow Process: CUT Receive Account Data
For information about workflow process properties, see “Viewing CUT Send 
Account Data Workflow Process Properties” on page 239.

To view properties for the CUT Receive Account Data workflow process

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 From the Queries drop-down list, select All Processes.

3 In the Workflow Processes list, select CUT Receive Account Data.

4 Click the Process Properties view tab.

Viewing the Workflow Process Steps
You can examine the details of each workflow process step.

To examine the details of the CUT Receive Account Data workflow process steps

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 From the Queries drop-down list, select All Processes.
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Sample Workflow Process: CUT Receive Account Data
3 In the Workflow Processes list, select CUT Receive Account Data.

4 Click the Process Designer view tab.

5 Double-click the step you want to view.

Receive Account Update Step
The Receive method of the EAI MQSeries Server Transport retrieves the inbound 
message from the Account physical queue. This queue is named in the Physical 
Queue Name argument. 

Figure 23 shows the Business Service view for the Receive step of the Receive 
Account Data workflow process.

Figure 23. Receive Step of the Receive Account Data Workflow
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Sample Workflow Process: CUT Receive Account Data
In this case, the output from the receive step is put into the Account XML process 
property. The assumption is that the inbound message is already in XML format.

Convert to Internal Step
The next step, Convert to Internal, uses the XML Document to Integration Object 
Hierarchy method of the EAI XML Converter to convert the inbound message to the 
Siebel business object format. 

Figure 24 shows the Business Service view for the Convert to Internal step of the 
Receive Account Data workflow process.

The output argument from this step is stored in the Account Message process 
property, in the Siebel Message format.

Figure 24. Convert to Internal Step of the Receive Account Data Workflow
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Sample Workflow Process: CUT Receive Account Data
Update Account Step
The last step before End uses the Insert or Update method of the Siebel EAI Adapter 
to perform the updating task. As shown in Figure 25 on page 250, the Siebel EAI 
Adapter checks the Siebel database for an Account record that matches the current 
instance of Account in the Account Message property.

If an Account record matching the current instance does not appear in the database, 
the Siebel EAI Adapter inserts the record into the database. 

If an Account record in the database matches the current instance, the adapter 
updates the record with the instance.

Figure 25 shows the Business Service view for the Update Account step of the 
Receive Account Data workflow process.

Figure 25. Update Account Step of the Receive Account Data Workflow
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Appendix A
This chapter provides detailed information about the Price Comparison feature in 
Siebel eEnergy. It supplements the basic concepts, business scenarios, and 
procedures described in Chapter 9, “Price Comparison.”

Specifically, this chapter details each of these components, which make up the 
pricing calculator:

■ SmartScript to collect user inputs (see “SmartScript for Price Comparison” on 
page 251)

■ Two primary workflows:

■ SIS OM PC Comparison workflow (see “SIS OM PC Comparison Process” on 
page 273)

■ SIS OM PC Enrollment workflow (see “SIS OM PC Enrollment Process” on 
page 276)

■ Two primary methods called by the workflows:

■ Bill Decomposer (see “Bill Decomposer Method” on page 263)

■ Comparison Generator (see “Comparison Generator Method” on page 264)

■ Other Siebel workflows and methods

SmartScript for Price Comparison
The SIS OM SmartScript functionality can be conceptually broken into five parts:

■ Business component classes that invoke the SIS OM SmartScript

■ SIS OM SmartScripts (one low and one high interactivity version)
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■ SIS OM SmartScript engine classes

■ The EPC Admin VBC business component

■ SIS OM PC Workflows that use SmartScript answers collected by the SIS OM 
SmartScripts

This section describes all these parts followed by user property descriptions and a 
graphic showing the SmartScript text.

NOTE: After you have tested a script and determined it is ready for production, an 
administrator must explicitly release it. Releasing a SmartScript allows Siebel 
eEnergy to find and use that script when a user invokes it. Therefore, release the 
Price Comparison SmartScript to use it the first time, and rerelease it every time you 
update the script. For more information, see Siebel SmartScript Administration 
Guide.

Business Component Classes
These business component classes are used to invoke the SIS OM SmartScript:

■ Method SISOMCreateQuote in class CSSSIABCQuote 

In Siebel eSales, this method is called using the Compare Price link on the Home 
page. Invoking this method from these low interactivity applications invokes the 
low interactivity SmartScript. 

In Siebel eEnergy, this method is invoked from the PC Price Comparison view. 
Invoking this method from this high interactivity application causes the high 
interactivity SmartScript to run. 

NOTE: In Siebel eEnergy, this class is used by the Quote business component. 
When this method is invoked from the PC Price Comparison view, there is a link 
between the Opportunity and Quote business components, where the 
Opportunity is the parent. In this case, the current Opportunity row ID and 
Opportunity name are passed as input to the SmartScript when this method is 
called. The SmartScript then passes these values to the workflow that is invoked 
when the SmartScript Finish button is clicked.
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■ Method SISOMRunPCReport in class CSSSISOMBCProductRelationship 

This method can be used to run the SIS OM SmartScript in report mode. The 
method is invoked when the CP Reports button from the Product Relationship 
view in Siebel eEnergy is clicked. 

NOTE: This method should not be used when the application is in low 
interactivity mode.

NOTE: Both methods call the RunSmartScript method in the SIS OM PC Service 
business service to start the SIS OM SmartScript Engine.

SIS OM SmartScript
There are two versions of the SIS OM SmartScript.

SIS OM PC Comparison Smart Script - HI. This is the high interactivity version used in 
Siebel eEnergy.   

SIS OM PC Comparison Smart Script - LI. This is the low interactivity version used in 
Siebel eSales and Siebel Partner Relationship Management (Siebel PRM) for Siebel 
eEnergy. 

NOTE: In low interactivity mode, SmartScript questions that use dynamic answers 
must be broken into separate SmartScript pages whenever the answer from one 
SmartScript is used as the input for the next SmartScript question.
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SIS OM SmartScript Engine Classes
These two classes make up the SIS OM SmartScript Engine:

■ CSSSWESISOMFrameWebCallScriptPlayer, used by the SIS OM Smart Script 
Player Applet 

■ CSSSISOMBCVCallScriptPlayer, used by the business component SIS OM Smart 
Script Player

NOTE: Regarding Siebel Tools configuration, both engine classes and their associated 
applet and business component must be used together for SIS OM SmartScript 
Engine to work properly. 

SIS OM PC Workflows
There are two SIS OM PC workflows provided out-of-the-box that are invoked by 
the SIS OM SmartScript.

SIS OM PC Competitive Pricing Report workflow. This workflow is invoked when the 
CP Reports button is clicked in the Product Relationship view in Siebel eEnergy. 

SIS OM PC Comparison Process workflow. This workflow is called in Siebel eEnergy 
when the CP Reports button is clicked in the PC Price Comparison view. For Siebel 
eSales for Siebel eEnergy, this workflow is called from the Compare Price link on 
the Home page. 

For more information on these workflows, see “SIS OM PC Competitive Pricing 
Report Process” on page 284 and “SIS OM PC Comparison Process” on page 273.

EPC Admin Virtual Business Component
The EPC Admin virtual business component is used to specify data sources (that is, 
LOVs and business components) where SmartScript answers for a particular 
question can be found. For more information, see Siebel SmartScript Administration 
Guide.
254 Siebel eEnergy Guide Version 7.5, Rev. B



Appendix

SmartScript for Price Comparison
SIS OM SmartScript Player User Properties
The following business component user properties, used by the SIS OM Smart Script 
Player business component, are used to enable the following SIS OM PC specific 
functionality.

Off Page Answer Branching
This set of user properties allows a SmartScript to branch to a different SmartScript 
page, using a SmartScript answer from another page.

SIS OM Branch Question. Specifies which SmartScript question contains the answer 
used for off page branching.

SIS OM Branch Answer. Specifies which SmartScript answer triggers branching. This 
value is in language independent code.

SIS OM Branch Answer LOV. Specifies the LOV used in conjunction with user property 
SIS OM Branch Answer to find the language dependent value.

SIS OM Branch Trigger Answer. The value of this user property is used to find the 
SmartScript question that contains the off answer branch. The SmartScript question 
must have this value specified as its default answer.

Dynamic Answers
This functionality allows the SmartScript to dynamically find, using a business 
service, the possible SmartScript answers for the Rate Plan and Supplier questions 
for both the electricity and gas questions. 

SIS OM PC Service Name. Name of the business service that contains the methods 
used to get the Rate Plan (Get Area Rate Plan Names) and the Supplier (Get Area 
Supplier Names). The value of this user property should not be changed.

SIS OM Question Service Type. Specifies which question is used to get the Service 
Type (Electricity or Gas). The Service Type is used as input to the Get Area Rate Plan 
Names and Get Area Supplier Names methods.

SIS OM Question Electric Service Area. Specifies which SmartScript question contains 
the electricity Service Area question. The Service Area is used as input to the Get 
Area Rate Plan Names and Get Area Supplier Names methods.
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SIS OM Question Electric Supplier Name. Specifies which SmartScript question 
contains the electricity Supplier Name question. The answers displayed by this 
SmartScript question come from calling the SIS OM PC Service business service’s 
method and Get Area Supplier Names.

SIS OM Question Electric Rate Plan. Specifies which SmartScript question contains the 
electricity Rate Plan question. The answers displayed by this SmartScript question 
come from calling the SIS OM PC Service business service’s Get Area Rate Plan 
Names method. 

NOTE: This method takes the Supplier Name, as well as the Service Type and Service 
Area, as input, so the Supplier Name SmartScript question must come before the 
Rate Plan question for a particular Service Type.

SIS OM Question Gas Service Area. Specifies which SmartScript question contains the 
gas Service Area question. The Service Area is used as input to the Get Area Rate 
Plan Names and Get Area Supplier Names methods.

SIS OM Question Gas Supplier Name. Specifies which SmartScript question contains 
the gas Supplier Name question. The answers displayed by this SmartScript 
question come from calling the SIS OM PC Service business service’s method and 
Get Area Supplier Names.

SIS OM Question Gas Rate Plan. Specifies which SmartScript question contains the 
gas Rate Plan question. The answers displayed by this SmartScript question come 
from calling the SIS OM PC Service business service’s Get Area Rate Plan Names 
method. 

NOTE: This method takes the Supplier Name, as well as the Service Type and Service 
Area, as input, so the Supplier Name SmartScript question must come before the 
Rate Plan question for a particular Service Type.

Report Mode
These user properties are used when the SmartScript is in report mode. The 
SmartScript is in report mode when the SmartScript is invoked from the 
Relationship view New button (method invoked SISOMRunPCReport using class 
CSSSISOMBCProductRelationship).
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SIS OM Report Mode: No Answer Validation #. Specifies which SmartScript questions 
do not need to be answered when in report mode. If a SmartScript question is left 
blank and it uses this user property, then the system will operate as if All 
SmartScript answers were selected for this question.

SIS OM Report Mode: On Finish View. Specifies which view is displayed after the report 
workflow is started.

SIS OM Report Mode: SIS OM Finish Workflow. Specifies which workflow is called to 
generate the report when the SmartScript Finish button is clicked.

General User Properties
SIS OM Finish Workflow. Specifies which workflow is called when the SmartScript 
Finish button is clicked.

SIS OM Pricing Calculator Business Service
For more information on this business service, see “SIS OM Pricing Calculator 
Business Service” on page 260.

The following user properties are broken down by business service methods.

CP Report Create Quotes Method
The following user properties are used by the CP Report Create Quotes method, 
which is used to create the data set used when generating a report.

Dual Fuel Service Type. Specifies the language independent code used to specify the 
dual fuel Service Type.

Service Type Question Name. Specifies which SmartScript question in the SmartScript 
answer table contains the Service Type.

Electric Region Question Name. Specifies which SmartScript question in the 
SmartScript answer table contains the electricity Region (Service Area).

Electric Service Type. Specifies the language independent code used to specify the 
electricity Service Type.

Electric Supplier Question Name. Specifies which SmartScript question in the 
SmartScript answer table contains the electricity Supplier.
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Electric Tariff Question Name. Specifies which SmartScript question in the SmartScript 
answer table contains the electricity Tariff (Rate Plan).

Gas Region Question Name. Specifies which SmartScript question in the SmartScript 
answer table contains the electricity Region (Service Area).

Gas Service Type. Specifies the language independent code used to specify the gas 
Service Type.

Gas Supplier Question Name. Specifies which SmartScript question in the SmartScript 
answer table contains the gas Supplier.

Gas Tariff Question Name. Specifies which SmartScript question in the SmartScript 
answer table contains the gas Tariff (Rate Plan).

Run SmartScript Method
The following user properties are used by the Run SmartScript method as defaults 
if these values are not specified as input to this method.

SIS OM ScriptName - HI. Specifies the default SIS OM SmartScript to run if the 
application is in high interactivity mode.

SIS OM ScriptName - LI. Specifies the default SIS OM SmartScript to run if the 
application is in low interactivity mode.

SIS OM ViewName. Specifies the default view that contains the SIS OM SmartScript 
Engine.
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Figure 26 shows the SmartScript text for the Price Comparison feature.

Figure 26. SmartScript Workflow for Price Comparison
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SIS OM Pricing Calculator Business Service
The SIS OM Pricing Calculator (PC) business service is a set of methods that 
implements the back-end calculation engine for the pricing calculator. Different 
workflows, which provide the business flow of this functionality, invoke the 
methods.

The two primary methods, Bill Decomposer and Comparison Generator, decompose 
a utility bill from a prospective customer into the usage breakdown and use that 
data to determine the comparable internal rate plans that best meet the customer's 
criteria. 

More specifically, Bill Decomposer receives a PC Competitor quote that represents 
the utility bill from a competitor as input. Based on the details of competitors' rate 
plans stored in the Siebel database, Bill Decomposer then reverse-engineers the 
utility bill information to deduce the usage breakdown of this prospective customer. 
It stores the result in the PC Competitor quote. 

The quote is then passed to Comparison Generator, which looks up the internal rate 
plans to locate those that meet the customer's requirements. Comparison Generator 
then creates a PC Comparison quote for each of those matching rate plans and uses 
the Pricing Engine to calculate the potential savings available to prospective 
customers, if they switch to the rate plans. 
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User Properties
Pricing Calculator methods use these user properties:

■ XA Name - Area. Name of the product attribute used to store the service area 
where the rate plan is being offered.

■ XA Name - Usage Type. Name of the product attribute used to store the usage 
breakdown category of the rate plan. Out of the box, the value of this property 
is Usage Type. 

■ Usage Type n. Valid values for the Usage Type attribute specified by the XA Name 
- Usage Type user property.

For example:

NOTE: For instructions on adding a new usage type, see “To add a new usage type 
for the pricing calculator” on page 263.

■ Threshold Usage Type. Value of the Usage Type attribute that is handled as the 
threshold usage (that is, the number of units charged at a specified price before 
applying other pricing rules). Out of the box, the value is Threshold.

■ Peak. Name of the field of the SIS OM PC Usage Profile business component that 
is used to store the Peak category of usage breakdown.

■ Off Peak. Name of the field of the SIS OM PC Usage Profile business component 
used to store the Off Peak category of usage breakdown.

Name Value

Usage Type 1 Peak

Usage Type 2 Off Peak

Usage Type 3 Threshold
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■ Must Match XA n. Names of product attributes that an internal rate plan must 
possess in order to be qualified as a match to the current rate plan used by the 
prospective customer.

For example:

■ PC Type n. Names of all the basic (non-dual) service types of products used in 
the Pricing Calculator functionality.

For example:

■ Dual Fuel Service Type. Name of the service type of products designated for dual 
fuel discount processing.

■ SIS OM ViewName. Default view to use when displaying the PC SmartScript. It is 
used by the Run SmartScript method.

■ SIS OM AppletName. Default applet to use when displaying the PC SmartScript. It 
is used by the Run SmartScript method.

■ SIS OM ScriptName - HI. Default SmartScript script to use in high interactivity 
mode. It is used by the Run SmartScript method.

■ SIS OM ScriptName - LI. Default SmartScript script to use in low interactivity 
mode. It is used by the Run SmartScript method.

Name Value

Must Match XA 1 MeterType

Must Match XA 2 Region

Name Value

PC Type 1 Electricity

PC Type 2 Gas
262 Siebel eEnergy Guide Version 7.5, Rev. B



Appendix

SIS OM Pricing Calculator Business Service
To add a new usage type for the pricing calculator

1 Add the new value to the attribute specified by the user property XA Name - 
Usage Type.

2 Add a new user property Usage Type n to specify this new value.

3 Add both a new field to the SIS OM PC Usage Profile business component and a 
new column to its underlying table for the data storage.

4 Add a new user property with this new usage type as the name and the Business 
Component field name added above as the value.

Bill Decomposer Method
This method decomposes a utility bill provided by a prospective customer into the 
usage breakdown. The calculation is based on a number of billing parameters 
derived from the information on the utility bill.

Arguments PCMultiQuotes

[in/out] List of SIS OM Quote integration object instances that are used to store the 
utility bill information provided by a prospective customer. The usage breakdown 
is also written back into this quote structure as output. (Required)

Returns List of SIS OM Quote integration object instances that contain the usage breakdown.

Remarks The usage breakdown is represented in a quote integration object as the Quantity 
field of a usage sub-line item with the Usage Type attribute set to a specific value 
(for example, Threshold, Peak, Off Peak).

See Also “SIS OM PC Comparison Process” on page 273.
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Comparison Generator Method
This method locates the comparable internal rate plans that match the rate plan 
currently provided to the prospective customer by a competitor. It creates a quote 
of type PC Comparison for each of the matching internal rate plans, setting the 
Quantity field to the usage breakdown obtained from the PCMultiQuotes input 
(which is usually generated from the Bill Decomposer Business Service method).

Arguments PCMultiQuotes

[in] List of SIS OM Quote integration object instances that are used to store the 
utility bill information provided by a prospective customer, along with the usage 
breakdown calculated by the Bill Decomposer method. (Required)

Opportunity

[in] Name of the opportunity object under which the generated PC Comparison 
quotes should be stored. (Required)

PriceList

[in] Name of the Price List that contains the collection of internal products from 
which matching rate plans should be located. (Required)

OpportunityRevenueAmt

[out] Summation of the total bill amount for each of the utility bills represented in 
the PCMultiQuotes input argument.

Returns OpportunityRevenueAmt

Total bill amount the prospective customer is paying a competitor for.

Remarks The usage breakdown is represented in a quote integration object as the Quantity 
field of a usage sub-line item with the Usage Type attribute set to a specific value 
(for example, Threshold, Peak, Off Peak).

See Also “Bill Decomposer Method” on page 263 and “SIS OM PC Comparison Process” on 
page 273.
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Update Status Method
This method searches for all quotes with a certain type for a given opportunity and 
updates a user-specified field in those quotes.

Arguments Opportunity Id

[in] ID of the opportunity for which the quotes are to be updated. (Required)

QuoteType

[in] Type of the quotes for which the user wants to query. (Required)

FieldName

[in] Name of the field in the quote business component that the user intends to 
update. (Required)

FieldValue

[in] Value to be set to the field in the quote business component that the user 
intends to update. (Required)

Returns None.

Remarks In the out-of-the-box use of this method, the value of Opportunity Id is passed 
through the Named Method that invokes the SIS OM PC Enrollment workflow, 
within which the other values of QuoteType, FieldName and FieldValue are set.

See Also “SIS OM PC Enrollment Process” on page 276.

Get Area Rate Plan Names Method
This method locates available rate plans provided by any company (supplier) 
within a service area.

Arguments Supplier Name

[in] Name of the company whose rate plans are needed. (Optional)

Service Area
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[in] Region within which the rate plans are needed. (Optional)

Service Type

[in] Type of service for search. Possible inputs are Gas, Electricity, or Dual Fuel. 
(Required)

Returns List of rate plans that match the criteria. 

Remarks The list of rate plans is returned in a string in this structure: Plan 1, Plan 2, and so 
on.

Get Area Supplier Names Method
This method returns the list of supplier names for a given service type in a given 
service area.

Arguments Service Area

[In] Region within which the rate plans are needed. (Optional)

Service Type

[In] Type of service for search. Possible inputs are Gas, Electricity, or Dual Fuel. 
(Required)

Returns List of supplier names that match the criteria. 

Remarks The list of supplier names is returned in a string in this structure: Company 1, 
Company 2, and so on.

Run SmartScript Method
This method is used to run the pricing calculator's SmartScripts. 

Arguments Script Name

[in] Name of the SmartScript to run. (Optional) 
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If this parameter is not supplied, then the business service user property SIS OM 
ScriptName - HI is used to find the default SmartScript when running in high 
interactivity mode. When running in low interactivity mode, the business service 
user property SIS OM ScriptName - LI is used to find the default SmartScript. For 
more information, see “User Properties” on page 261.

Applet Name

[in] Name of the applet used to display the SmartScript. (Optional) 

If this parameter is not supplied, then the business service user property SIS OM 
AppletName is used to find the default applet. For more information, see “User 
Properties” on page 261.

View Name

[in] Name of the view used to display the SmartScript. (Optional) 

If this parameter is not supplied, then the business service user property SIS OM 
ViewName is used to find the default view. For more information, see “User 
Properties” on page 261.

Currency Code

[in] Sets the current code used by the SmartScript. (Optional) 

Language Code

[in] Sets the language code used by the SmartScript. (Optional) 

Script Id

[in] Used to “rerun” a previous SmartScript session. (Optional) 

Returns None
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Convert PC Quote to Quote Method
This method converts a Price Comparison (PC) Quote into a regular quote. The 
quantity for usage products is reset to “1,” which is the number of items to be 
ordered.

Arguments Account

[in] Name of the account for the PC Quote. (Optional)

QuoteId

[in] Quote Id of the PC Quote that is to be converted to a regular quote. (Required)

SiebelMessage

[out] Property set output that represents the regular quote. (Optional)

AutoSync

[in] True or false value used to synchronize the regular quote to the database. For 
performance reasons, this is usually not specified and the regular quote is 
synchronized to the database after other operations that follow this step.

Returns SiebelMessage 

Property set output that represents the regular quote.

See Also “SIS OM PC Enrollment Process” on page 276.
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Convert PC Input to PC Quote Method
The answers from a SmartScript session are taken as the Pricing Calculator input 
and are converted into a Competitor Quote. Multiple quotes are created as 
appropriate, based on the SmartScript answers.

Arguments PCMultiQuotes

[out] List of SIS OM Quote integration object instances that are used to store the 
utility billing information provided by a prospective customer. (Required)

Opportunity

[in] Name of the opportunity object under which the generated PC Comparison 
quotes will be stored. (Required)

OpportunityId

[in] ID of the opportunity object under which the generated PC Comparison quotes 
will be stored. (Required)

RunId

[in] RunId of the SmartScript session where the answers are stored. This typically 
will be a process property that is set internally when the SmartScript session is 
finished. (Required)

Returns PCMultiQuotes 

List of SIS OM Quote integration object instances that are used to store the utility 
billing information provided by a prospective customer.

See Also “SIS OM PC Comparison Process” on page 273.
Version 7.5, Rev. B Siebel eEnergy Guide 269



Appendix

SIS OM Pricing Calculator Business Service
Setup Question Field Map Method
This method determines the type of the question, the name of the business 
component, and the field where the answer to a specific SmartScript question 
should be stored. This step is required before the PC Input to PC Quote conversion 
method is called.

The syntax for the arguments is: type-buscomp-field, 
where type is a value of PC Type n user properties. 

Arguments Electricity-Quote Item-Product

Electricity-Quote Item XA-Meter Type

Electricity-Quote Item XA-Payment Method

Electricity-Quote Item-Usage CxTotal 

Electricity-Quote-Bill Period

Electricity-Quote-PC Bill Info 

Electricity-Quote-PC Budget Plan

Electricity-Quote-Price List 

Electricity-Quote-Region 

Gas-Quote Item XA-Meter Type

Gas-Quote Item XA-Payment Method 

Gas-Quote Item-Product 

Gas-Quote Item-Usage CxTotal

Gas-Quote-Bill Period 

Gas-Quote-PC Bill Info 

Gas-Quote-PC Budget Plan 

Gas-Quote-Price List 
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Gas-Quote-Region

[in] A list of mapping arguments that are mapped to a corresponding question 
name. The list should be defined whether a customer chooses to answer all 
questions at runtime or not. The argument values are the question names. 
(Required)

Returns None

See Also “SIS OM PC Comparison Process” on page 273.

Delete Existing PC Quotes Method
This method deletes existing PC Quotes for a given opportunity.

Arguments Opportunity

[in] Name of the opportunity for which all the existing PC Quotes should be deleted. 
(Required)

Returns None

Remarks The Delete PC Quotes Search Spec user property of the Quote business components 
specifies the search specification to be used by the method to determine which 
quotes to delete.

See Also “SIS OM PC Comparison Process” on page 273.

CP Report Create Quotes Method
This is an intermediate step in the generation of the Competitive Pricing report. It 
takes input from a SmartScript session and reads the Pricing Calculator Relationship 
entries. It replaces some of the SmartScript answers and generates a quote for each 
In-House entry in the Relationship table, as well as a matching quote for each “like-
for-like” Competitor entry.

Since this method invokes Convert PC Input to PC Quote internally, its arguments 
are formed as for that method, and passed through. CP Create Quotes directly uses 
only the RunId of the SmartScript session.
Version 7.5, Rev. B Siebel eEnergy Guide 271



Appendix

SIS OM Pricing Calculator Business Service
Arguments PCMultiQuotes

[out] A list of SIS OM Quote integration object instances that are used to store the 
utility billing information provided by a prospective customer. (Required)

Opportunity

[in] The name of the opportunity object under which the generated PC Comparison 
quotes will be stored. (Required)

OpportunityId

[in] The Id of the opportunity object under which the generated PC Comparison 
quotes will be stored. (Required)

RunId

[in] The RunId of the SmartScript session where the answers are stored. This 
typically will be a process property that is set internally when the SmartScript 
session is finished. (Required)

Returns PCMultiQuotes

A list of SIS OM Quote integration object instances that are used to store the utility 
billing information provided by a prospective customer.

Get Next RowId Method
This method generates a unique system RowId that can be used to populate 
required fields in business components.

Arguments RowId

[out] The system-generated RowId is returned.
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SIS OM PC Comparison Process

The SIS OM PC Comparison Process is called by a SmartScript session. The 
SmartScript session is invoked by clicking the New button in the SIS OM PC 
Opportunity Price Comparison view or by clicking the Compare Prices link on the 
Home Page.

1 A check is made to determine whether an opportunity exists for the Price 
Comparison. If an opportunity exists, all existing quotes that meet the specified 
criteria will be deleted. Out-of-the-box quotes of type PC Comparison, PC Like 
for Like, and PC Competitor will be deleted.

2 If an opportunity does not exist, a new opportunity is created.

3 The SmartScript session questions are mapped to fields of a quote.

4 The answers from the SmartScript session are converted into a competitor quote 
using the mapping created in the previous step.

Figure 27. SIS OM PC Comparison Process
Version 7.5, Rev. B Siebel eEnergy Guide 273



Appendix

SIS OM PC Comparison Process
5 The Bill Decomposer method uses the competitor quote information to calculate 
the user's annual usage.

6 The Price Comparison method generates a comparison quote for each product 
offered by the company that meets the criteria specified by the user. The usage 
amounts calculated by the Bill Decomposer step are used to calculate the 
projected annual bill given the pricing of the product.

7 The comparison quotes are displayed in the Opportunity Price Comparison view. 
For more details, see “SIS OM Goto Price Comparison View Process” on 
page 275.

Table 35 lists the SIS OM PC Comparison Workflow steps, methods, and business 
services.

Table 35. SIS OM PC Comparison Process 

This Workflow Step Calls This Method In This Business Service

Delete Existing PC Quotes Delete Existing PC Quotes SIS OM Pricing Calculator 
Service

Get New RowId Get Next RowId SIS OM Pricing Calculator 
Service

Setup Question-Field 
Mapping

Setup Question Field Map SIS OM Pricing Calculator 
Service

PC Input to PC Quote Convert PC Input to PC 
Quote

SIS OM Pricing Calculator 
Service

Bill Decomposer Bill Decomposer SIS OM Pricing Calculator 
Service

Price Comparison Comparison Generator SIS OM Pricing Calculator 
Service
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SIS OM Goto Price Comparison View Process

The SIS OM Goto Price Comparison View Process is invoked as a subprocess of the 
SIS OM PC Price Comparison Process.

1 The Primary Revenue Amount of the Opportunity is set to the total bill amount, 
passed as an input to the workflow.

2 The application that is invoking the workflow is checked.

3 If the application is eSales, the Opportunity Id is stored as a profile attribute and 
the CUT Opportunity PC Price Comparison View (eSales) is displayed.

4 Otherwise, the SIS OM Opportunity PC Price Comparison View is displayed.

Table 36 lists the Goto Price Comparison Workflow steps, methods, and business 
services.

Figure 28. SIS OM Goto Price Comparison View Process

Table 36. Goto Price Comparison View Process Workflow Steps

This Workflow Step Calls This Method In This Business Service

Set Profile Attribute Set Profile Attribute SIS OM Product Manipulation Toolkit Service
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SIS OM PC Enrollment Process

The SIS OM PC Enrollment workflow is invoked by clicking the Enroll button in the 
SIS OM PC Opportunity Price Comparison View or the CUT Opportunity PC Price 
Comparison View (eSales).

1 A check is made to determine whether an account is associated with the 
opportunity.

2 If an account does not exist and the application that invoked the workflow is not 
eSales, the SIS OM PC Account Entry view is displayed to allow the user to create 
a new account. For more details, see “SIS OM PC Create Account Subprocess” 
on page 278. 

Figure 29. SIS OM PC Enrollment Process
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3 A check is made to see whether an account was created. If an account was not 
created, the user is returned to the SIS OM PC Opportunity Price Comparison 
view. For more details, see “SIS OM PC Go To Opportunity View” on page 279.

4 If the user created a new account, the account is associated with the 
opportunity. For more details, see “SIS OM PC Set Opportunity Account” on 
page 279. 

5 The comparison quote is converted to a regular quote that can be progressed 
through the order life cycle.

6 The Status of the comparison and competitor quotes is set to Order Placed.

7 If the application that invoked the workflow is eSales, the comparison quote is 
merged with the shopping cart. For more details, see “CUT eSales - PC 
Enrollment Process” on page 280. 

8 If the application is not eSales, the quote is converted to an order and the order 
is displayed in the Order Line Item view. For more details, see “SIS OM PC Go 
to Order Entry - Line Items View (Sales)” on page 279.

Table 37 lists the SIS OM PC Enrollment Process steps, methods, and business 
services.

Table 37. SIS OM PC Enrollment Process

This Workflow Step Calls This Method In This Business Service

Convert PC Quote to Quote Convert PC Quote to Quote SIS OM Pricing Calculator 
Service

Set Status for PC Competitor Update Status SIS OM Pricing Calculator 
Service

Quote to Order Convert Product Instance SIS OM Product 
Manipulation Toolkit 
Service

SIS OM Sync Synchronize SIS OM Product 
Manipulation Toolkit 
Service
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SIS OM PC Create Account Subprocess

The SIS OM PC Create Account Subprocess is invoked as a subprocess of the SIS 
OM PC Enrollment workflow.

1 The SIS OM PC Account Entry Selection View is displayed and the user is asked 
whether a new account should be created. If the user clicks No, an account is 
not created and the subprocess is terminated.

2 If the user clicks Yes, a new account is created.

3 The SIS OM PC Account Entry View is displayed to allow the user to enter the 
details of the account. The user clicks Continue.

4 The name of the account is retrieved and returned to the calling workflow.

Figure 30. SIS OM PC Create Account Subprocess
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SIS OM PC Go To Opportunity View

The SIS OM PC Go To Opportunity View workflow is invoked as a subprocess of the 
SIS OM PC Enrollment workflow.

The SIS OM PC Opportunity Price Comparison view is displayed.

SIS OM PC Set Opportunity Account

The SIS OM PC Set Opportunity Account workflow is invoked as a subprocess of the 
SIS OM PC Enrollment workflow.

The Account Id specified by the process property is associated with the Opportunity.

SIS OM PC Go to Order Entry - Line Items View (Sales)

The SIS OM PC Go to Order Entry - Line Items View (Sales) is invoked as a 
subprocess of the SIS OM PC Enrollment workflow.

The workflow navigates to the Order Entry - Line Items View (Sales).

Figure 31. SIS OM PC Go To Opportunity View

Figure 32. SIS OM PC Set Opportunity Account

Figure 33. SIS OM PC Go to Order Entry - Line Items View (Sales)
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CUT eSales - PC Enrollment Process

The CUT eSales - PC Enrollment Process is invoked as a subprocess of the SIS OM 
PC Enrollment workflow.

1 The status of the shopping cart is checked.

2 If the cart is empty, a new cart is created and the cart's price list is set to the 
Price Comparison internal price list. See “CUT eSales - Set Shopping Cart Price 
List” on page 282 for more details.

3 If the cart is not empty, the cart's price list is compared to the price list of the 
comparison quote selected by the user. If the price lists are different, a check is 
made to see if the user explicitly logged in.

Figure 34. CUT eSales - PC Enrollment Process
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4 If the user logged in, the Save Cart Confirmation view is displayed to allow the 
user to specify how to handle the existing cart. See “CUT eSales - PC Prepare 
Cart Process” on page 282 for more details.

5 If the user is not logged in, a request is made to display the CUT Opportunity PC 
Price Comparison View (eSales) on log in, and the Login View is displayed. The 
workflow terminates.

6 If the user chose not to save or discard the existing cart, the workflow is 
terminated. 

7 If the comparison quote's price list and the cart's price list are the same, or a 
new cart was created, the comparison quote line items are added to the cart.

8 The Shopping Cart view is displayed.

Table 35 lists the CUT eSales - PC Enrollment Process steps, methods, and business 
services.

Table 38. CUT eSales - PC Enrollment Process

This Workflow Step Calls This Method In This Business Service

Get Shopping Cart Status GetShoppingCartStatus CUT OET Service

Get Property: Explicit Login GetPropValue Shopping Service

New Cart NewCartHeader CUT OET Service

Set Pending Request Set Pending Request Shopping Service

Merge PC Quote & Cart MergeCxObj CUT OET Service

Goto Shopping Cart GotoView CUT OET Service
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CUT eSales - Set Shopping Cart Price List

The CUT eSales - Set Shopping Cart Price List process is invoked as a subprocess of 
the CUT eSales - PC Enrollment Process workflow.

The cart's price list is updated to the specified value.

CUT eSales - PC Prepare Cart Process

The CUT eSales - PC Prepare Cart Process is invoked as a subprocess of the CUT 
eSales - PC Enrollment Process workflow.

Figure 35. CUT eSales - Set Shopping Cart Price List

Figure 36. CUT eSales - PC Prepare Cart Process
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1 The current shopping cart is loaded and the Save Cart Confirmation view is 
displayed. 

2 If the user chooses Save, the cart is saved.

3 If the user chooses Discard, the cart is discarded.

4 If the user chooses Cancel, the CUT Opportunity PC Price Comparison View 
(eSales) is displayed and the calling workflow is terminated.

Table 39 lists the CUT eSales - PC Prepare Cart Process Workflow steps, methods, 
and business services.

.

Table 39. CUT eSales - PC Prepare Cart Process

This Workflow Step Calls This Method In This Business Service

Save Cart as Quote SaveCartAsQuote Shopping Service

Discard Cart DiscardCart Shopping Service

Go Back to PC Comparison 
View

GotoView CUT OET Service
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SIS OM PC Competitive Pricing Report Process

The workflow is called by a SmartScript session that is invoked by clicking the CP 
Report button in the Product Comparison > Relationships view.

1 A check is made to determine whether an opportunity exists for the Price 
Comparison. If there is an opportunity, all existing price comparison quotes are 
deleted.

2 If an opportunity does not exist a new opportunity is created.

3 The SmartScript session questions are mapped to fields of a quote.

4 The answers from the SmartScript session are converted into a competitor quote 
using the mapping created in the previous step.

Figure 37. SIS OM PC Competitive Pricing Report Process
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5 Using the answers from the SmartScript session the data is generated for the 
report.

6 The report is executed using the data set generated by the previous step.

.

Table 40. SIS OM Competitive Pricing Report Process

This Workflow Step Calls This Method In This Business Service

Delete Existing PC Quotes Delete Existing PC Quotes SIS OM Pricing Calculator 
Service

Get New RowId Get Next RowId SIS OM Pricing Calculator 
Service

Setup Question-Field 
Mapping

Setup Question Field Map SIS OM Pricing Calculator 
Service

CP Report Create Quotes CP Report Create Quotes SIS OM Pricing Calculator 
Service

Execute Report Execute Report Report Service
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Q
quotes. See opportunities

R
rate plans

See also administrator procedures; end-
user procedures

administrators, setting up overview 133
classes, setting up for 135
competitor’s, matching with inhouse 

plans 141
examples, table of 128
root products, creating for 136
scenario, analyzed by pricing 

manager 131
scenario, set up by pricing manager 130
tier-based pricing, about 127

Receive Account Data workflow
account record, updating 250
inbound message, converting 249
inbound messages from IBM MQSeries, 

receiving 248
release, new features 15
repayment plans

customer decision, submitting 207
description 204
repayment plan outcome, viewing 207
repayment plans, about 165
request for 205
views listed 204

reports
Competitive Pricing report, running 143
Price Comparison Administrative report, 

running 142
responsibilities

profiles, table of 51
table of 34

roles
profiles, table of 51

table of 34

S
sales administrators, roles and 

responsibilities 34
sales agreements, description 72
sales managers, roles and 

responsibilities 34
sales representative

profiles, roles and responsibilities 51
roles and responsibilities, table of 34

scenarios
accounts, example sequence performed 

by administrators 132
rate plans, set up by pricing 

manager 130
rate plans. analyzed by pricing 

manager 131
Web, using to compare prices and 

enroll 131
screens, table of 26
Send Account Data workflow

outbound message, sending 244
Service Aggregator Class, description 31
service agreements, description 73
Service class, description 31
service customer, enrolling 145
service information, viewing assets 110
service item

agreements, associating with 82
description 47

service level agreements, description 73
service point

assets, viewing 110
defined 85
premise, adding to and associating 

with 91
viewing 95

Service Profile view, note about order 
management module 51

service requests
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See also customer satisfaction surveys; 
trouble tickets; trouble tickets, 
resolving; work orders

administrator setup, about 184
asset, adding to associate with service 

request 108
business scenario 181
contact, associating with 69
creating, about 180
description 179
initiating, about 180
premise, adding for a premise 97
premise, viewing associated with 96
trouble tickets, differences between 179

service, enrolling customer for 145
Siebel eBusiness Application Integration 

(eAI), description 220
Siebel eCommunications

business issues, solutions to (table) 22
screens and functions (table) 26

Siebel eMedia
business issues, solutions to (table) 22
screens and functions (table) 26

Siebel Energy, description 21
SIS OM Goto Price Comparison View 

Process 275
SIS OM PC comparison process

flow diagram 273
process described 273
SIS OM Goto Price comparison view 

process, flow diagram and 
process 275

steps, methods, and business services 
(table) 274

SIS OM PC Competitive Pricing Report 
Process

process described 284
steps, methods, and business service 

(table) 285
workflow diagram 284

SIS OM PC Create Account Subprocess 278
SIS OM PC Enrollment Process

CUT eSales-PC Enrollment Process, 
process described 280

CUT eSales-PC Enrollment Process, table 
of steps, methods, and business 
services 281

CUT eSales-PC Enrollment Process, 
workflow 280

CUT eSales-PC Prepare Cart Process, 
process described 282

CUT eSales-PC Prepare Cart Process, table 
of steps, methods, and business 
services 283

CUT eSales-PC Prepare Cart Process, 
workflow 282

CUT eSales-Set Shopping Cart Price List, 
workflow 282

flow diagram 276
SIS OM PC Create Account subprocess, 

workflow and process described 278
SIS OM PC Go To Opportunity View, 

workflow diagram 279
SIS OM PC Go To Order Entry-Line Items 

View (Sales), workflow 279
SIS OM PC Set Opportunity Account, 

workflow diagram 279
SIS OM PC Enrollment process

process described 276
steps, methods, and business services 

(table) 277
SIS OM PC Go To Opportunity View 279
SIS OM PC Go to Order Entry - Line Items 

View (Sales) 279
SIS OM PC Set Opportunity Account 279
SIS OM PC workflows, list of 254
SIS OM Pricing Calculator (PC) business 

service
about 260
bill decomposer method 263
comparison generator method 264
convert PC input to PC quote 

method 269
convert PC quote to quote method 268
CP report create quotes method 271
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delete existing PC quotes method 271
get area rate plan names method 265
get area suppler names method 266
get next RowId method 272
run SmartScript method 266
setup question field map method 270
update status method 265
user properties 261

SIS OM Pricing Calculator business service
CP Report Create Quotes method 257
Run SmartScript method 258

SIS OM SmartScrip Player user properties
about 255
dynamically find answers 255
off page answer branching 255
report mode 256
workflow, specifying 257

SIS OM SmartScript
See also SmartScript, for price comparison
Engine classes 254
version of 253

site profile
description 51
end-procedures, about and fields 

(table) 62
SmartScript, for price comparison

business component classes 252
EPC Admin virtual business 

component 254
parts, described 251
SIS OM PC workflows 254
SIS OM Pricing Calculator business 

service 257
SIS OM SmartScript Engine classes 254
SIS OM SmartScript Player user 

properties 255
SIS OM SmartScript, versions of 253
workflow diagram 259

subagreements, about 73

T
third-party credit systems 195
tier-based pricing, setting up 138

trouble tickets
See also customer satisfaction surveys; 

service requests; trouble tickets, 
resolving

administrator setup, about 184
analyzing data 192
attachments, about 193
business scenario 181
closing trouble tickets 190
contact, associating with 69
creating overview 185
creating trouble tickets 185
creating, about 180
customer satisfaction surveys, 

initiating 192
customer verification, about 192
description 179
entitlement verification, about 193
entitlement, verifying associating 

with 188
existing parent tickets, associating child 

ticket with 187
field service agents, about 

communication with 193
initiating, about 180
partner software, about referring to 180
person or group, assigning 

manually 186
person or group, assigning to 186
service requests, differences 

between 179
solutions, about reviewing 188
solutions, defined 189

trouble tickets, resolving
See also customer satisfaction surveys; 

service requests; trouble tickets
activity plan, associating with 189
activity, about adding to 189
activity, adding to 190

U
unbilled charges, viewing 160
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unincorporated business, credit check 
information 61

usage
billing, viewing details 159
detail information, viewing 44
pricing calculator, adding new type 263
service point associated with premise, 

about viewing 96
service point associated with premise, 

viewing 96
usage products

creating 137
setting up 137

usage profile
setting up 140

user properties, used by Pricing Calculator 
method 261

user scenarios
accounts, example sequence performed 

by administrators 132
rate plans, set up by pricing 

manager 130
rate plans. analyzed by pricing 

manager 131
Web, using to compare prices and 

enroll 131

W
Web scenario, using to compare prices and 

enroll 131
work orders

See also service requests
activity for a work order, creating 176
activity plan, associating with 176
attachments, about relating to 178
business scenario 173
defined 173
line item actions, adding 177
line items, creating 177
service information, viewing 110
work order terms, adding 178
work orders, creating 175

workflow process, integrating

See also workflow process, sample
business scenarios 221
CUT Get Account Data workflow 

process 228
CUT Get Phone Number Data workflow 

process 236
CUT Get Sales Order Data workflow 

process 231
CUT Get Service Profile Data workflow 

subprocess 230
CUT Get Trouble Ticket Data workflow 

process 234
CUT Get Work Order Data workflow 

process 232
CUT Receive Account Data workflow 

process 229
CUT Receive Credit Alert Data workflow 

process 236
CUT Receive Fraud Alert Data workflow 

process 235
CUT Receive Phone Number Data 

workflow process 237
CUT Receive Sales Order Data workflow 

process 232
CUT Receive Service Profile Data 

workflow process 230
CUT Receive Trouble Ticket Data 

workflow process 235
CUT Receive Work Order Data workflow 

process 233
CUT Send Account Data workflow 

process 228
CUT Send Phone Number Data workflow 

process 237
CUT Send Sales Order Data workflow 

process 231
CUT Send Service Profile Data workflow 

process 229
CUT Send Trouble Ticket Data workflow 

process 234
CUT Send Work Order Data workflow 

process 233
sample processes, about 227
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workflow process, sample
See also workflow process, integrating
CUT Receive Account Data, defining 

properties 246
CUT Receive Account Data, viewing 

sample process 245
CUT Receive Account Data, viewing 

workflow process steps 247
CUT Send Account Data, viewing process 

properties 239
CUT Send Account Data, viewing 

workflow process 238
CUT Send Account Data, viewing 

workflow process steps 240
workflow processes, description 221

See also workflow process, integrating; 
workflow process, sample

workflows, sample
Receive Account Data, converting the 

inbound message 249
Receive Account Data, receiving the 

inbound message from IBM 
MQSeries 248

Receive Account Data, updating the 
account record 250

Send Account Data, accessing the 
Workflow Process Designer 238

Send Account Data, sending outbound 
message 244
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